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Legal Notices

Release Notice
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Inc., October 2024. All rights reserved.
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FARO TECHNOLOGIES, INC. MAKES NO WARRANTY, EITHER EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
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Copyright Notice
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FARO Trademarks
The following are trademarks or registered trademarks of FARO Technologies Inc.

ATS ®

CAM2 ®

FARO ®

FARO Flatness Check ™
FARO Gage ®

FARO RemoteControls ®

FARO ScanPlan ®

FARO Sphere ®

FARO Stream ™
FaroArm ®

FaroBlu ®

Flash Technology ™
Focus 3D ®

Freestyle ®

GeoSLAM ™ (pending)
HoloBuilder ™ (pending)
Hybrid Reality Capture ™ (pending)

HYPERMODULATION ®

JobWalk ™ (pending)
Orbis ™ (pending)
RayTracer ®

RevEng ®

ScanAlign ™ (pending)
SiteScape ™ (pending)
Traceable 3D ®

The absence of any product or service name from this list does not imply a waiver of FARO's trademark or
other intellectual property rights associated with said name.

This product includes third-party and open source resources. For license and copyright information
pertaining to the use of these resources, refer to the following document in the FARO Knowledge Base:
https://knowledge.faro.com/Essentials/General/3rd-Party_Open_Source_License_Information_for_FARO_
Products
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Chapter 1: Introduction

SCENE is a comprehensive 3D point cloud processing and managing software tool for the professional user.
It is specially designed for viewing, administration, and working with extensive 3D scan data obtained from
high resolution 3D laser scanners such as the FARO Focus Laser Scanner.

SCENE processes and manages scanned data highly efficiently and easily by offering a wide range of
functions and tools, such as filtering, automatic object recognition, scan registration, as well as automatic
scan colorization.

After SCENE has prepared the scan data, you can begin evaluation and further processing right away. For
this, it offers functions from simple measuring to 3D visualization through to meshing and exporting your
scan data into various point cloud and CAD formats.

Starting from version 2024.0, you can upload projects to the new cloud solution Sphere XG as well as
download and synchronize existing projects. With Sphere XG, your scan projects can be published on the
Internet and viewed with a standard Internet browser.

If you have any questions or need further instructions for any procedure, contact your Customer Service
representative by phone, fax or email. You can also reach the Customer Service Applications and Training
group through email at the following addresses:

l support@faro.com

l applications@faro.com

l training@faro.com

Visit the FARO Customer Service area on the Web at www.faro.com to search our technical support
database, which is available 24 hours a day, 7 days a week.

You may also find various online tutorials on the Internet at learn.faro.com.

System Requirements
To use SCENE seamlessly, your computer should have the following specifications.

NOTE: The Minimal Specifications are sufficient for scan resolutions up to 1/4, a project of less than 10
scans, and when stereo rendering is not required.
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Minimal Specifications Recommended Specifications

Processor
l Quad-core, with at least 2-GHz
(for example, Intel Core i7)

l 8 physical cores (for example, Intel
Core i7, Core i9 or Xeon)

Graphics Card

l OpenGL 4.3, or higher

l At least 4 GB Memory.

For VR Rendering:

l NVIDIA 1060GTX or similar

l Oculus Rift S

l Oculus with Oculus Touch
Controllers or HTC VIVE

l SteamVR

For Processing of Focus Scan using
the PanoCam :

l DirectX 11 Feature Level
11.0

l OpenGL 4.3, or higher

l At least 8 GB Memory

l Dedicated graphics card

For VR Rendering:

l NVIDIA 1080GTX or similar

l Oculus with Oculus Touch
Controllers or HTC VIVE

l SteamVR

For Stereo Rendering:

l NVIDIA Quadro

For Processing of Focus Scan using the
PanoCam:

l DirectX 11 Feature Level 11.0

Main Memory At least 32 GB 64 GB

Hard Disk 512 GB Solid State Drive 1 TB Solid State Drive + Regular HDD

Display 1366 x 768 1920 x 1080

Operating
System

Microsoft Windows 10 (64-bit)

Microsoft Windows 11 (64-bit)

Microsoft Windows 10 (64-bit)

Microsoft Windows 11 (64-bit)

Accessories
Mouse with 2 buttons and a scroll wheel

Network connectivity is required for licensing
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Chapter 2: Installation and Licensing

This chapter describes the installation and licensing procedures.

Licensing SCENE Versions 2022.2 and Later
Starting from SCENE 2022.2, the software is licensed via the FARO Licensing Manager. The SCENE
installation contains FARO InTouch as well as the FARO Licensing Manager. You can access the FARO
Licensing Manager via FARO InTouch.

You can find further information on licensing SCENE with the FARO Licensing Manager starting from
section Licensing SCENE Versions 2022.2 and Later on page 5.

Licensing SCENE Versions 2022.1. and Earlier
For SCENE 2022.1. and earlier your licensing option is determined when you purchase SCENE. The
following licensing options are available: 

a. Licensing with a port lock: the license number is recorded into the port lock (USB dongle). Attach the
port lock to a USB port on your computer.

b. Licensing with a product key: enter a string of characters that you received from FARO.

l The product code must be validated using an Internet connection. After completion, this validation is
permanently stored on your computer.

l If you do not have an available Internet connection, contact FARO’s customer service team to receive a
validation file.

l Each key code can only be activated one time. If you install the software on a new computer, use the
license transfer options or contact FARO’s customer service team for support.

You can find further information on these licensing options starting from chapter Licensing SCENE
Versions 2022.1. and Earlier.

Contact FARO’s customer service team if you need to switch your licensing option, or have other issues
with licensing. Additional information is available on the FARO Knowledge Base.

Installing the Software
NOTE: You must belong to the group of administrators to install the software.
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NOTICE: Uninstall any third-party software that interacts with SCENE and OpenGL software. This
includes but is not limited to GPU performance and over-clocking tools, gaming overlays, FPS
counters and various streaming and recording tools. These tools are known to cause random
SCENE crashes when working with 3D views.

The following third-party software products are not compatible with SCENE:

• Nahimic
• MSI Afterburner
• Lavasoft Web Companion
• Trimble Connected Community Explorer

1. Insert the installation USB flash drive supplied with the scanner.

2. Select the language that the installation should use.

3. Select the product and follow the installation instructions on the screen. An installation wizard will
guide you during installation.

4. Read the license agreement and accept it to proceed.

Figure 2-1 SCENE installation startup

5. Accept the default components for installation, or change the selection according to your needs.
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6. If desired, create a new default folder.

Figure 2-2 Select Additional Tasks

7. Decide if you want to be informed about updates. You will then be notified if a newer version is
available than you are using. A dialog appears that shows the used version, the new version and a link
to download the .exe file for the new version. After downloading, you must install the software
manually.

8. If the new version is a major release (first or second number has been incremented) you may need
another license to use the new version. Select the "Don't ask me again" checkbox if you don’t want to
be informed again about this new version, for example, if you want to download later.

9. Create a desktop icon: Select, if you would like to have the SCENE button shown on your computer’s
desktop.

10. Register file extensions (.lsproj, .fws, .fls): Decide if you want to open scan projects by clicking the
file name in Windows Explorer.

11. Review the setting and install the software.

When installing SCENE version 2022.2 and later, FARO InTouch and the FARO Licensing Manager are
installed as well. Starting from SCENE 2022.2, you need the FARO Licensing Manager to request, update
and manage your license.

Licensing SCENE Versions 2022.2 and Later
Starting from SCENE 2022.2, the software is licensed via the FARO Licensing Manager. The SCENE
installation contains FARO InTouch as well as the FARO Licensing Manager. You can access the FARO
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Licensing Manager via FARO InTouch.

1. To access the FARO Licensing Manager, open InTouch, and click Run on the Licensing Manager tile.

Figure 2-3 FARO InTouch

The FARO Licensing Manager opens.

Figure 2-4 FARO Licensing Manager

2. ClickManage Licenses.

3. Then, click Activate New.

4. Enter your product key in field Product key and click button Activate.

The license will be added and activated. Note that this may take some time.
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Updating Your License Automatically
1. To access the Licensing Manager, open InTouch, and click Run on the Licensing Manager tile.

The FARO Licensing Manager opens.

Figure 2-5 FARO Licensing Manager

2. In the FARO Licensing Manager, clickManage Licenses.
The licenses which need updating are displayed.

Figure 2-6 Update license view

3. Click icon .
The update may take some time. If the update does not work even after several attempts, you can also
update your license manually.
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If you want to update all available licenses, click button . To filter licenses, click icon and
select the filter criterion you want from the context menu.

Once the license is updated successfully, it will be shown in the list and a green notification symbol will be
appear next to the icon at the top right side of the FARO Licensing Manager.

Figure 2-7 License updated successfully

Updating Your License Manually
1. To access the Licensing Manager, open InTouch, and click Run on the Licensing Manager tile.

The FARO Licensing Manager opens.

Figure 2-8 FARO Licensing Manager

2. In the FARO Licensing Manager, clickManage Licenses.
The licenses which need updating are displayed.
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Figure 2-9 Update license view

3. Click icon .

Figure 2-10 Update license manually

4. Click icon and save the .c2v file to your computer.

5. Then, click the Go to Portal link.
The FARO Licensing Portal is opened in a browser.

6. In the FARO Licensing Portal, click button Browse, then select the .c2v button from your computer.
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7. Click button Update.
(You may need to try more than once.)

8. Click Download zip file.

9. Go the zip file location and unzip the .v2c file contained in the downloaded zip file.

10. Go back to the FARO Licensing Manager.

11. Click the Apply License Update icon and select the .v2c file that you have downloaded and
unzipped in steps 8 and 9.

Once the license is updated successfully, it will be shown in the list and a green notification symbol will be
appear next to the icon at the top right side of the FARO Licensing Manager.

Figure 2-11 License updated successfully

Licensing SCENE Versions 2022.1. and Earlier
When you start an unlicensed version of SCENE, the following dialog is shown:
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Figure 2-12 Activation Wizard

If you don’t yet have a license, you can activate the 30 day trial license, or you can purchase a license.

To request a trial license, click the Trial button to be directed to the SCENE product page. On this page,
you can submit the required information, after which you will receive a trial license via email.

To purchase a license, click the Purchase button to be directed to a FARO website where you make your
purchase. You can buy a license either as a product key (a series of numbers or letters) or as port lock that
contains a USB dongle. If you plan to use SCENE on more than one computer, especially computers on
different networks, a port lock allows you to move the license quickly between computers. A product key is
usually more convenient if you will only use SCENE on one computer.

If you already have a license, use this dialog to select a licensing option:
Product Key: If you have your license as a string of characters, select this option and follow the
instructions in the wizard.

Hard Lock Key: If you have your license as a port lock, select this option and follow the instructions in the
wizard.

Network License: If network licensing is available for SCENE on your network, select this option and
follow the instructions in the wizard. You will need to know the host name or IP address of the network
server. If network licensing is not available, and you want to set it up, contact FARO’s customer service
team to update your license. See Collect license information.

Transfer Key: If another computer on your network has a SCENE license that you want to transfer to your
computer, select this option and follow the instructions in the wizard. After transfer, the license will no
longer be available on the original computer.
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Managing your Licenses
The License Manager is available from within the SCENE GUI. Access the manager from the Settings tab
by clicking button .

Figure 2-13 License Manager

l Scope: The icon indicates whether the license is a local, network or dongle license. Hover over the icon
to get additional information.

l In Use: A check mark is present if the license is currently used by an instance of SCENE.

l Product: The product for which the license is valid.

l Type: This indicates whether the licenses is a trial, temporary (time-limited), or perpetual license.

l Days left: If the license is not perpetual, this column indicates the number of days remaining before the
license expires.

l Key ID: The Key ID of the licenses. Note that this is not the same as the Product Key.

l Hostname: Name of the computer on which the license resides.

Start trial
Use to request a trial license.
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Add license
Use to enter a product key. This operation requires an Internet connection.

Update licenses
To update existing licenses stored on your computer or the attached USB dongle to a new version of
SCENE, ensure that you are connected to the Internet and click the Update Licenses button.

Transfer key
To transfer a single-user license from one computer system to another, click the Transfer Licenses button.
This opens a PDF document with details about how to transfer a SCENE, SCENE Process, or SCENE app
license. The FaroRUS tool, that is required to perform the transfer, is also opened. Follow the process
specified in the document to transfer the license.

Collect license information
If you do not have an available Internet connection, contact FARO’s customer service team to update your
license. You will need to create a C2V license file for FARO customer service if you are deleting a license,
modifying a license, or activating the software for the first time on a computer that does not have Internet
access (also known as an offline activation). Make sure you apply the license you are given before you
generate a C2V using this link. Send the exported file to support@faro.com.

Update from file
If you do not have an available Internet connection, contact FARO’s customer service team to update your
license.

Network Licensing
SCENE allows management of multiple licenses over a network. This option is available for users who want
to use a separate computer to host a network license without having to install SCENE on that computer.

Network licenses are hosted on a license server computer and shared to client computers over the network.
They can be locked to a USB dongle (port lock) or to the licensing server computer.

When you start SCENE on any computer in your network, it will search the network for available licenses.
If one is found, it will use this license for the time it is executed. When you close SCENE, the license will
be released and will be available to other SCENE installations in the network.
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Installing the Sentinel HASP Licensing Software on the
License Server
SCENE licenses are managed with Sentinel HASP from SafeNet. To setup a computer as a license server,
you must install the Sentinel licensing software on that computer. Sentinel is automatically installed with
SCENE; however, if you do not want to install SCENE on the computer that hosts the network licenses, you
must install Sentinel manually. Do one of the following to install the Sentinel licensing software on the
server computer:

l Click HASP Network License Manager on the USB menu and follow the prompts.

OR

l Execute haspdinst.exe –install from a command shell. You can obtain this file from the FARO
Technical Support Center site.

To verify the proper installation of the Sentinel licensing software, open an Internet browser on the license
server and enter the address http://localhost:1947/ to open the Sentinel Admin Control Center. If the Sentinel
Admin Control Center appears, installation was successful.

Enabling Remote Access on the Server
Before users can access the network licenses, remote access must be enabled on the server computer:

1. Open an Internet browser on the license server and enter the address http://localhost:1947/ to open the
Sentinel Admin Control Center.

2. In the Options window, select Configuration to display the configuration tab set.

3. Click the Access from Remote Clients tab.

4. Select the Allow Access from Remote Clients checkbox.

5. Click Submit.

Network Licenses Attached to a USB Dongle (Port Lock)
You can obtain a special network port lock from FARO Customer Service. This port lock may be plugged
into any computer that has the Sentinel HASP drivers installed. This computer will act as the license server
and share the licenses over the network (after you enable remote access from clients). Activation of these
licenses is not necessary.

If you want to add network licenses to a port lock, you can purchase network licenses linked to a product
key. To transfer them to the port lock, attach it to any computer with SCENE installed and follow the steps
to validate the product key and activate the licenses. When validating the key and activating the licenses,
you will be asked whether you want to lock the licenses to the computer or to the attached port lock. Select
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the second option. After completion, you can remove the port lock from the computer and attach it to the
license server again (if you used another computer to activate the licenses).

Network Licenses Attached to a Key Code
You can also lock network licenses to the license server computer using a product key. To do so, install and
start SCENE on the server, then follow the steps to validate the product key and activate the licenses. If you
do not want to install SCENE on the license server, you can use the FARO Remote Update System tool to
activate the licenses on the server instead.

To activate licenses with the FARO Remote Update System:

1. Start the FARO Remote Update System (Start > All Programs > FARO > SCENE > FARO Remote
Update System).

2. On the Collect Key Status Information tab, click the Collect Information button. The System will
generate a C2V file.

3. Save the C2V file to your local hard disk.

4. Send the C2V file and your product key to support@faro.com.

5. After a short processing time, you will receive an email with an activation file (V2C). Save this file to
your local hard disk.

6. Start the FARO Remote Update System again and click the Apply License File tab.

7. Select the V2C file you received from FARO Customer Service and click Apply Update. The license
will activate and be bound to the computer.

8. Open http://localhost:1947/ with an Internet browser on the server to verify the proper activation of the
SCENE license. In the Options window, select Products to display the available SCENE licenses.

Detaching Network Licenses
If your license server hosts network licenses that are attached to the computer with a key code (not to a port
lock), you can detach a network license and temporarily bind it to a client computer. The license can then be
used locally on that computer without being connected to the network. When the detached license expires, it
is automatically unbound from the client computer and restored to the server.

The license server and the client computer must be configured to allow detaching of network licenses.

To enable license detachment on a server or client computer:

1. Open http://localhost:1947/ with an Internet browser on the server or client computer.

2. In the Options window, select Configuration to display the configuration tab set.
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3. Click the Detachable Licenses tab.

4. Enable Detaching of Licenses.

NOTE: On a server, you may also specify the number of reserved non-detachable licenses and the
maximum detach duration.

5. Click Submit.

To detach a license and bind it to your client computer:

1. Open http://localhost:1947/ with an Internet browser on the client computer.

2. In the Options window, select Products for an overview of all available local and network licenses.
Detachable network licenses are identified by a red arrow.

3. Click the Detach button to access the Detach License dialog.

4. Select the expiration date to specify the day the license will be restored to the pool.

5. Click Detach & Attach to temporarily bind the license to your client computer. It will return to the
network license pool when it has expired.

To return a detached license before it expires:

1. Open http://localhost:1947/ with an Internet browser on the client computer.

2. In the Options window, select Products for an overview of all available local and network licenses.
Detached network licenses are identified by a green arrow.

3. Click the Cancel License button and confirm your selection on the following dialog to return the
license to the network license pool.

Transferring Network Licenses
1. To transfer (rehost) a valid SCENE license from one computer to another:

2. On both computers, start the FARO Remote Update System (Start > All Programs > FARO >
SCENE > FARO Remote Update System).

3. On both computers, click the Transfer License tab.

4. On the recipient computer (the computer that will receive the license), select a location to save an
information file (ID) and click Collect and Save Information.

5. Transfer the ID file to the source computer (the computer which currently contains the license).

6. On the source computer, highlight the license to transfer.
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7. Browse to the ID file created in Step 3.

8. Select a location to save a license transfer file (H2H) and click Generate License Transfer File.

9. Transfer the H2H file to the recipient computer.

10. On the recipient computer, click the Apply License File tab.

11. Select the H2H file created in Step 7 and click Apply Update.

License Server Administration
The Sentinel Admin Control Center provides various functions to manage and monitor the usage of network
licenses and to diagnose problems. For more information, refer to the Sentinel Admin Control Center help.

Updating Your License
Use the FARO Remote Update System, found in the program group, to check for any pending license
updates. When you run this program, SCENE will download any pending updates or orders and
automatically update your port lock. For example, if you order a translator from FARO customer service,
you can use the License Update tool to download the translator and automatically apply it to your license.

If you do not have an available Internet connection, contact FARO’s customer service team to update your
license. You will need to create a C2V license file for FARO customer service if you are deleting a license,
modifying a license, or activating the software for the first time on a computer that does not have Internet
access (also known as an offline activation). Make sure you apply the license you are given before you
generate a C2V.

To create a C2V file:

1. Start the FARO Remote Update System (Start > All Programs > FARO > SCENE > FARO Remote
Update System).

2. Click Collect Information.

3. Save the C2V file.

4. Send the file to support@faro.com.

5. After a short processing time, you will receive an email with an activation file (V2C). Save this file to
your local hard disk.

6. Start the FARO Remote Update System again and click the Apply License File tab.

7. Select the V2C file you received from FARO Customer Service and click Apply Update. The license
will activate and be bound to the computer.
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8. Open http://localhost:1947/ with an Internet browser on the server to verify the proper activation of the
SCENE license.
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Chapter 3: SCENE Projects Overview and
Projects Details Pages

SCENE always starts with the Projects Overview window. This chapter describes this window and its
contents and functions.

Updates and News
When SCENE starts for the first time, the Updates and News window is displayed. This window provides
you with the latest information from FARO about SCENE, including information about software updates,
training, apps and so on. If you want to see the information again next time you start SCENE, click
CLOSE. If you don’t want to see the information again click DISMISS and then CLOSE. The information
is always available from the Help page.

Projects Overview
The Projects Overview presents all scan projects which are saved in your default project folder. The path of
this project folder is displayed at the top of the screen. Clicking on this path will open a Windows dialog,
where you can select the folder you want.

SCENE will verify all known projects at start-up that are available locally or in the cloud, i.e. in Sphere XG.
The cloud option is available starting from SCENE version 2024.0.

SCENE LT will verify all known projects at start-up.
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Figure 3-1 Projects Overview window

Search field. Start typing, and SCENE LT will automatically show scan projects with names that match
what you type.

Click to show either local projects on your computer or projects in the cloud. For this purpose, you
must be signed in to Sphere XG, see Sign into Sphere XG on page 64.

Refresh project view, show the scan projects either as a list view, or as a tile view.

Scan projects shown with preview image. Hover with the mouse to see a short description of the scan
project. This short description corresponds to what you see in the list view.

Click the three-dots menu to open the Project History or Project Folder.

Opening scan projects
Use one of the following options to open a scan project.

l In the tile view, click the project's preview image.

l In the list view, click the line of the scan project.

SCENE User Manual
Chapter 3: SCENE Projects Overview and Projects Details Pages

SCENE User Manual (2024.0) Page 20 of 372



l Drag and drop a scan project file (ending: .lsproj) from a file system into the Project Preview.

l Drag and drop a scan file (ending: .fls) from a file system into the Project Preview. A new scan project
will be created and opened.

NOTE: Starting with SCENE version 2019.2, projects can be opened by versions of SCENE that are older
than the version used to save the project. For example, version 2019.2 will be able to open projects
saved by future versions of SCENE. (For SCENE versions 2019.1 and older, the older versions of
SCENE cannot open projects saved by younger versions.)

Project Details
After the scan project is opened, the Project Details will be shown.

Figure 3-2 Project preview

If the preview image is not the one you want to see at this place, you can replace it by another one. Only
images in .jpg or .jpeg format are allowed.

1. Hover over the preview image. The Change Image button appears.

2. Click the Change Image button.

3. Browse to a folder, and select the image.

4. Click the Open button to replace the image.
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Number of scans
The number of scans belonging to the scan project.

Recording period
Date and time when scanning was started, and date and time when scanning was finished. Times shown here
are in local time.

Modified
Date and time when the scan project was modified for the last time.

Location
Add a position to your project to make the Google Maps View feature available.

The coordinates must be entered in decimal notation, first the latitude, then the longitude.

Here are some example coordinates:

Moscow: 55.758032 37.617188

Sydney: -33.870416 151.204834

Rio de Janeiro: -22.902743 -43.214722

Seattle: 47.606163 -122.332764

Google Maps

If positional information is provided for a project, the Google Maps View button becomes available in
the project’s preview. Clicking this button will open a Google Maps view of the project’s location in your
default web browser.

Path
The path of the folder in which the scan project is saved.

Description
You can enter a description of your scan project.
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Read-only projects
Projects that cannot be opened with write access are read-only. This happens for example if the project is
opened by another SCENE instance. In this case, SCENE will show a message box while loading the
project.

After the loading is finished, the project will be shown as read-only with a warning message at the top of the
project dashboard. The Save button is disabled. As an additional hint for the user, the SCENE title bar
contains a read-only hint.

Status tiles
Depending on your scan project, different status tiles may be shown. The order of the status tiles
corresponds to the workflow steps in the Workflow bar.

Each status tile shows the status regarding one specific step of processing a scan project.

A status tile usually consists of color coded badges, a description text, and an action button.

Depending on the status of the tile, the action button is disabled or enabled.

Figure 3-3 Color coding with running upload to Sphere XG

NOTE: The status tiles and their buttons are meant as information, and offer a short way to access a
specific function. It is not mandatory to click the buttons, you can also click the appropriate
Workflow bar buttons.

Status Tile "Processing"
NOTE: From the processing status tile, you can click the processing button to select scans and configure

processing. If your project is a mix of hand-held and Focus scans, clicking this button will only
allow you to select Focus scans. To process hand-held scans, click the Processing tab and select
Process hand-held Scans.

The Processing status tile shows the current processing status of the scans inside the project.

The colored badges in the Processing Tile categorize the scans of the project into three categories:

Green: The Scan has been processed and has an up-to-date Scan Point Cloud.

Yellow: The Scan has been processed but does not have an up-to-date Scan Point Cloud.

NOTE: Scans that have been processed with SCENE 6.0 or lower must be processed again to have an up-
to-date Scan Point Cloud, and to utilize the full functionality of SCENE 7.1.

Red: The Scan has not been processed yet.
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Processing Status
The processing status of scans is displayed as follows:

l The status color of the tile is gray if there are no scans in the project.

l Tile and badge are green if all scans are processed and have the updated Scan Point Clouds.

l The status color of the tile is yellow if the yellow badge is visible and the red badge is not visible. This
means that all scans in the project were processed, but for some scans, Scan Point Clouds must be
regenerated.

l The status color of the tile is red if the red badge is visible, when there is at least one scan that was not
processed at all.

Click the Process Scans button to start processing.

The task will open. For more details, see Processing Settings on page 46.

Status Tile "Registration"
The Registration status tile shows the current registration status of the scan project. For more details, see
Registration on page 115.

The tile will show different badges which show the number of clusters for each registration state.

An additional badge showing the mean point error is displayed if all clusters were successfully registered.

All information corresponds directly to the information shown in the registration dashboard and the
registration report.

Each badge type has a tool tip with additional information.

The tile can have three different states which correspond directly with the current state of the project in the
Registration dashboard. These states are symbolized by colors:

Grey
l The currently open project does not contain any clusters or scans.

l The Registration button is disabled.

Orange
There are still clusters which need some user interaction to be successfully registered.

l Red badge: the number of unregistered clusters.

l Orange badge: the number of incomplete clusters.
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l Green badge: the number of finished clusters.

Click the Registration button to switch to the registration dashboard.

Green
All clusters are successfully registered.

l Green badge: the number of finished clusters.

l Red, orange, or green badge will show the overall mean point error. This number is also shown in
header of the registration report with the same color coding, which depends on how high the error is.

Click the Show Report button to switch to the registration report.

Status Tile "Project Point Cloud"
The Project Point Cloud status tile shows the current processing status of Project Point Cloud (PPC).

Status colors
Tile and badge are gray if no Project Point Cloud exists for this project.

Click the Create button to create the Project Point Cloud.

The Point Cloud Creation dialog will open.

NOTE: If the registration is not yet complete, i.e., the registration tile is not green, a warning message is
displayed which recommends finishing the registration before creating the Project Point Cloud.

Orange: A Project Point Cloud in a legacy format exists.

Click the Update button to update the Project Point Cloud.

First, the legacy Project Point cloud will be deleted, and the new Project Point Cloud is created afterwards.

Green: A Project Point Cloud in the current format exists.

A green badge will show the total number of scan points within the Project Point Cloud.

Click the Explore button to switch to the Explore category where the Project Point Cloud is shown in a 3D
view.

Status Tile "Sphere XG"
This status tile shows whether or not the project has been uploaded to Sphere XG.

The following status are possible:

l Blue: You are not signed into Sphere XG, see Sign into Sphere XG on page 64 for more information.

l Grey: You are signed into Sphere XG, but the project has not yet been uploaded.
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l Yellow: The upload is running.

l Green: The project was uploaded successfully.

l Red: The upload has failed.

Status tile buttons:

l Upload: Uploads the project to Sphere XG, see Upload a Project on page 66.

l Sync: Synchronizes changes between SCENE and Sphere XG.

l Resume: Resumes an upload that was aborted for any reason, for example by the user, Internet
connection lost, etc.
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Chapter 4: Navigation

This chapter introduces to the toolbars and buttons which help you to navigate through a scan or a point
cloud.

NOTE: SCENE provides all the features needed to finish typical scan projects. For some advanced features,
however, you must switch to the classic style user interface by clicking Switch UI in the Settings
toolbar.

After you have opened a scan project, the SCENE window appears. This window is made up of the
following areas:

Figure 4-1 Composition of the SCENE window

① Workflow Bar
The workflow bar guides you through a series of steps to process a scan project. All steps are structured in a
similar way which will help you to get familiar with all the functions.

② Toolbar
The toolbar provides a quick and easy way to access features.
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③ Structure View
The structure view displays the project structure, including all folders and objects. If you click the name of
those folders and objects with the right mouse key, a so-called context menu will open which offers specific
functions.

By default, the structure view is visible. If you want to fold it away, click the thumbtack button. To make
the structure view permanently visible again, click the Structure button, then click the thumbtack button.

④ Scan and Object Views
Shows the visual presentation of the scan data and other objects. Scans and objects can either be displayed
in a quick view , a detailed planar view, or in 3D view.

If you click the scan data and objects with the right mouse key, a context menu will open which offers
specific functions.

⑤ Navigation Toolbar (3D View Only)
Offers a quick and easy way to a number of navigation modes. In addition, it allows opening various views,
for example gap filling or point sizes.

⑥ Coordinate Axes
Shows the viewing direction by means of x, y, and z coordinate axes

⑦ Status Bar
Displays command and scan point data details

Workflow Bar
The workflow bar and its buttons provide easy functions to work on scans and scan projects. Working
through the steps from the left to the right should lead to a satisfactory result.

Figure 4-2 workflow bar
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① Select the Save icon to save the currently open scan project.

② Select the Project category to find the features for your entire scan project.
There are two sets of toolbars, one that shows up when no scan project is opened, and one that shows
up when a scan project is opened.

③ Select the Import category to import scans, projects, images, or WebShare data.

④ After importing, select the Processing category to determine how the raw scan data will filtered,
colorized, and otherwise modified to make it more useful.

⑤ Select the Registration category to open the Registration features.

⑥ Select the Explore category to add annotations, measurements, viewpoints, or clipping boxes.

⑦ Select the Export category to export scan points, the point cloud, or the scan project.

⑧ This icon opens the Apps feature.

⑨ This icon opens the Settings for the categories.

⑩ This icon opens the Help page.

⑪ This icon opens the sign-in dialog to Sphere XG. For more information, see Upload and Download
SCENE Projects to/from Sphere XG on page 64.

Help Page
Icons and search options in the ribbon (from left to right):

l Button English Manual opens the English User Manual

l Button Online Manuals opens the FARO Knowledge Base.
Here, the user manual is available in further languages.

l Button Online Tutorials opens the FARO YouTube Channel, where you can find training videos.

l Click button FARO Knowledge Base to create and monitor support cases, access asset information,
update contact information, submit product ideas, and more.

l Click button Contact Technical Support to create a technical support request.
Clicking on this button opens the website Request Support.

l Search the FARO Knowledge Base directly.

The following options are available in the section on the left side.
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l About: View version and build numbers for this version of the software.

l News: Get the latest news about this software.

l 3rd-Party Licenses: View the licenses for 3rd-party products included in this version of the software.

Tasks and Task Steps

Task steps

① The task that is currently being executed, and the several steps of that task that are performed
sequentially.

② Completed Step

③ Completed Step you can go back to. You can go back only one step at a time. Changes will not be
reversed (for example, the result of a registration).

④ Active Step
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⑤ Upcoming Step

⑥ Navigation Buttons: 
The Cancel button exits the current task. It does not undo changes.
The Continue button is only active (green) if all necessary prerequisites of the current step are fulfilled.
It either goes to the next step, or finishes the task.

⑦ Name of currently active task step.

⑧ Optional description and tools of currently active task step.

⑨ Correspondence tools that assist you in finding or dismissing correspondences between the selected
scans.

⑩ Work area, for example 3D views and additional information …

Color Coding
While you are working with SCENE, you will notice different colors, for example header lines, buttons,
traffic light symbols, or messages. Those colors are meant to be an additional information.
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Figure 4-3 Color coding
Blue: Stands for an information, or shows an active step

Green: Everything is working properly or previous step has been completed successfully. For buttons: you
can now click to continue.

Yellow: Something is not working properly, or there is legacy data. Check and fix.

Red: Something went wrong, or some step has not yet been processed. Check and fix.

Navigation Toolbar (3D View only)
A navigation toolbar is displayed only with the 3D scan view.

Figure 4-4 3D Navigation toolbar

The following options are available in the 3D navigation toolbar. For details, click the links:

View Modes

Note that the appearance of this button depends on your Views default settings.

Camera Modes

View All

Predefined Views

Center of Rotation

Last Camera Position

Align Camera on Point

Toggle Clipping Boxes

Point Cloud Visibility
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Supersampling

Gap Filling

Clear View

Adaptive

Point Sizes

Coordinate Coloring

Shading

View Modes

Examine Mode
Click Examine Mode to start the object-based navigation. The objects will appear to move while you stand
still.

Smart Mode
The Smart Mode combines different navigation modes.

A ring is used to divide the view into different zones. When starting the actual navigation by clicking the
mouse button, different navigation modes will be used depending on the zone.
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Figure 4-5 SCENE with activated Smart Mode

The navigation ring disappears when the mouse is not moved anymore, or while you are clicking and
moving the view. It appears again as soon as you hover with the mouse.

2 Zone navigation (default)

A thin ring visualizes the two zones. The cursor updated depending on its position.

Figure 4-6 2 Zone navigation
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① Fly Mode: activated if the cursor is in the inner of the ring.

② Examine mode: Activated if the cursor is in the outer area of the ring.

3 Zone navigation

A thick ring visualizes the three zones. The cursor is updated depending on its position.

NOTE: To set the 3 Zone navigation, you must switch to the SCENE classic style user interface by clicking
Settings > Switch UI. In the old UI, select Tools > Options, then click the Navigation tab. On
the navigation tab, activate radio button Fly, Examine, Roll.

Figure 4-7 3 Zone navigation

① Fly Mode: Activated when the cursor is in the inner of the ring.

② Roll Mode: Activated when the cursor is on the ring.

③ Examine Mode: Activated when the cursor is in the outer area of the ring.
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Figure 4-8 Scenery with Roll mode

To do this, click the ring and drag in any direction. A circle will appear in the middle of the view, indicating
the rotation angle.

Fly Mode
The Fly Mode of the observer-based navigation simulates flying through the 3D world.

l Click and drag the 3D view with the mouse to simulate a flight around the scanner’s position.

l The cursor keys left, right, up, and down turn your head to the left, the right, forward, and backwards.

l The keys page-up and page-down move you up and down.

l In addition, you can press the shift key to accelerate these movements.

Pan Mode
There is no turning available in this navigation mode. Mouse movements are interpreted as observer
movements.

Walk Mode
TheWalk Mode of the observer-based navigation is similar to the fly mode but you can only travel along
the XY plane. This is useful if you want to stay at the same height while navigating.
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Camera Modes
Click the camera modes button to change from Orthographic to Perspective mode and vice versa.

Perspective

The 3D view displays the scan points and objects with the correct perspective - objects of the same size
appear smaller with increasing distance.

Orthographic

The 3D view displays objects of the same size identically, regardless of how far away they are. This type of
representation is common in a CAD systems.

View All
Not available in the quick view.

Changes the position of the observer in such a way that a view on all the objects is achieved.

Predefined Views
Changes the position and viewing direction to view the complete scene from top, bottom, right, front, back,
or in an isometric view.

NOTE: Double-click a scan point to fly to a location. SCENE will then zoom into the scene, close to the
selected scan point. Cancel the movement by clicking and moving the view with the mouse, or
with the respective keys.

Center of Rotation
The center of rotation (the rotation point) is somewhere in the 3D world. It is set automatically by some
functions, for example, when using the object-based navigation.

In the Fly mode, the center of rotation is set to the position of the observer.

To set it manually, click the Set rotation point button, then click the scan point or object.

Last Camera Position
The Last Camera Position button moves camera to the last camera position.
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Align Camera on Point
Click the Align Camera on Point button, then pick a point in the 3D view to align the camera position to
an estimated surface. The center of rotation will be set to the picked point.

Supersampling
Switches supersampling on or off.

Supersampling renders the point cloud with a resolution higher than the resolution of your screen, and then
shrinks the point cloud to fit the screen resolution.

This reduces anti-aliasing effects and gives the point cloud a smoother visual appearance. Fine and filigree
structures look sharper, and stray points will appear less annoying. Set the resolution of the initially
rendered point cloud compared to the screen resolution by selecting one of the options 2x2, 3x3, or 4x4.

For example, selecting 2x2 means that the point cloud will be rendered with a resolution that is 4 times the
resolution of your screen.

NOTE:
l Objects like walls might appear transparent when using small point sizes in combination with
supersampling.

l High supersampling resolutions like 4x4 require large amounts of graphics card memory.

Gap Filling
Switches gap filling on or off.

If switched on, it will fill gaps between scan points that are physically close to one another. Gap filling can
be defined as a predefined setting.

Clear View
Switches Clear View on or off. Clear View can be defined as a predefined setting.

Toggle Clipping Boxes
If there are Clipping Boxes (3D view) placed in the 3D view, you can switch these on or off with the Toggle
Clipping Boxes button.
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Point cloud visibility
Switches the Point cloud visibility on or off. If switched off, other settings, e.g., clipping boxes, remain
active.

Point Sizes
Toggles adaptive point size mode, and switches through three different point size settings.

Adaptive
When Adaptive point size is active, the displayed size of each point adapts to its distance to the observer.
The closer a point is to the observer, the larger it gets.

If adaptive point size is deactivated, points always are drawn with the same size in pixels. They get
displayed with the same size on screen, no matter how distant from the observer they are located.

The three point size buttons scale the size of the points on the screen and can be used to influence the
density of point visualization.

The 3D view is used just like the other views. In addition, in the 3D view you can position yourself at
arbitrary positions in space and look at the scan points and CAD models. The mouse is used to define the
turning movements you want to perform, and with the keyboard you define the actual movement in space.

Coordinate Coloring

Figure 4-9 Distance Coloring Figure 4-10 Normal Coloring Figure 4-11 Z-Axis Coloring

This feature temporarily changes the color of the points in the point cloud according to their coordinates in
the scan. This can highlight features that are difficult to see in the point cloud, such as showing whether a
surface is perfectly flat, or showing if objects that are far from each other have similar or different
elevations. Use the coloring modes shown below with the settings found in Coloring on page 245 and
Shading on page 245 where you can adjust color palettes, coloring ranges, shading strength and other
parameters used in coordinate coloring.

Normal Coloring: A geometric normal is a vector that is perpendicular to an object. Normal coloring
changes the color of the points depending on the direction of the point's normal. This means that mostly flat,
uncurved surfaces will be one color, while surfaces that are curved will have more colors.
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XYZ Axis Coloring Mixes all R, G, B (X,Y,Z) color channels.

X Axis Coloring: changes the color of the points based on their position in the X axis.

Y Axis Coloring: changes the color of the points based on their position in the Y axis.

Z Axis Coloring: changes the color of the points based on their position in the Z axis.

Distance Coloring: changes the color of the points based on their distance from the reference object.

Original Colors: Removes the coordinate coloring and shows the points with the colors they originally had
after the scan was processed and colorized.

Point Shading
Shading makes some points darker in an attempt to simulate shadows to increase the sense of depth and
make subtle features more visible. You can select strong, light, or no shading.
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Chapter 5: Settings

The Settings page provides options to specify or edit all SCENE settings in one place. All changes (except
language changes) are immediately visible and applied after returning to a scan project.

NOTE: Settings are valid for all scan projects. As soon as you start working on a new scan project, it might
be necessary to adjust some settings.

1. Figure 5-1 Open Settings

2. Click the Settings icon on the right side of the workflow bar to open the Settings.
By default, page General is opened.
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① Settings toolbar with more functions

② Available Settings pages. Click the page that you want to check or modify.

③ Check and modify the settings as required. If one of the settings is shown collapsed, click the header
line to open it. If you change a parameter, the changes are immediately applied.

④ Each Settings page has a Reset button. Click this button to reset all parameters to their predefined
values.

Settings Toolbar
The Settings toolbar offers some more functions:

Figure 5-2 Settings features

Reset All Settings button
Resets all SCENE settings to the predefined values.

A confirmation box similar to the reset of the individual categories will be shown.

NOTE: Reset All Settings does not only reset the settings visible and accessible in the new UI, but also all
settings only accessible in the SCENE classic style user interface. Hidden and undocumented
registry settings are also removed/set back to their predefined status.

License Manager
The License Manager provides an overview of all licenses available for the currently running SCENE
version and helps manage them.

Switch User Interface
To access some SCENE functions, you must switch to the Classic user interface.

Back button

Click the Back button to exit the Settings page, and to return to the workflow bar.
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General Settings
The General Settings page offers settings which are typically made only once and which are valid for all
scan projects, for example country-specific settings, or the folder in which scan projects are to be saved.

Check the Show Scanning Category option to activate Scanning.

Language Settings
Select the language of the user interface.

NOTE: The new language will be applied after restarting SCENE.

Unit Settings
Select the units in which length and angle values are displayed.

The following options are available:

Length

l Metric: Millimeter [mm], Centimeter [cm], Meter [m]

l Imperial: Inch [in], Feet [ft], Yard [yd]

l US surveyor: Inch [in US], Feet [ft US], Yard [yd US]

The predefined setting is Meter [m].

Small sizes

Select one of the units for defining sizes. The options available are same as those for the Length option.

The predefined setting is Millimeter [mm].

The small sizes setting is used when presenting dimensions that are very small, such as the tensions in the
registration reports.

Angle

Select one of the units of angle: Degree [°], Radian [rad], or Gon [gon].

The predefined setting is Degree [°].
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Project Folder Settings
The project folder is in the predefined folder where scan projects will be saved. All projects listed in this
folder will be displayed in the Project Selector. When you first open SCENE, the predefined project location
will be a folder in C:\Users\<YourName>\Documents\FARO\Projects. All projects listed in this
folder will be displayed in the Project Selector. .

1. Click the Browse button to open the file system browser.
You cannot enter a project folder path directly into the field.

2. Browse to the folder, or create a new folder.

NOTE: Only one folder can be defined as project location. If you need to have additional project locations,
you can use symbolic links to refer to those locations.

The symbolic links must be placed on your project folder and can point to an arbitrary folder (for
example, on another drive).

Log File Settings
In case of technical problems with SCENE, FARO customer service may ask you for log files.

Enable logging if you experience problems during operating. Specify a folder to save the log files. When
you first open SCENE, the predefined log file location will be a folder in
C:\Users\<YourName>\temp\SCENELogs.

1. Select the Enable Logging checkbox.

2. Click the Browse button to open the file system browser. You cannot enter a log file path directly
into the field.

3. Browse to the folder, or create a new folder.

SCENE will then create log files which will be placed in the selected folder.

There will be one SCENE log file which contains all logged information.

Temporary Data Folder Settings
This folder is used to buffer data during complex processes, for example the creation of point clouds. Ensure
that sufficient disk space should be available.

When you first open SCENE, the predefined project location will be a folder in C:\Users\<your
name>\AppData\Local\Temp\SCENETemp.
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1. Click the Browse button to open the file system browser.
You cannot enter a temporary data folder path directly into the field.

2. Browse to the folder, or create a new folder.

User Interface Settings
This section provides the option to activate or deactivate the Scanning category or Tab in the user interface.

Updates Settings
SCENE version update checking can be enabled or disabled in the SCENE settings.

Check the Enable Automatic Update Checking option to activate update checking.

When enabled, the update checker checks directly at startup, if there is a new SCENE version available.
You must have an active Internet connection on your system for this option to function.

Customer Experience Improvement Program Settings
When you install SCENE, you are asked if you want to participate in the Customer Experience
Improvement Program. If you click yes, anonymous usage statistics are sent to FARO. We collect the
following information:

l The version number of the SCENE instance.

l The date and time that SCENE started and stopped. This allows us to detect crashes.

l The execution of some specific commands where we want to get more information about how they are
used. This helps us to improve the software in the future and helps us understand what may have caused
a crash.

l Tracing information that we have added to the software to help us investigate defects that have been
reported, but which we cannot reproduce.

We use this information to help us understand how customers use SCENE so we can continue to make the
software better. On the settings page, you can change your decision at any time.

Import settings
When importing scan data, it's often necessary to define the unit of length. In the Import settings page, you
can set a default unit of length. Other determining parameters are set in the respective Import dialogs.
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Units
l Metric: Millimeter [mm], Centimeter [cm], Meter [m]

l Imperial: Inch [in], Feet [ft], Yard [yd]

l US surveyor: Inch [in US], Feet [ft US], Yard [yd US]

The default setting is Meter [m].

Processing Settings
The processing settings are applied when a processing operation is started through the Process Scans button

, or the Process Scans command in the context menu of a scan or cluster.

General Processing Settings
On this page you can define general processing settings.

Create Scan Point Clouds
If enabled, a scan point cloud for each scan will be created as last part of the processing.

This setting is enabled per default.

Automatic Registration
Indicate that the project should be registered with an automatic registration after the processing of scans
finishes successfully.

The method used for the automatic registration is the method selected on the page.

Colorization Settings
On this page, you can define various colorization settings.

No colorization
If you mark this checkbox, no color will be added to the scan points during processing.
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Colorize Scans
If you have a scan taken by a laser scanner with the color option, this scan will also contain the digital
pictures which the scanner took automatically during the scanning. These pictures will be applied to color
the scan if this option is selected.

NOTE:  Starting from version 2022.1, SCENE supports coloring Focus Premium scans with high-resolution
images (13MP) made by the scanner’s internal camera.

Laser Illuminated HDR
With LI-HDR, a photograph of a scanned area is combined with information about the amount of laser light
that was reflected by surfaces during scanning. Because the laser provides the illumination, details in areas
that are completely over- or underexposed in the photograph can nevertheless be added to the LI-HDR
image, as shown in this example:

Figure 5-3 Laser Illuminated HDR

The laser light does not provide color information, so areas illuminated only by the laser are shown as
grayscale.

Create PanoCam Scans
If you mark this checkbox, PanoCam scans will be created for every stationary scan whose color was
captured with the PanoCam. As a result, after processing, only the PanoCam scans will remain in the
project.
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Filter Settings
To identify an inaccurate scan point, the filters compare the scan point with the scan points in the
surrounding area. Some of the filtering is performed based on information from the point.

Figure 5-4 The area surrounding a scan point, in a 2D grid

In the figure above the surrounding area oriented toward the recording point is shown. With filters, you can
set what should be regarded as the surrounding area. In this example, the value 5 was set, which means the
edge length of the surrounding square is 5.

Dark Scan Point Filter
This filter removes points based on a reflectance value. Reflectance Threshold indicates the minimum
reflectance value a scan point must have. The Reflectance Threshold range is: 0 to 2048.

This criterion is useful because with a dark scan point, only a very small amount of light entered the scanner
and therefore the measurement will have an increase in noise.

NOTE: This filter is not applicable for colorized scan points.

Distance Filter
This filter removes all scan points which are outside of the defined distance range. All points with a distance
less than theMinimum Distance and all points with a distance larger than theMaximum Distance will be
deleted.

Stray Point Filter
This filter checks if the 2D grid cell of a scan point contains a sufficient percentage of points with a distance
similar to the scan point itself.

l Grid Size: The size of the surrounding area used for comparison. For each scan point of the scan or
selection, the filter takes the valid scan points of this surrounding area and counts how many of them are
at a distance to the scanner which is approximately the same as the distance of the scan point currently
being viewed.
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l Distance Threshold: A scan point is counted if the difference in distance is smaller than the value of
Distance Threshold.

l Allocation Threshold: If at least the percentage of scan points indicated by the Allocation Threshold in
the surrounding area is within this distance threshold, the scan point remains in the scan. Otherwise, it is
removed.

NOTE: The Stray Point Filter is very well suited to correct incorrect scan data. It also works well if the
Allocation Threshold is below 50%. However, the filter must not be applied on surfaces that were
strongly inclined versus the scanner’s laser. The filter is always applied to the whole scan. It is not
possible to apply it only in selected areas.

Edge Artifact Filter
This filter is enabled by default. The filter is especially useful to remove artifacts at the edges of objects.

Target Settings
The Find Targets section allows you to select targets such as checkerboards, planes, and spheres. These
will then be searched in each scan during processing.

NOTE: Finding targets is time-consuming and should be enabled only when scans are registered with the
target-based registration.

Find Checkerboards
A frequently used paper target is the checkerboard target. A checkerboard target fit determines the center
point of the target’s four quadrants. Select this option to find checkerboards and use them for scan
registration. note that the angle between the laser beam and the checkerboard should be higher than 45
degrees. Otherwise, the accuracy of checkerboard may be compromised.
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Find Markers
Select this option to find markers. Markers are printed targets with a unique ID.

Find Planes
Select this option to find planes and use them for scan registration.

Find Spheres
This refers to three-dimensional, white, reference spheres that come in various sizes. The advantage of
spheres is that they can be placed at any angle to the scanner. Select this option to find spheres and use them
for scan registration.

NOTE: Sphere search works with spheres meant for registration. Forensic spheres (used for determining
shot trajectories) may not be found by this target search.

The global list of sphere sizes set in the Settings > Processing page are displayed in the active and inactive
sphere radii list.

Active Sphere Radii
Click Add New and specify new sphere radii. These sphere sizes will be used for target detection.
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This list of user-defined sphere sizes will be used for processing the scans in the current processing task run.

Inactive Sphere Radii
Click Add New and specify additional sphere radii for sphere detection.

Drag the sphere radii that are not required for the current project, from the Active Sphere Radii to the
inactive Sphere Radii list.

You can easily move items between the two lists and manage the sphere radii for processing the scans in the
current project.

Hand-held Processing Settings
These processing settings are only used for hand-held scans.

Plane Detection
Switches plane detection on or off for all processing. Auto switches on plane detection only if it was
switched on when the scan was created.

Replay
If scans already passed some processing steps, Replay restarts the processing from the beginning. Processing
is then executed with higher precision than it was done during capturing.

Scan Optimization
Adjusts all frames of a scan to minimize the overall displacements errors. The function searches for loops in
the scan and tries to close those loops. Loop closing is necessary because small errors from frame to frame
may accumulate over time, resulting in gaps if you return to the same position again. The Extended setting
may give better results, but will take longer.

Stray Point Filtering
Removes stray points, creating a cleaner overall look. Select Standard to remove stray points without
additional 3D smoothing. This setting tends to make edges and corners look better. Select Smooth to add
additional 3D smoothing. This setting tends to make planes look better.
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Color Optimization
Averages the color of scan points in overlapping areas within the selected scan, and adjusts color effects
caused by different lighting situations.

Registration Settings
Adjustments made in the Registration settings page will affect the quality of the registration result.

You can define settings for the registration methods:

l Automatic registration

l Manual registration

You can also define settings for the registration options:

l Target-based

l Top-view-based

l Cloud-to-Cloud

You can also define settings for the Registration Report.

General Registration Settings
The scanner’s sensor data that will be used during registration:

l The inclinometer data will be used for all registration methods.

l The compass data will be used for top-view-based and target-based registration.

NOTE: Sensor data can only be used if the sensors were enabled during scanning.

Use Inclinometer
Normally, inclinometer data is available and used by default to level the scans during registration.

Leveling ensures that the z-axis of the registered scan corresponds to the z-axis defined by the inclinometer.
By this technique one reference can be replaced during registration. When registering with inclinometer
data, this will be used as fully-trusted information and all other registration objects will be used with lower
priority.
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Use Compass
If the scans were recorded with a FARO Focus Laser Scanner equipped with a built-in compass, orientation
information is available for the single scans. Enable this option to use this information as auxiliary
information for the correspondence search. If the correspondence search cannot find any correspondences
that are consistent with the compass data, this may be an indicator that the compass was influenced by
environmental interference and the compass data will be ignored. If you disable this option, no compass data
will be used for correspondence search.

Expert Settings
Move cluster to the center of its scans

When you create a new cluster in the correspondence view, it is shown at the center of the scans displayed
on the screen. However, if you add some of the displayed scans to the cluster, it may happen that the cluster
is not shown at the center of these scans. If this option is activated, the cluster is automatically moved to the
center of its scans. If it is deactivated, a message is shown in which you can confirm that the cluster should
be moved to the center of its scans.

Note that this does not change the global position of the clusters or scans but only the representation on the
screen.

Auto Clustering

SCENE may not be able to find a spatial relationship between all scans in your scan project and only groups
of scans can be registered to each other. The registration internally recognizes which scans can be registered
correctly and which can not. All groups of correctly registered scans are automatically arranged in
appropriate sub-clusters (named Cluster1, Cluster2 etc.).

Automatic Registration Settings
Registration method that will be used when performing the automatic registration task.

Select among the following 4 options:

l Target-based
Use this option if you have well measured targets, like spheres or checkerboards. Target-based
registration doesn't need scan positions.

l Top-view-based
Used for a fast indoor or rough outdoor placement. If inclinometer data is available, this registration
method is independent of the initial scan position. We recommend refining a top-view-based registration
with a cloud-to-cloud registration.
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l Cloud-to-Cloud
Used for refining roughly positioned scans, for example by sensors, manual positioning, or a top-view-
based registration. Different initial positions may lead to different results.

l Top-view-based and Cloud-to-Cloud
Performs a top-view-based registration first and then a cloud-to-cloud registration.

Manual Registration Settings
Select if you want to optimize each registered pair of scans with cloud-to-cloud registration. This
optimization is always done before you are asked to select another pair of scans.

Target-based Registration Settings

Find correspondences for scan positions
Mark this checkbox if the position of a scan is known, for example, by a surveyed reference point or by a
reference sphere representing the position of the scanner in other scans.

Force correspondences by target names
Mark this checkbox, if you want to force correspondences by target names. The targets in each scan must be
named according to their counterparts in the other scans. This feature requires that targets are already
detected by SCENE. In Settings > Process, select a target search, then run Process. After that, open the
cluster or the scans in Explore. You can then click the target’s names the in structure view and rename
them.

Use Checkerboard Normals
If this setting is active, the normals of checkerboards are used for the correspondence search. Uncheck if the
direction of checkerboards has changed from one scan to another. For example, if you use checkerboard
targets that can be tilted and turned for a precise orientation to the scanner.

Target Distribution Threshold
Sets the limit for registration. If targets are too near to one another, registration will be refused. In this case,
lowering the limits gives you a result.
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Top-view-based Registration Settings

Subsampling
The result of the registration can be adjusted through the subsampling rate. The value defines the size of the
grid in which scan point homogenization is performed. The resulting grid of points will be used to perform
the registration. When you move the slider, the set value will be shown. Five centimeters (0.05m) usually
work for all environments. If you are indoors, in an industrial environment, you can reduce the subsampling
to 0.35m or even 0.25m.

Reliability
The reliability value determines the amount of additional checks on a registration. It filters out results that
could be contested. Higher values allow for more certainty, but could affect the needed time by algorithm to
provide a solution. Set the slider to the value which you expect to bring the result you want. As soon as you
move the button, the set value will be shown.

Cloud-to-Cloud Registration Settings

Subsampling
The result of the registration can be adjusted through the subsampling rate. The value defines the size of the
grid in which scan point homogenization is performed.

Set the slider to the value which should bring the result you want. As soon as you move the handle, the set
value will be shown.

Maximum number of iterations
You can define the maximum number of iterations for the algorithm to find the best solution. By default this
parameter is set to 30 iterations. Click this number to open the input field. Enter the number of iterations.

Maximum search distance
The maximum distance in which the registration searches for corresponding points. The maximum search
distance must be larger than the initial misplacement. By default the distance is set to 10 meters. Click this
number to open the input field. Enter the distance you want.
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Registration Report Settings
On this page, you can define settings for the Registration Report. You can define settings for the following:

Scan Point Statistics, i.e., the references between scan points which are calculated by a top-view-based or a
cloud-to-cloud registration

Target Statistics, i.e., references between targets returned by a target-based registration

Thresholds
You can define thresholds as follows:

Values below the first threshold are shown in green, and values above the second threshold are shown in
red. Values in-between are shown in yellow. The color codes are used in the Registration Report, the Project
Dashboard, and the Scan Managers.

Set specific thresholds by clicking in the field and entering a new value.

NOTE:
For the interactive registration, it is recommended to use the following threshold values:

l Thresholds for overlap color coding: Set to 5% for Red below and to 20% for Green above.
With the default settings a lot of connections between scans would be displayed yellow if the
overlap is very low. (If you have previously used the default settings, you must set Red below
first, because otherwise, you can't set the Green above value).

l Thresholds for point error color coding: Use default values of 20 mm for Red above and 8
mm for Green below.

Views settings
The Views settings page provide settings for:

l 3D View

l Quick View

l Planar View

SCENE User Manual
Chapter 5: Settings

SCENE User Manual (2024.0) Page 56 of 372



General Views Settings

Explore
Check the Automatically Open 3D View option under the Explore category. When you switch to explore
category, a new 3D view is opened. You can uncheck this option if the 3D view takes a lot of time to load.

Measurement Properties
TheMeasurement Properties provides settings to set the displayed measurement distances for all views.

The following options are available:

l Overall Distance: This is the default setting. The overall distance measured between two points is
displayed.

l Horizontal Distance: The horizontal measurement of the point-to-point distance is displayed.

l Vertical Distance: The vertical measurement of the point-to-point distance is displayed.

The selected distance measurements will be shown in 3D view, quick view, and planar view.

The chosen distance value will be displayed in all new measurement objects.

However, to change the displayed measurement distance for each individual measurement, use the
Measurement Object Properties dialog.

3D Views Settings
The settings for the 3D view are separated into Display and Navigation settings. All these settings will be
applied when a new 3D view is opened. These settings will not be applied to views which are already
opened.

Navigation
Default Mode: Select the navigation mode to be activated when you open a new 3D view. You can select
among Fly, Examine, or Smart mode as default navigation modes. Depending on your selection, the 3D
toolbar button changes its appearance.

Invert Mouse Wheel: Changes the forward and backward movement by the mouse wheel. The default
behavior of the mouse wheel is: spinning it forward will move the view backwards in space and vice versa.

Use Positional Zoom (instead of Optical Zoom): Sets the zoom mode for the 3D view. The default zoom
is a positional zoom, meaning that it zooms by behaving as if the position of the camera (that is, the position
from which you observe the scan) is moving toward the position of the cursor on the screen. This allows

SCENE User Manual
Chapter 5: Settings

SCENE User Manual (2024.0) Page 57 of 372



zoom, meaning that it zooms by behaving as if the position of the camera (that is, the position from which
you observe the scan) is moving toward the position of the cursor on the screen. This allows you to do
things like zoom past or through objects. Prior to SCENE 2019.1, the default zoom was an optical zoom,
meaning that it zoomed by increasing the magnification of the scan (as if you were standing in one position
and using a zoom lens to magnify the scan). Note that you can toggle between these two modes on-the-fly
by pressing and holding the SHIFT keyDefault Movement Speed: Change the speed of the left, right,
forward and backward movement triggered by pressing the cursor keys.

Acceleration Factor: This is the factor which is used to determine the accelerated speed. The accelerated
speed is the factor multiplied with the default speed. The accelerated speed is used by pressing the cursor
keys in combination with the SHIFT key.

The settings invert Mouse Wheel, Default speed and Accelerated Factor will be applied to the opened
view.

Display – Effects
Supersampling: renders the point cloud with a resolution higher than the resolution of your screen and then
shrinks the point cloud to fit the screen resolution. This reduces anti-aliasing effects and gives the point
cloud a smoother visual appearance. Fine and filigree structures look sharper and stray points will appear
less annoying. Set the resolution of the initially rendered point cloud compared to the screen resolution by
selecting one of the options 2x2, 3x3, or 4x4. For example, choosing 2x2 means that the point cloud will be
rendered with a resolution that is 4 times the resolution of your screen.

Figure 5-5 Supersampling turned off (left) and turned on (right)

NOTE: Objects like walls might appear transparent when using small point sizes in combination with
supersampling.

High supersampling resolutions such as 4x4 require large amounts of graphics card memory.
Gap Filling: The gap filler fills gaps between scan points that are physically close to each other.

Clear View: In the clear view mode, points in areas with low point density will be displayed more
transparently and points in areas with a high point density will be displayed more brightly. It adds
transparency to the otherwise completely opaque point cloud rendering. This allows for viewing through
walls or ceilings and may give a much better impression of the spatial structure of the underlying point

SCENE User Manual
Chapter 5: Settings

SCENE User Manual (2024.0) Page 58 of 372



In the clear view mode, points in areas with low point density will be displayed more transparently and
points in areas with a high point density will be displayed more brightly. It adds transparency to the
otherwise completely opaque point cloud rendering. This allows for viewing through walls or ceilings and
may give a much better impression of the spatial structure of the underlying point cloud. Points in areas with
low point density will be displayed more transparently and points in areas with a high point density will be
displayed more brightly.
NOTE: Changing the effects will be applied if a new 3D view is opened. The effects which can be changed

directly in the 3D view are only applied to the 3D view which is opened.

Gap filler or clear view can only be activated if supported by hardware.

Display – Background
Select either Environment Map or Color Gradient.

Environment Map

See Environment Map as Background Image for a 3D View

Color Gradient

The gradient background color starts with the selected top color and transitions linearly to the selected
bottom color.

1. Click the Top Color button to open the color selector dialog.

2. Select the color that you want the background to start at the top of the display.

3. Click the Bottom Color button to open the color selector dialog.

4. Select the color that you want the background to start at the bottom of the display.

Display – Scans
Loaded scan replaces scan point cloud in 3D view

Two representations of a scan exist in your project, the original scan points and the optimized scan point
cloud. If this option is selected and the scan is loaded, the original scan points are used for visualization
instead of the scan point cloud.

The scan point cloud representation is optimized for visualization performance of a scan. Any combination
of original scan points and scan point clouds in a single view will disable tools such selections and the
visualization performance may degrade. Deactivate this setting to avoid these issues.

Environment Map as Background Image for a 3D View
SCENE offers solid or gradient color backgrounds in a 3D view. These are suitable for editing of point
clouds, but when a realistic visualization is needed (like for capturing a video of an outdoor scene in the
Video App), the result would look somewhat boring.
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To make such scenes or videos look more realistic, you can add a so-called Environment Map as a
background image.

The background image selected last will be used as a default setting for a new 3D view.

Figure 5-6 3D view with a solid gray background

Figure 5-7 Environment Map showing a cloudy sky
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Figure 5-8 3D view with Environment Map

How to add an Environment Map
The usage of Environment Maps can be enabled in the Visibility Settings dialog of a 3D view.

1. Click the Settings button on the right side of the workflow bar, then select the View page.

2. To select a new Environment Map, click the Browse button in section Background >
Environment Map.
A dialog opens with the folder Environment Maps.

3. Select your new background image and click Open. The file name is now shown in the View tab.

The selected Environment Map will be saved with the project. So, when another person on another machine
opens the project, the Environment Map will again be shown as background image.

Limitations
At the moment, the Environment Map is only available for 3D views with a perspective camera setting. For
views with orthographic cameras, it is disabled.
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Creating individual Environment Maps
If you need a special background image for your scan project, you can create it yourself.

It must fit the following conditions:

l Aspect ratio 2:1, which means that it is twice as wide as it is high.

l The lower half of the image shall show “ground” and should not show too much structure.

l The image is later mapped to an imaginary spherical firmament.

l should look distorted because it is meant to texture a sphere. Professional graphics editors offer a feature
called “Spherics” which may help in creating suitable images.

l The left and the right end of the image must fit.

You can save the newly created Environment Map into the folder SCENE\EnvironmentMaps, but you can
save it to any other folder as well.

Planar and Quick View Settings

Scan Data Load Behavior
Select the default scan load behavior to be used to load a scan for planar view or quick view. By default, the
scan is loaded in color mode.

Overview Map Settings

Foreground Color
Defines the color of the overview map itself

Background Color
Defines the color around the overview map

Highlight Scan Color
In the overview map, the scanner positions are displayed as dots. When you hover the mouse pointer over
such a dot, all scan points related to this scans are highlighted in the defined color.

Highlight the scan points when selecting the scan position
When is option is active and you click a scanner position in the overview map, the color of the scanner
position changes, too.
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Export Settings
The Export settings page provides Units settings for exporting SCENE data.

Units
Set the default unit of length used to export data.

Select one of the units of length:

l Millimeter [mm], Centimeter [cm], Meter [m]

l Inch [in], Feet [ft], Yard [yd]

l Inch [in US], Feet [ft US], Yard [yd US]

The default setting is Meter [m].

NOTE: Some export formats like PTX do not support user-defined Unit settings. They support only the
metric system

WebShare Settings
The WebShare settings page provides settings to login to WebShare.

NOTE:WebShare is being replaced by the new cloud solution Sphere XG. Contact the FARO support or
find information in the Sphere XG user manual.

Login
The login credentials will be used to automatically log in every time a connection to WebShare is required
for Import or Export process.
Domain: Enter your organization’s subdomain name on WebShare.

User Name (email) : Enter the user name to log in to WebShare.

Password : Enter the password with which to log in to WebShare.

Login and Save Credentials : Click to save the login credentials to WebShare button. If the login is not
successful, an error message is displayed and the credentials are not saved.
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Upload and Download SCENE Projects to/from
Sphere XG

Starting from SCENE 2024.0 you can upload SCENE projects to the cloud solution Sphere XG. It is also
possible do download projects from Sphere XG and to make incremental uploads from SCENE to Sphere
XG.

The cloud solution Sphere XG replaces Sphere Legacy and WebShare Cloud. For more information on
Sphere XG, see the Sphere XG user manual.

This feature is in continuous development. You may find more recent information on the FARO Knowledge
Base.

NOTE:
l You can only upload FARO Focus scans. The upload will fail if your project contains other
scan file types, for example created by the Orbis scanner, the legacy Freestyle or imported .e57
files.

l The upload will fail if the SCENE project folder contains files that were added manually, for
example .csv files, .docx files, .e57 files.

l You need a Sphere XG account to use this upload feature.

Sign into Sphere XG

1. In SCENE, click the Sphere XG profile icon in the top right corner.
You are redirected to the Sphere XG sign-in page. If you are signed in, the icon picture changes to
your initials.
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Figure 5-9 Sphere XG log-in form

The connection to Sphere XG is established in the browser. If the sign-in is successful, the message Login
successful - Switch to SCENE is displayed.

2. Go back to SCENE.

You may need to wait a few seconds until the workspace selector is displayed.

Figure 5-10 Select a workspace

3. Select the Sphere XG workspace to which you want to upload the project.
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Upload a Project
NOTE:

l You can only upload one project at a time.

l If you want to upload more than one SCENE project at a time, you can open multiple SCENE
instances.

l You must have sufficient permissions to upload a SCENE project, i.e. the permission to create
a project.
You can find an overview of roles and permissions in Overview of Roles and Permissions on
the Workspace and Project Level in the Sphere XG user manual.

l A project point cloud must be available in the SCENE project if you want to see the 3D point
cloud in the Sphere XG Viewer.

1. Open the SCENE project you want to upload.

2. On the Project tab, click the Upload button on the Sphere XG tile.

Figure 5-11 Upload to Sphere XG tile

The Upload to Sphere XG dialog is displayed.
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Figure 5-12 Upload to Sphere XG dialog

3. Enter the Sphere XG project name you want.
This name can be different from the name in SCENE.

4. Select the workplace to which you want to upload the project.

5. Select the group to which the project will be assigned in Sphere XG.

6. Click OK.

The upload will be started.

When the upload is finished, the Sphere XG tile in tab Project will turn green.

To open your project, open Sphere XG and go to the previously selected workspace. For more information,
see Open an existing project in the Sphere XG user manual.

Download a Project from Sphere XG
1. Open SCENE, sign into Sphere XG and select the workspace as described above, then follow the steps

below:

2. On the Projects Overview page select Show Cloud.

Figure 5-13 Show Cloud tab

3. Click the three-dots icon on the tile of the project that you want to download.

4. Select Light Download or Full Download, see further explanations below.

If you click the project tile when Show Cloud is selected, SCENE will automatically start a light download
of the project.

When a project is downloaded, you will notice that the scan point clouds and the project point cloud are not
present in the project. This is to minimize the amount of data that is uploaded/downloaded. You should
recreate them if they are needed.

l Full download: Downloads the entire SCENE project as described above.

l Light Download: Downloads only the project structure and metadata. The scans are only downloaded
when they are loaded in SCENE. The light download allows you to easily and efficiently add or remove
scans in existing large projects without the need to download the entire project.
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You can find more detailed information and tutorials on the FARO Knowledge Base.

Synchronize Changes with Sphere XG from within
SCENE
Once you have uploaded a project to Sphere XG, it is possible to make changes in your SCENE project and
to synchronize those changes with Sphere XG. Once the changes are synchronized, they will be visible in
the Sphere XG Viewer.

The following changes can be synchronized:

l Added and removed scans.

l Modified registration of the existing scans.

l Modified scans, e.g. reprocessed, points cleaned.

l Modified project point cloud.

This is a major improvement compared to the existing WebShare Cloud workflow where a new WebShare
Cloud project had to be created for every project update. With Sphere XG it is easy and efficient to perform
incremental updates on uploaded projects.

To synchronize the changes:

1. Save the project.

The Sphere XG tile is highlighted yellow and the Sync button is enabled to indicate that the project is no
longer in sync with Sphere XG.

Figure 5-14 Sphere XG tile

2. Click button Sync.

You can find more detailed information and tutorials on the synchronize functionality on the
FARO Knowledge Base.
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Change the Workspace

1. Click the Sphere XG icon in the top right corner.
The Log off or choose the Sphere XG workspace dialog is displayed.

Figure 5-15 Change workspace or sign out of Sphere XG

2. Open the dropdown list and select the workspace you want.

3. Click OK.

Sign out of Sphere XG

1. Click the Sphere XG icon in the top right corner.
The Log off or choose the Sphere XG workspace dialog is displayed, see above.

2. Click Log Out, then click OK.

Troubleshooting

How to resume an aborted upload?

1. Go to the Project tab.
The Sphere XG tile will show a Resume upload button.

2. Click this button to resume the upload.

How to re-upload a SCENE project that has been previously uploaded?

Open the project

From the project tab you can remove the existing connection between your SCENE project and the Sphere
XG project by clicking the icon next to the Sphere XG link (see figure below). Note that the connection
between the project in SCENE and the project in Sphere XG cannot be re-established once it is deleted.
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Figure 5-16 Remove connection between SCENE and Sphere XG project

Note that this may also work when uploading a project fails. You can find more troubleshooting information
on the FARO Knowledge Base.
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Chapter 6: Project

The Project toolbar provides the features for your entire scan project.

There are two sets of toolbars, one that shows up when no scan project is opened, and one that shows up
when a scan project is opened.

Project Features when no Scan Project is Opened

Figure 6-1 Project toolbar when no scan project is opened

l Create Project: Create a new scan project from scratch.

l Open Project: Open an existing scan project. Clicking the little arrow opens a dropdown menu with the
recently loaded scan projects.

l Open Project History: Open a specific revision of a scan project. Clicking the little arrow opens a
dropdown menu with the recently loaded scan projects. When you have selected a project, another dialog
opens in which you must select a project revision.

l Project Transfer: Transfer scan data from an SD Card, or from any other place.

Create Project
Create a new scan project. The new scan project is initially empty and you must fill it.

There are different ways to create new scan projects:

1. Click the Create Project button in the toolbar. The Create New Scan Project dialog appears:
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Figure 6-2 Create a new project

2. Enter a location, or click the Browse button to open the file manager.

3. Enter a project name.

4. Click Create. All necessary files and structures will automatically be created at the selected location.

When creating a new scan project from scratch, you must fill it with the appropriate scan files. SCENE
offers several Import features.

The scan project can be identified by the .lsproj file which is accessible in the folder of the scan project.
It is usually named like the scan project itself.

You may also create a new project by transferring scan data from an SD Card, exporting an existing scan
project, a cluster, or a single scan to a different location. For this, use the Export features.

You can also create a new project based on a project revision of another project.

Open an Existing Project
There are different ways to open scan projects:

1. Click the little arrow besides the Open Project button in the toolbar.
A dropdown menu with the recently loaded scan projects opens.

2. Select a project from the dropdown menu.

or

1. Click the Open Project button in the toolbar.
The Open Existing Project file manager is opened.

2. Enter a path, or browse to find the folder containing the project that you want to open.

3. Select the project and click Open.

or

Click one of the project tiles in the Projects Overview.
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NOTE: The scan project can be identified by the .lsproj file which is accessible in the folder of the scan
project. It is usually named like the scan project itself.

Open Projects in Read-Only Mode
When a user has opened a project, other users can open this project in read-only mode.

When users try to access the scan project while a write lock already exists, the scan project will only be
opened in read-only mode.

l The SCENE title bar contains a new additional read-only warning string between the project name and
the SCENE version.

l When trying to save a project opened in read-only mode, the message box informs that you must open
the project with write access to be able to persist modifications.

Transfer a Project
The Project Transfer task can be used to transfer scan projects from a source folder to a target folder.

A typical example for a project transfer is the SD card import. If an SD card is inserted, the SD Card
Transfer task will open automatically, and the SD card will be used as predefined source folder.

Transfer scan projects from a storage medium

1. Click button in the toolbar.

2. Select the source folder.
If you wish to change the predefined folder, carry out the following steps:

a. Click the Browse button to open the file system browser. You cannot enter a project folder
path directly into the field.

b. Browse to the folder.

3. Select the target folder.

4. Select the Transfer checkbox of all scan projects that you want to transfer.

5. Select the Process checkbox if you want the imported project to be processed automatically after the
import is finished.

You can select and deselect all checkboxes in columns Transfer and Process at once by selecting or
deselecting the corresponding checkboxes in the header line.

NOTE: If you do not only wish to process the scan project but even to register its scans afterwards, go to
Settings > Processing. Activate Perform Automatic Registration. In addition, you can change
the registration method on page Registration.
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6. Click the Start Transfer button to start the transfer.

Transfer scan projects from SD card
If you insert an SD card and SCENE is already running, the SD Card Transfer dialog will be shown after
some seconds.

If a scan project is already opened, this scan project must be closed before the SD Card transfer can start. In
this case, the SD Card Transfer dialog will show a warning.

1. Click the Yes button to start the SD Card Transfer task.

2. Select the scan projects to be transferred by checking the Transfer checkbox of the project.
If there is more than one scan project, you can select/deselect all checkboxes by clicking the checkbox
in the header line.

3. Select the Process checkbox if you want the imported project to be processed automatically after the
import is finished.
If there is more than one scan project, you can select/deselect all checkboxes by clicking the checkbox
in the header line.

4. Select the target folder. If you wish to change the predefined folder, carry out the following steps:

a. Click the Browse button to open the file manager. You cannot enter a project folder path
directly into the field.

b. Browse to the folder.

c. In the folder, select the scan project file, which is a file with the file ending .fws or .lsproj.

For every project to be transferred, SCENE will search for a matching project name in the
predefined project folder.

d. If a matching project is found, the target folder will point to the folder of the project and an
Import project icon is shown. The transferred project will be merged into the existing
project.

e. If no matching project is found, the target folder will be a new folder in the project folder based on
the name of the project. In this case, an Add project icon is shown.

5. Click the Start Transfer button to start the transfer and finish the task.

After the transfer was performed, the task is closed and a message is shown in which all projects are listed. 
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Project Features for an Opened Scan Project

Figure 6-3 Project toolbar for an opened scan project

Close Project: Closes the currently opened scan project. Before, you will be asked if you want to save the
scan project. If you click Yes, you can enter a comment, and the author’s name. You can also select if the
project point cloud shall be updated before closing the scan project.

Project History : Shows all revisions of a scan project and allows to load a specific version or revert to a
specific version.

Wipe Project History : Deletes the project history, which means, that all revisions will be lost.

Work with the Project History
All revisions of a scan project are available in the Project History. Note that you can also open a specific
project revision when no project is opened.

Click the Project History button to open the history of a scan project.

Figure 6-4 Project History
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The project history shows the following information: 

l all revisions of a scan project numbered from 1 to x

l the date the revision was saved

l the name and version number of the FARO application that was used to save the project

l the author (either the application or the user) that saved the revision

l any comment added when saving

Revert to a Project Revision

This feature is useful, for example, when you made changes that you want to undo.

NOTE: After you revert to a specific revision, all revisions that were created after the revision you are
reverting to will be deleted and are no longer available.

1. Click the revision that you want to revert to.

2. Click button Revert.
Dialog Revert to revision <revision number> is opened.

3. In the dialog, type the word revert and click OK.
A message is displayed confirming the reversion.

4. Confirm message.

Export a Revision to Another Project

Exporting a project revision to another location creates a new project based on this revision.

1. Click the revision that you want export.

2. Click button Export to ....

3. In the dialog that opens, select a file location for the new project and enter a project name.

4. Click OK.
A message is displayed confirming the creation of the new project.

5. Confirm message.

Load Revision

When you want to look at a project at a given date or in a given state, you can load a specific project
revision.

NOTE: Note that you can load previous project revisions in read-only mode only. When you have loaded a
revision, all later revisions are no longer visible. When you close and reopen the project, all
revisions are visible and accessible again.
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If you want to continue working with a given project revision, use function Export to ... (see above) to
create a new project based on a selected project revision.

1. Click the revision that you want to load.

2. Click button Load Revision.

The selected project revision is loaded in read-only mode.

Wipe Project History
As a project grows over time, numerous revisions may accumulate in the scan project history. Thus it may
become necessary to reduce the number of revisions and the amount of stored data, for instance when an
important milestone has been reached and the individual steps are no longer needed. At this point you may
delete all revisions, and save a new revision.

NOTICE: The scan project history is deleted.

All information about the history of a project will be lost. You will no longer be able to revert
the project to a previous revision afterwards.

1. Click theWipe Project History button. After confirming a warning message, the Share Changes
dialog opens.

2. If required, modify the entry.

3. Click the OK button.
SCENE will then start to create a new revision.

NOTE: If revision history is critical, you should Export the scan project. Exporting the scan project will
perform a cleanup and compact function but stores the results in a new scan project. The revisions
of the original project will be kept. 

Basic Concepts
The following basic concepts are important for understanding SCENE.

Scans
Scans are the scan files as they are recorded by the scanner with their millions of data records that include
position, reflectance, and color for single scan points. Scans consist of scan points that were recorded from a
single scanner location. They are organized in a row column order.
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Scan Point Clouds
Scan point clouds are an alternative representation of the scans and must be created from the single scans.
Scan point clouds are organized in a spatial data structure that facilitates fast visualization of scan points and
automated point loading based on point visibility. They may facilitate and accelerate the processing of the
scan points.

Project Point Cloud
The result of a scan project in SCENE typically is a comprehensive project point cloud of the scanned
object.

Unlike scans and scan point clouds, the project point cloud consists of the points of all the scans within your
scan project and can be seen as a comprehensive point cloud of the complete scan project. This means that a
project point cloud can be very large. It is typically created from all the single scans in your project after
they have been processed, colorized and registered.

The project point cloud is optimized for fast visualization of large amounts of scan points in the 3D view
and is organized in a spatial data structure that facilitates fast visualization of the scan points. However, such
large amounts of points cannot be loaded into a physical memory at once. Therefore, the points of the
project point cloud are automatically loaded and visualized on demand based on the camera position and
point visibility. The automated point loading of the project point cloud can visualize hundreds of scans at
once. This empowers you to actually see all scans of a scan project at once regardless of whether they fit
into your computer’s physical memory. Manual scan file loading is not necessary.

As the point cloud visualization technique is constantly loading scan points from the hard disk drive based
on point visibility, the overall performance strongly depends on the speed of your hard disk drive. While
project point clouds outperform all other visualization methods (including scan point clouds) on regular hard
disk drives, we recommend using a solid state drive for maximum performance. Using a solid state drive
will also speed up the process of creating the project point cloud.

Structure View
In the structure view, you can see the hierarchy of the objects.
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There are various views to display and explore scans and scan point clouds:

l Quick View: The standard scan view to examine single scans. For this, the scan doesn't have to be
loaded. The quick view is available within a few seconds. In the meantime, the scan data will be loaded
in the background. You can manipulate the scan points as soon as background loading is finished. Until
then you are only able to view and navigate. You can find further information in topic Quick View.

l Planar View: Used to examine single scans. The scan must be loaded. At first glance, the planar view
may appear very strange because the scanned area seems to be distorted. Connections between objects in
the picture do not run in a straight line but are curved. For the planar view, uses the same technique as it
is used for depicting the earth's surface on a map where the area around the poles appears to be
magnified, and the flight route between two distant cities is not straight but bent. You can find further
information in topic planar view.
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l 3D View: With the 3D view, you can achieve the most easily comprehensible view of the scan points
and CAD models. The 3D view is normally set up with the field of view corrected, so that you get an
impression close to reality. Unlike the quick view and the planar view, scan points manipulation and
analysis is limited in the 3D view. You can find further information in topic 3D view.

l Overview Map: The overview map provides a top view overview to the whole scan project. The map is
by default, a gray scale image. It is recommended to create the map after the registration and cleanup of
scan points is completed. (Note that the map is created from the points in the individual scans—not from
the project point cloud.) You can find further information in topic Overview Map.
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Chapter 7: Import

This chapter gives an overview of the formats that are supported by SCENE to import scans, projects,
objects, or images.

Figure 7-1 Import features
Import Scans: Imports scans and point clouds. This includes FARO Focus Laser Scanner files (FLS), E57
files, PTZ files, PTX files, and unstructured point data in ASCII XYZ, LAS, and LAZ. With PTX and
ASCII XYZ files, you must make sure that the scan points in the scan file are arranged in a way that they
correspond to the row or column-oriented recording process of the scanner. You also must make sure that
the scan was not registered.

Import Projects: Will SCENE Projects into existing projects. Note that this is different from simply
opening a project.

Import Mesh Objects: Will import VRML files, i.e. WRL and WRLGZ, as well as OBJ (Wavefront) files.

Import Surveyed Points: Will import surveyed points files, i.e. CSV or COR files.

Import Images: Will import images as a layout plan, virtual scan, or simple image.

Import WebShare: Will start the WebShare Import assistant.

Import by Drag & Drop
The easiest way to import scan projects, scans, images, or objects is by drag & drop.

NOTE: Drag & drop is not only available in the Import window. You can also use it in all other steps in
which the structure view is available.

1. Open a file system browser, for example, MS Explorer.

2. Click the Import button in the Workflow bar.

3. In your file system browser, select the file to be imported.

4. Drag & drop the file to SCENE in the Drag & Drop field. The Drag & Drop field will change its size
and its color as soon as the file is accepted.
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Depending on the type of the file, the following would happen:

Importing a scan project
The scans and objects of the newly imported scan project will be added to the currently opened scan project.

CAUTION! Scan names must be unique. If a scan in your project has the same name as a scan in the
project you are importing into, the existing scan will be replaced with the imported scan.

Importing a scan
The newly imported scan can be found in the structure view, in the cluster the mouse pointer was when
dropping the file. You can move it to another cluster, again using drag & drop.

NOTE: Newer versions of the FARO Focus Laser Scanner allow the creation of scan groups, which are
several scans created without moving the scanner.

One use for scan groups is to make a complete 360° scan, and then to make several higher-
resolution partial scans of the targets that are visible in the first scan. This reduces the total time
needed to scan the area, while still getting high-quality scans of the targets to ensure that
registration is accurate.

Importing an image
After dropping the image file, the Import Pictures dialog will open.

The newly imported images can be found in the Pictures folder.

Importing objects
After dropping the object file, a dialog will open in which you can adjust some settings. Those settings
depend on the file format of the object.

The newly imported object can be found at the following positions in the structure view: objects in VRML
format in theModels folder, objects in CSV format in the References folder, and so on. You can find
further information in Import Mesh Objects and Import Surveyed Points.

Import Scans
The Import Scans feature allows to import scans and point clouds. This includes FARO Focus Laser
Scanner files (FLS), E57 files, PTZ files, PTX files, and unstructured point data in LAS, LAZ, and ASCII
XYZ format.
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1. Click the Import Scans button in the Import toolbar.

2. Browse to select the files which you want to import.

3. Click the Open button.

After closing the file manager, SCENE will start to import the selected files and show the progress.

The newly imported scans can be found in the structure view. You can move them to a cluster by drag &
drop.

When importing files with a space in the file name, this space will be automatically replaced by an
underscore.

Cancel Import
You can cancel this import process by clicking the Cancel button.

The Cancel button will not stop the import immediately, but after importing the current file. This is the
reason why the Cancel button is not available if the import was started for only one file.

When the Cancel button was clicked, it will be grayed out and the status message is updated.

General Scan Data Format .xyz
XYZ files sometimes contain row and column information for each scan point:

l If the xyz file contains row and column information, the data is imported as an ordered scan that can
also be displayed in the quick view and the planar view.

l If the xyz file does not contain row and column information, the data is imported as unordered scan
point cloud. In this case, the quick view and the planar view are not available.

After the XYZ coordinates, either the intensity value or the RGB value may be supplied. When importing a
xyz file that contains both types of values, only the RGB value is used.

Scan Data Format .ptx
PTX is an ASCII based interchange format for point cloud data, which is usually created with the scan
software Leica Cyclone.

This format is especially suited for exchanging scan points and their corresponding coordinate
transformation.

All values are given in ASCII and are metric. The first line states the number of columns, the second line
the number of rows. In the next line, the translation part of the transformation is given (a 3D vector). After
that, 3 lines with the rotation part follow (a 3x3 matrix). The next 4 lines contain the full transformation (a
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4x4 matrix). Finally the scan points are written, one scan point per line: x, y, z, and a reflection value. In
addition, the RGB value may follow. The reflection value is between 0 and 1.

When importing a PTX file, the following dialog opens:

Figure 7-2 PTX import dialog
Rows per column: The input file contains the data column-wise, i.e. it starts with all the rows of the first
column, then all rows of the second column, and so on. Good when importing FARO PTX files.

Columns per row: The input file contains the data row-wise, i.e. it starts with all columns of the first row,
then the second row, and so on.

Linear: A linear mapping of intensity values to gray values.

Non-linear: A non-linear mapping of intensity values to gray values. Good when importing for example
Leica PTX files. If the PTX file contains a RGB value, intensity mapping is not done. The RGB value is
used instead. If the PTX file contains both, RGB and intensity values, the RGB value is used.

NOTE: If your input looks not right in the planar view, but seems to be OK in the 3D view, try to import
again with a different row/column orientation.

If the Apply to all checkbox is selected and you click the OK button, it will apply the same settings for the
following scans and will not ask again.

If you click the Cancel button, the import will abort for the current scan and all following scans. Scans that
were already imported will remain.

Scan Data Format .ptz
PTZ is the binary data format of Leica HDS scan files, which are usually created with the scan software
Leica Cyclone.

When importing a PTZ file, the following dialog opens:
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Figure 7-3 PTZ import dialog
Linear: A linear mapping of intensity values to gray values.

Non-linear: A non-linear mapping intensity values to gray values. Good when importing for example Leica
PTZ files.

If the PTZ file contains colors, intensity mapping is not done. The colors are used instead.

If the Apply to all checkbox is selected and you click the OK button, it will apply the same settings for the
following scans and will not ask again.

If you click the Cancel button, the import will abort for the current scan and all following scans. Scans that
were already imported will remain.

Scan Data Format .e57
This scan data format is a vendor-neutral standard for storing point cloud data produced by 3D imaging
systems. The “ASTM E57 3D file format” (officially ASTM E2807) is a format for three-dimensional
imaging data such as laser scans. The E57 file is used as shorthand for “ASTM E57 3D file format” and is a
combination of binary data and XML (eXtensible Markup Language).

An E57 file can store 3D point data, attributes associated with 3D point data such as RGB or intensity
values, or both. (The specification of the format is available on www.astm.org/Standards/E2807.htm.
SCENE uses the library libE57 V1.1.312 to write and read E57) files.

SCENE supports the import of several features of the E57 file, for example exported by FARO Connect.
When importing, the E57 file must contain xyz or spherical coordinates as well as RGB or intensity values
for each scan point. If the E57 file contains RGB and intensity values, the RGB value is used.

If the E57 file doesn’t contain information about row/column ordering, the following dialog opens:
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Figure 7-4 E57 import dialog

Select the correct ordering of the file, then click the OK button.
Rows per column: The input file contains the data column-wise, i.e., it starts with all the rows of the first
column, then all rows of the second column, etc.

Columns per row: The input file contains the data row-wise, i.e., it starts with all columns of the first row,
then the second row etc.

Currently, SCENE doesn’t support the import or export of associated 2D images.

If the Apply to all checkbox is selected and you click the OK button, it will apply the same settings for the
following scans and will not ask again.

If you click the Cancel button, the import will abort for the current scan and all following scans. Scans that
were already imported will remain.

Import Projects
The Import Projects feature allows to import SCENE scan projects.

NOTE: The Import Projects feature will only work if a valid SCENE project is already open.

1. Click the Import Projects button in the Import toolbar.
The file system browser will open.

2. Browse to select the files which you want to import.

3. Click the Open button.

The scans and objects of the newly imported scan project will be added to the currently opened scan project.

Import Images
The Import Images feature will import images as virtual scans, layout plans, or simple images.

SCENE User Manual
Chapter 7: Import

SCENE User Manual (2024.0) Page 86 of 372



There are three ways to use images in SCENE:

l Images with their original resolution which provide additional information about the scan environment

l Images with their original resolution which provide additional information about the scan environment.
These images are imported into the 3D world as virtual scans with their full resolution. Such images will
be interpreted like a high resolution scan of a plane surface and can be placed on arbitrary positions in
the 3D world.

l Images which add color information to already existing scan points

1. Click the Import Images button in the Import toolbar.
The file system browser will open.

2. Select the file format Image Files (*.bmp, *.jpg, *.png).

3. Browse to select the files which you want to import.

File names of imported images cannot be renamed in SCENE. Ensure that the image file has the name you
want before importing it.

4. Click the Open button.
The following dialog appears:

Figure 7-5 Import image dialog

5. Select how you want to use the image.
If there are several images for one application, select Apply to all, or select the appropriate ones.

Import High-Resolution Image as Virtual Scan
This method allows you to include high resolution pictures (for example, digital photos of important details
in the scan environment) into the 3D world by importing them with their full resolution as virtual scans.
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Such pictures will then be interpreted as a high-resolution scan of a plane surface and can be placed in an
arbitrary position in the 3D world.

For this, import a picture into SCENE as virtual scan (see above).

If you choose to create a virtual scan, the picture will be placed in the scan folder of the structure view and

be marked with a special icon , signifying that it is a picture with 3D information.

Figure 7-6 Virtual scan in the structure view

Initially, the virtual scan is scaled in such a way that the longest side of the picture is equal to 1 meter. The
initial position in the 3D world is in the origin of the coordinate system.

Figure 7-7 Virtual scan in 3D view

The main application for virtual scans is to complement existing 3D scans with detailed information from
high resolution photos of flat surfaces.

In this case, size and location of the virtual scan are fixed and can be determined by using the Place on
Surface command under Operations > Registration in the virtual scan’s context menu.

The command Place on Surfaces scales and places the virtual scan in the 3D world using a plane and
corresponding points in the virtual scan and a scan in the 3D world. The command Place in 3D places the
virtual scan upright in the 3D world.
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The technique to place and scale virtual scans is similar to the one used to colorize existing scan points. This
time, however, new points are created from the pixels of the picture and added at the proper position in the
3D world.

Place on Surface
The position of the virtual scan is defined by a plane that must be created in one of the scans at the
approximate position where the virtual scan should be placed. The exact position and size on this plane are
then determined by selecting matching points in the virtual scan and in a real scan.

1. In the structure view, right-click the virtual scan, then select View > Planar View.
A new tab opens which shows the virtual scan.

2. In the structure view, right-click the scan in which the virtual scan shall be placed, then select View >
Planar View or Quick View.

3. Use theMark Plane function to mark the area where the virtual scan shall be placed.

Mark Plane to place virtual scan

4. In the structure view, right-click the virtual scan and select Registration > Place on Surface.
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Figure 7-8 Place and scale dialog

5. In the structure view, click the scan, then click Use Selection in the dialog.

6. In the structure view, click the plane, then click Use Selection in the dialog.

7. Click Associate Points.
The mouse pointer changes and is displayed cross-shaped.

8. Mark at least 4 suitable scan points in the virtual scan.
Each scan point position is listed in the Image column in the dialog.

9. Mark the corresponding scan points in the scan.
Take care to keep the same order. Each scan point position is listed in the Scan column in the dialog.

10. When you are done selecting points, click Done to place and scale the virtual scan.
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Figure 7-9 Placed and scaled virtual scan in 3D view

11. Open the scan folder or cluster in 3D view.

12. In the structure view, right-click the virtual scan and select Locate.

The virtual scan is now displayed at its new place.

Place in 3D
1. In the structure view, right-click the virtual scan, then select View > Planar View. A new tab opens

which shows the virtual scan.

2. In the structure view, right-click the scan in which the virtual scan shall be placed, then select View >
Planar View or Quick View.

3. Use theMark Plane function to mark the area where the virtual scan shall be placed.

4. In the structure view, right-click the virtual scan and select Registration > Place in 3D.

5. In the structure view, click the plane, then click Use Selection in the dialog.

6. In the structure view, click the scan, then click Use Selection in the dialog.

7. Click Associate Points. The mouse pointer changes and is displayed cross-shaped.
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8. Mark at least four suitable scan points in the virtual scan. Try to find scan points in all three
dimensions. Each scan point position is listed in the Image column in the dialog.

9. Mark the corresponding scan points in the scan. Take care to keep the same order. Each scan point
position is listed in the Scan column in the dialog.

10. In the dialog, click the Set button beneath Foot Point.

11. In the virtual scan, click a scan point that is suitable as placing point. These coordinates are now
displayed as Foot Point.

12. When you are done with selecting points, click Done to place and scale the virtual scan.

Measure
1. Select the virtual scan.

2. SelectMeasure points .

3. Measure an object.

Show positions in 3D View
Open the scan folder or cluster in 3D view.

Figure 7-10 Laced virtual scan and camera position in 3D view
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The virtual scan is now shown at its new place, not in original but plane-shaped. To find the camera
position, search the 3D view for a suitable small camera symbol. If you click the camera symbol, the
orientation of the camera is displayed.

Import Mesh Objects
The Import Mesh Objects feature allows you to import VRML files and OBJ files.

To compare the scanned reality with models from the CAD system, you can import the model into SCENE.
For this, the model must be in multi-vendor-capable VRML (Virtual Reality Modeling Language) or OBJ
data format. Many CAD systems provide the option of exporting models in these formats. For further
information, read the instructions of your CAD system.

VRML

Although the VRML standard recommends a specific coordinate system and a specific unit of length, not all
VRML files are modeled that way. The standard defines the unit of measure of the world coordinate system
to be meters, and a coordinate system in which the y-axis points upwards.

When importing a VRML model, you can have SCENE combine any meshes in the model into a single
mesh.

SCENE does not support all objects or object properties that are available in the VRML format. The
following parameters are not transferred:

l Light sources

l Textures with 8 or 16 bit per pixel (use 24 bit per pixel instead)

l The in-line node

OBJ

When imported, the OBJ model is split into one separate mesh object for each material. If some parts of the
model are not assigned to any material, they are grouped into another separate mesh object.

SCENE does not support all objects or object properties that are available in the OBJ format. The following
parameters are not transferred:

l Vertex colors

l Material illumination models: the illumination model _2: Highlight on_ is always used

l Advanced texture maps: only the diffuse texture map is used

l Texture options, such as offset and scale
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How to Import the Mesh Objects

1. Click the Import Mesh Objects button in the Import toolbar.
The file manager will open.

2. Select the file format

n OBJ (*.obj)

n VRML 2.0 (*.wrl, *.wrl.gz)

1. Browse to select the files which you want to import.

2. Click the Open button.

3. Select the units, coordinate system, and optimizations, then click OK.

Import Reference Points
Usually, external reference points are measured with survey equipment such as a total station. For spheres,
the survey point lies the center point of the sphere. For circular flat targets, the survey point lies the
middle of the light circle, which stands out clearly from the surrounding darker border. Finally, for
checkerboards, the survey point lies the center point of the four quadrants.

Survey data can be imported, for example, from a .csv file into SCENE. You can import the survey data into
a specific folder or cluster. Survey data is displayed in a References folder in the structure view.

In the selected location, a folder called References contains a separate object for each survey point with the
name and coordinates from the survey file.

External references are used for target-based registration.

Figure 7-11 External References Folder
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When registering scans within a cluster, external references are not mandatory. Nevertheless, existent
external references will be used and will have a higher weighting in the registration algorithm than scan
references.

If external references are available, the Reference folder of the cluster is used first. If not, the Reference
folder of the next available higher leveled cluster is used.

NOTE:When importing survey data, SCENE uses a right-handed coordinate system.

In some applications, scans shall be registered without referring to higher-leveled references. In this case,
create an empty Reference folder on the same level as the cluster with these scans, or create it somewhere
between the cluster and the Reference folder which would be used.

Each row of the file contains one single reference point with the following specifications: name, x
coordinate, y coordinate, z coordinate, and measurement quality. All four specifications must be given and
must be separated by the same separator, which can be a blank space, a colon, a semicolon, or a tab. The
coordinates are specified in the unit that has been defined in Settings > General.

NOTE: SCENE uses a right-handed coordinate system.

1. Click the Import Surveyed Points button in the Import toolbar.
The file system browser will open.

2. Select the file format Surveyed points (*.cor, *.csv).

3. Browse to select the files which you want to import.

4. Click the Open button.
The file will be imported.

Import WebShare Project Modifications back to
SCENE
If you have scan projects uploaded to WebShare, these scan projects might be modified by adding
measurements, annotations, etc. You can import those modifications back to SCENE. Follow the steps
below to do this:

NOTE:WebShare is being replaced by the new cloud solution Sphere XG. Contact the FARO support or
find information in the Sphere XG user manual.

Login
The legacy method is as follows: 

In the Import tab, click the button in the scan project toolbar and log in to WebShare.
Domain: Enter your organization’s subdomain on WebShare.

User Name (email): Enter the user name with which you log in to WebShare
Password:
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Enter the password with which you log in to WebShare

Save Credentials: Click to save your login credentials so that you do not have to enter them again in the
future

Cancel Import: Click to stop importing, and return to the scan project

Select project
The software will guide you through the import process with the help of following dialogs, see example
below.

Figure 7-12 WebShare import dialog – Select project
Recommended Projects: The WebShare project which is most similar to the one opened in SCENE will be
displayed.

Other Projects in this Domain: Click the little arrow to see all the scan projects saved in this domain. If
you want to import the contents of one of these projects, select it by clicking its checkbox.

Quick Import: The contents of the scan project are imported with default settings.

Click the Next Step: Apply Changes button to import the scan project.

If you want to modify those settings, clear the Quick Import checkbox. Two additional dialogs are then
shown in which you can specify the import process.

Select Object Filters
User filter

Select whether you want to import the modifications you made yourself, or if you want to import the
modifications of other users as well.
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If your WebShare role is Project Manager, you will be able to import all the modifications, even those
which were set to “private” by one of the other users.

Object type filter

Select which type of objects you want to import. Click the Select button to select all object types, or none of
them. If you select “none”, you must re-select at least one of the checkboxes below.

Category filter
Objects without a category: Select, if you want to import objects although they have no category.

Category name: Select, if you want to import all objects which are linked to this category.

Tag filter
Objects without tags: Select, if you want to import objects although they have no tags.

Tag names: Select, if you want to import all objects which are tagged with this tag name.

Select Objects
Select at least one of the objects in the list.

l Objects to be Updated -Click the objects you want to update. Click the Select button to select all
objects of one type, or none of them. If you select “none”, you must re-select at least one of the object
checkboxes in the list.

l Objects to be Created -Click the objects you want to create. Again, click the Select button to select all
object types, or none of them. If you select “none”, you must re-select at least one of the object
checkboxes in the list.

Click the Apply Changes button to start the import. Final report

The Final Report shows a list of what has been imported.

l Save Report – Click this button to receive a machine readable report. A dialog will open in which you
can browse for a saving location.

l Close report – Click this button to close the report. This will not save the imported changes. To save
the changes, use the regular SCENE saving function.

The Final Report also shows errors which may occur while importing, for example:

l The scan project in SCENE includes an object with the same name as one in the WebShare project, but
it is not the same object. Such an object will be given a default name.

l A parent object is missing. It may happen that you uploaded a scan project to WebShare, and, in the
meantime, deleted one of the scans in your scan project in SCENE. If you or someone else created
objects in that scan in WebShare, these objects cannot be imported back anymore.
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Check import in SCENE
You can now open one of the scans to see the imported objects. These objects are also listed in the structure
view.

l Modifications made in the Panorama View of a scan are listed in the folder of that scan.

l Modifications made in the Overview Map are listed in the folder of the Overview Map.
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Chapter 8: Processing

In the Processing toolbar you can work on the entire scan project, a cluster or a single scan.

If at least one of the selected scans already has a scan point cloud, the creation of scan point clouds is
enforced for all selected scans to ensure data consistency.

Start Processing

Click the Process Scans button to start processing scans (laser scanner or hand-held scans, and mixed
projects).

You can also start processing in the Explore toolbar if you right-click the scan project, cluster, or scan in
the structure view and then click Operations > Process Scan(s).

Processing a FARO Swift Scan Project
FARO Swift is a collection of features that makes it possible for a FARO Focus Laser Scanner and a FARO
ScanPlan to work together to complete scanning projects much faster than with the laser scanner alone. The
software uses a simultaneous localization and mapping (SLAM) algorithm that enables one to scan while the
scanner is in motion. This can significantly reduce the scanning time and the cost of large scanning projects.
A Swift scan project contains two types of scans: mobile scans, that are created while the scanner is in
motion, and conventional scans, that are used to provide context for the mobile scan or to provide better
resolution in areas where more detail is required. For more information about FARO Swift, refer to the
FARO Swift User Manual.

Swift scans require special preprocessing, but this is done automatically when you process the scan.

However, you can also process Swift scans manually:

1. Go to tab Processing.

2. Right-click the Swift scan sequence and select menu entry Operations > Swift > Preprocess.
The following dialog opens.
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Figure 8-1 Swift Processing Dialog

3. Select the option you want, see below.

4. Click button Start Processing.

Enable Operator Filter

This option removes objects that are too close to the scanner or that are moved along with the scanner.

Process Anchor Scans

A FARO Swift scan project begins by making an anchor scan. This is a fast, low resolution scan which
aligns the Focus and the ScanPlan and creates a known set of scan data that the mobile scan will use as its
base. You can also make subsequent anchor scans.

l Mark checkbox Colorize Scans if you want to color Swift anchor scans with PanoCam data.

l Mark checkbox Register Scans if you want to register Swift anchor scans. Note that this registration
does not start the SCENE registration but an internal cloud-to-cloud registration of the anchor scans to
ensure correct positioning.

Process Mobile Scans

Runs the standard Swift preprocessing sequence.

Processing Focus Scans Using the PanoCam
FARO Focus Laser Scanners can be used in combination with a Ricoh Theta Z1 360° camera to reduce the
time needed to take the pictures that colorize the points of a scan. Such projects receive special
preprocessing which is done automatically when you process the scan.

To improve the scan visualization, you can use functionality Create PanoCam Scan on the Explore tab.
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Requirements
l The scans must be taken with a Focus scanner that is outfitted with a Ricoh Theta Z1 camera and a
mounting adapter. Contact your FARO sales representative to purchase the equipment necessary to
colorize scans with your Ricoh Theta Z1 camera. Refer to the FARO Focus Laser Scanner Accessories
Manual, available at knowledge.faro.com for information about how to make Focus Scan using the
PanoCam.

l DirectX drivers must be installed and active to process these scan projects. An error message will appear
if you select Colorize Scans for a project without active DirectX drivers.

l Each computer and user needs one calibration scan made with the same Ricoh Theta Z1 camera that was
used when the scan data was captured.

About Calibration Scans
A calibration scan is a scan that is used by SCENE to align the colors of the Ricoh Theta Z1 picture with
the points of the Focus scan. It is saved as a normal fls folder on the scanner SD card and can be used in
SCENE like other scans. To successfully colorize a Focus Scan whose color was captured with the
PanoCam, you must have at least one calibration scan made with the same Ricoh Theta Z1 camera that was
used for the scan project you are processing. The computed calibrations are shared across all projects for
one user.

If the colorization quality deteriorates, or if you see the error message, Calibration failed. Failed to match
scan data to color data, it may help to capture a new PanoCam calibration scan.

Limitations
If you want to export panoramic pictures via the context menu entry Export Panoramic Images, you must
create the PanoCam scans first. You can then use the PanoCam scans to export the panoramic pictures.

Processing Flash Scans
When importing and processing Flash scans, SCENE automatically creates PanoCam scans. Metadata is
included in these PanoCam scans. The registration is done based on the PanoCam scans.

Process Scans

Use the Process Scans button to start processing scans (laser scanner or hand-held scans, and mixed
projects).
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NOTE: There is a second possibility to start Processing during executing Explore features: in the structure
view, right-click the scan project, cluster, or scan, then click Process Scan.

Configure Processing – General

Skip Fully Processed Scans
This option is selected by default if one or more scans have already been fully processed. Deselect if you
want to reprocess these scans.

Configure Processing – Scan Point Clouds

Create Scan Point Clouds
If you mark this option, scan point clouds will be generated. These scan point clouds ensure data
consistency.

This option is grayed out if there are already scan point clouds.

Configure Processing – Colorization

No colorization
If you mark this checkbox, no color will be added to the scan points during processing.

Colorize Scans
If you have a scan taken by a laser scanner with the color option, this scan will also contain the digital
pictures which the scanner took automatically during the scanning. These pictures will be applied to color
the scan if this option is selected.

NOTE:  Starting from version 2022.1, SCENE supports coloring Focus Premium scans with high-resolution
images (13MP) made by the scanner’s internal camera.

Laser Illuminated HDR
With LI-HDR, a photograph of a scanned area is combined with information about the amount of laser light
that was reflected by surfaces during scanning. Because the laser provides the illumination, details in areas
that are completely over- or underexposed in the photograph can nevertheless be added to the LI-HDR
image, as shown in this example:
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Figure 8-2 Laser Illuminated HDR

The laser light does not provide color information, so areas illuminated only by the laser are shown as
grayscale.

NOTE: If you always want to use LI-HDR when processing scans, you can set this in Settings, Processing,
Colorization.

Configure Processing – Filters
To identify an inaccurate scan point, the filters compare the scan point with the scan points in the
surrounding area. Some of the filtering is performed based on information from the point.

Figure 8-3 The area surrounding a scan point, in a 2D grid

In the figure above the surrounding area oriented toward the recording point is shown. With filters, you can
set what should be regarded as the surrounding area. In this example, the value 5 was set, which means the
edge length of the surrounding square is 5.
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Dark Scan Point Filter
This filter removes points based on a reflectance value. Reflectance Threshold indicates the minimum
reflectance value a scan point must have. The Reflectance Threshold range is: 0 to 2048.

This criterion is useful because with a dark scan point, only a very small amount of light entered the scanner
and therefore the measurement will have an increase in noise.

NOTE: This filter is not applicable for colorized scan points.

Distance Filter
This filter removes all scan points which are outside of the defined distance range. All points with a distance
less than theMinimum Distance and all points with a distance larger than theMaximum Distance will be
deleted.

Stray Point Filter
This filter checks if the 2D grid cell of a scan point contains a sufficient percentage of points with a distance
similar to the scan point itself.

l Grid Size: The size of the surrounding area used for comparison. For each scan point of the scan or
selection, the filter takes the valid scan points of this surrounding area and counts how many of them are
at a distance to the scanner which is approximately the same as the distance of the scan point currently
being viewed.

l Distance Threshold: A scan point is counted if the difference in distance is smaller than the value of
Distance Threshold.

l Allocation Threshold: If at least the percentage of scan points indicated by the Allocation Threshold in
the surrounding area is within this distance threshold, the scan point remains in the scan. Otherwise, it is
removed.

NOTE: The Stray Point Filter is very well suited to correct incorrect scan data. It also works well if the
Allocation Threshold is below 50%. However, the filter must not be applied on surfaces that were
strongly inclined versus the scanner’s laser. The filter is always applied to the whole scan. It is not
possible to apply it only in selected areas.

Edge Artifact Filter
This filter is enabled by default. The filter is especially useful to remove artifacts at the edges of objects.
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Configure Processing – Find Targets
The Find Targets section allows you to select targets such as checkerboards, planes, and spheres. These
will then be searched in each scan during processing.

NOTE: Finding targets is time-consuming and should be enabled only when scans are registered with the
target-based registration.

Find Checkerboards
A frequently used paper target is the checkerboard target. A checkerboard target fit determines the center
point of the target’s four quadrants. Select this option to find checkerboards and use them for scan
registration. note that the angle between the laser beam and the checkerboard should be higher than 45
degrees. Otherwise, the accuracy of checkerboard may be compromised.

Find Markers
Select this option to find markers. Markers are printed targets with a unique ID.

Find Planes
Select this option to find planes and use them for scan registration.
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Find Spheres
This refers to three-dimensional, white, reference spheres that come in various sizes. The advantage of
spheres is that they can be placed at any angle to the scanner. Select this option to find spheres and use them
for scan registration.

NOTE: Sphere search works with spheres meant for registration. Forensic spheres (used for determining
shot trajectories) may not be found by this target search.

The global list of sphere sizes set in the Settings > Processing page are displayed in the active and inactive
sphere radii list.

Active Sphere Radii
Click Add New and specify new sphere radii. These sphere sizes will be used for target detection.

This list of user-defined sphere sizes will be used for processing the scans in the current processing task run.

Inactive Sphere Radii
Click Add New and specify additional sphere radii for sphere detection.

Drag the sphere radii that are not required for the current project, from the Active Sphere Radii to the
inactive Sphere Radii list.

You can easily move items between the two lists and manage the sphere radii for processing the scans in the
current project.

Configure Processing – Hand-Held Scans
This section is only visible when you process hand-held scans.

Load Presets
Two presets are available: Fast or Accurate.
Fast is the default setting and will produce satisfactory results from good scans. If you experienced tracking
errors when scanning, or see doubled images in the scan before processing, you may find that setting
Accurate produces better results.

Plane Detection
Switches plane detection on or off for all processing. Auto switches on plane detection only if it was
switched on when the scan was created.
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Replay
If scans already passed some processing steps, Replay restarts the processing from the beginning. Processing
is then executed with higher precision than it was done during capturing.

Scan Optimization
Adjusts all frames of a scan to minimize the overall displacements errors. The function searches for loops in
the scan and tries to close those loops. Loop closing is necessary because small errors from frame to frame
may accumulate over time, resulting in gaps if you return to the same position again. The Extended setting
may give better results, but will take longer.

Stray Point Filtering
Removes stray points, creating a cleaner overall look. Select Standard to remove stray points without
additional 3D smoothing. This setting tends to make edges and corners look better. Select Smooth to add
additional 3D smoothing. This setting tends to make planes look better.

Color Optimization
Averages the color of scan points in overlapping areas within the selected scan, and adjusts color effects
caused by different lighting situations.

Delete Raw Data
Deletes the raw scan data and the project history after processing is complete. Select this option only if you
are sure that you never want to process the scan again.

Configure Processing – Automatic Registration

Perform Automatic Registration
Select this option to enable automatic registration after the processing. If the automatic registration is
enabled, more registration settings will appear. These settings vary depending on the selected Registration
Method.

General
The scanner’s sensor data that will be used during registration:
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l The inclinometer data will be used for all registration methods.

l The compass data will be used for top-view-based and target-based registration.

NOTE: Sensor data can only be used if the sensors were enabled during scanning.

Use Inclinometer
Normally, inclinometer data is available and used by default to level the scans during registration.

Leveling ensures that the z-axis of the registered scan corresponds to the z-axis defined by the inclinometer.
By this technique one reference can be replaced during registration. When registering with inclinometer
data, this will be used as fully-trusted information and all other registration objects will be used with lower
priority.

Use Compass
If the scans were recorded with a FARO Focus Laser Scanner equipped with a built-in compass, orientation
information is available for the single scans. Enable this option to use this information as auxiliary
information for the correspondence search. If the correspondence search cannot find any correspondences
that are consistent with the compass data, this may be an indicator that the compass was influenced by
environmental interference and the compass data will be ignored. If you disable this option, no compass data
will be used for correspondence search.

Expert Settings
Move cluster to the center of its scans

When you create a new cluster in the correspondence view, it is shown at the center of the scans displayed
on the screen. However, if you add some of the displayed scans to the cluster, it may happen that the cluster
is not shown at the center of these scans. If this option is activated, the cluster is automatically moved to the
center of its scans. If it is deactivated, a message is shown in which you can confirm that the cluster should
be moved to the center of its scans.

Note that this does not change the global position of the clusters or scans but only the representation on the
screen.

Auto Clustering

SCENE may not be able to find a spatial relationship between all scans in your scan project and only groups
of scans can be registered to each other. The registration internally recognizes which scans can be registered
correctly and which can not. All groups of correctly registered scans are automatically arranged in
appropriate sub-clusters (named Cluster1, Cluster2 etc.).
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Target-based

Find correspondences for scan positions
Mark this checkbox if the position of a scan is known, for example, by a surveyed reference point or by a
reference sphere representing the position of the scanner in other scans.

Force correspondences by target names
Mark this checkbox, if you want to force correspondences by target names. The targets in each scan must be
named according to their counterparts in the other scans. This feature requires that targets are already
detected by SCENE. In Settings > Process, select a target search, then run Process. After that, open the
cluster or the scans in Explore. You can then click the target’s names the in structure view and rename
them.

Use Checkerboard Normals
If this setting is active, the normals of checkerboards are used for the correspondence search. Uncheck if the
direction of checkerboards has changed from one scan to another. For example, if you use checkerboard
targets that can be tilted and turned for a precise orientation to the scanner.

Target Distribution Threshold
Sets the limit for registration. If targets are too near to one another, registration will be refused. In this case,
lowering the limits gives you a result.

Top-view-based

Subsampling
The result of the registration can be adjusted through the subsampling rate. The value defines the size of the
grid in which scan point homogenization is performed. The resulting grid of points will be used to perform
the registration. When you move the slider, the set value will be shown. Five centimeters (0.05m) usually
work for all environments. If you are indoors, in an industrial environment, you can reduce the subsampling
to 0.35m or even 0.25m.

Reliability
The reliability value determines the amount of additional checks on a registration. It filters out results that
could be contested. Higher values allow for more certainty, but could affect the needed time by algorithm to

SCENE User Manual
Chapter 8: Processing

SCENE User Manual (2024.0) Page 109 of 372



provide a solution. Set the slider to the value which you expect to bring the result you want. As soon as you
move the button, the set value will be shown.

Cloud-to-Cloud

Subsampling
The result of the registration can be adjusted through the subsampling rate. The value defines the size of the
grid in which scan point homogenization is performed.

Set the slider to the value which should bring the result you want. As soon as you move the handle, the set
value will be shown.

Calculate Target-based Statistics
If this setting is active and the scan contains targets, the target-based statistics are calculated in addition to
the scan point statistics. In other words, the registration will also return the target errors. You can use the
result as a double-check of the registration result. Note however, that only the scan points are used for the
registration.

Maximum number of iterations
You can define the maximum number of iterations for the algorithm to find the best solution. By default,
this parameter is set to 30 iterations.

Maximum search distance
The maximum distance in which the registration searches for corresponding points. The maximum search
distance must be larger than the initial misplacement. By default, the distance is set to 10 meters.

Top View and Cloud-to-Cloud
Shows settings for both, top-view-based and cloud-to-cloud registration, see above.

Start Processing and Check Processing Results
1. Start Processing by clicking the Process Scans button.

2. Select a scan, a cluster, or the entire project. Then, click the Configure Processing button.
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3. The Configure Processing dialog provides the same settings as the Processing Settings, and also some
options for automatic registration. However, here, the settings are only valid for this task.

Results
When processing is finished, a dialog is shown in which shows the results.

The dialog is color coded:

l green: all scans were successfully processed. Clicking the result line will show the list of scans.

l yellow: some scans were successfully processed, but there are scans which need special treatment. This
dialog would consist of two parts: a list of scans which were processed successfully, and a list with
scans which could not be processed. Clicking the result lines will show the list of scans.

l red: no scan could be processed.

Moving Objects Filter
The moving objects filter (valid only for laser scanner scans) provides a method for removing scan points
created from objects that are present in one scan, but which are not present in the same area in another scan.
An example of this is a car which was parked in one scan, but drove away before the next scan was made,
or a person who walks through the area during scanning. The moving objects filter compares areas that were
recorded in two or more scans, finds objects that are present in one scan, but not in others, then removes the
points created by that object.

NOTE: The results of the filter are only visible in the 3D view. The planar and quick views are not changed
because the filter only removes scan points. Because the filter does not modify color values, it will
not correct the color values of scan points that were incorrectly colorized due to moving objects.

l Before you begin, ensure that the scans in the cluster you want to process are registered.

l Scans of areas containing mirrors, highly reflective objects, or windows, may contain stray scan points
that are incorrect. You should delete those scan points before running the filter otherwise valid points of
other scans might be filtered accidentally.

l To see the results, first locate the moving objects in the 3D view and create a viewpoint. After running
the filter, return to the viewpoint and verify that the scan points that you expected were removed.

Apply the moving objects filter
Use the procedure below to apply the moving objects filter.
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1. Save the project so that if the results of the moving objects filter are not what you expect, you can
revert to the last saved version and try with different settings.

2. Select the Processing tab.

3. Select a cluster of registered scans. If the scans in the cluster you want to process are not registered,
click Cancel, register the cluster and return to the moving objects filter. (If you are working with a
FARO Swift scan, note that stationary scans use the moving objects filter, but mobile scans cannot.)

4. Click Configure Filter. Adjust the sensitivity, overlap threshold and maximum scan comparisons as
needed. We suggest that you use the defaults first, and adjust if the results are not what you expect.

5. Click Start Filter to begin running the filter. Depending on your processing speed and the number of
scans in the cluster, this can take a long time.

6. When the filter completes, check the 3D view to ensure that the scan points created by moving objects
were removed. If the results are not what you expected, revert to the last saved version of the project
and try again with different settings.

Hand-held Scan Repair
Unlike stationary scanners, which record objects only once per scan, hand-held scanners record pictures of
the objects they are scanning multiple times each second. Each of these pictures is called a frame. The
scanner keeps track of where it is in space by comparing one frame to another, and builds a single, coherent
scan out of all the frames. This process is called tracking.

It’s normal for very small measurement errors to occur during tracking. In most cases, these errors are
normalized by processing software, and are not visible in the final scan. But if a scan is long, and especially
if it records the same objects at the beginning and end of the scan, it can happen that the cumulative tracking
errors prevent the processing software from correctly merging objects that were recorded at different times
in the scan. This can result in a scan where some objects are duplicated, or appear thicker than they actually
are. See figure below for an example.
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Figure 8-4 Duplicate object

The hand-held Scan Repair tool provides an option for an automatic scan repair as well as another option for
a manual scan repair.

Automatic Scan Repair
1. In the Processing tab, open the scan that you want to repair in a 3D view.

2. Click the Handheld Scan Repair icon.

3. Click button Automatic Scan Repair.

SCENE now starts the repair process. When the repair process is finished, the repaired scan ins shown in a
3D view.

4. When it is finished, check whether the result is satisfactory.

If you are not satisfied with the result, you can repeat the automatic scan repair or start a manual scan repair,
see below.

Manual Scan Repair
1. In the Processing tab, open the scan that you want to repair in a 3D view.

2. Click the Handheld Scan Repair icon.
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3. Arrange the scan so that you can see the area that you want to repair.

4. Click the Selection button.
The selection tools appear.

5. Use the selection tools to select the area that you want to repair.
Note that the repair tool requires planes to function correctly. Ensure that the area you select contains
one or more planes.

If there are no planes in the selected area, you can also run the repair with irregular planes. For this purpose,
select Scan Repair > Cloud2Cloud > Run and Add after you have created the repair area in step 6.

Figure 8-5 Surface selected

6. Select Scan Repair > Create Repair Area
If the area you selected was recorded at two different times during the scan, you will see some scan
points turn green and other scan points turn red. The two colors show the two sets of consecutive
frames in which the objects were recorded. (If the area was recorded more than twice, additional colors
will be visible, one for each set of consecutive frames.)
Where the red and green points overlap, you will see them mix. This shows how the repair tool will
merge the objects.

Figure 8-6 Repair area created Figure 8-7 Scan repair preview

7. Select Scan Repair > Apply to make the changes permanent.
See figures below to compare the original and the repaired scan.

Figure 8-8 After repair Figure 8-9 Before repair
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Chapter 9: Registration

Scan points are recorded and saved in a coordinate system which is relative to the scanner. The point of
origin for this scan coordinate system is the position where the laser meets the mirror. The coordinates of
this point are x = 0, y = 0, z = 0. If you have two or more scans taken at different locations in a room, each
scan will only know its own scan coordinate systems right after scanning.

In reality however, the origins of these scan coordinate systems are at different positions in the room.
Therefore, it is necessary to determine the spatial relationship between them. This is called registration, and
the step from the scan coordinate system into the overall coordinate system is called transformation.

The scans of your scan project might have a rough initial placement derived from the sensors of the laser
scanner (GPS, Altimeter, Inclinometer or Compass), but, in general, it is still necessary to perform a
registration to get a more precise spatial relationship between the scans.

Registration Dashboard
The Registration Dashboard will guide you through the registration process. It informs you of the status, and
it helps you to perform the necessary steps to get the desired results.

The Registration Dashboard shows a hierarchical view of the registration relevant objects: clusters and
scans.

For clusters, it includes their current registration status and it allows registration relevant actions on the
cluster.

Figure 9-1 Registration Dashboard
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① Automatic registration: select the cluster and an automatic registration will be executed afterwards.

② Manual registration: select the cluster and a manual registration will be executed after you have marked
some scan points which the scans in this cluster have in common.

③ Visual registration: select the cluster and then drag scans and clusters to the right position by view. It is
recommended to use the interactive registration instead.

④ Interactive Registration: opens the Interactive Registration page (available since version 2023.1). Note
that this type of registration does not follow the workflow outlined on this page.

⑤ Recommendation button: click to execute the recommended type of action.

⑥ Cluster registration options: select automatic, manual or visual registration of the cluster.

⑦ Registration Report: shows the Registration Report.

⑧ More button: provides additional cluster handling functions.

To view a specific scan or cluster, collapse or expand a cluster by clicking on it.

If you click the preview image, it will be shown enlarged.

Registration Status

Colors
For each cluster, the current registration status is shown with a colored line in front of the cluster’s name.
The registration status describes how well the subordinate clusters or scans are registered against each other.

The following colors are possible:

l Green: A registration was performed and successful and you verified the result.

l Yellow
n A registration was performed and successful, but you did not verify it yet.

n A registration was successfully performed and verified by the user, but an optimization is
recommended through the used registration method.

l Red
n This cluster is not registered at all.

n A registration was performed but failed.
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Hints
The Registration Dashboard shows a hint, if available, for a cluster. The hint can help you with what is the
best to do next with that cluster. The following hints are possible:

l Perform Manual Registration on page 126: Perform a Manual Registration on this cluster.

l Perform Automatic Registration on page 123 Perform an Automatic Registration on this cluster.

l Optimize Registration: Optimize the registration result by performing a cloud-to-cloud registration or
target-based registration if targets exist.

l Verify registration: A registration on a cluster was performed, but you have not verified the result yet.

Registration Dashboard – Filter functions
The elements shown in the Registration Dashboard can be filtered by name.

Filter by name
Use the text field to filter by names. As soon as you start typing a search string, the filter is automatically
applied. Clear the search field by clicking the Clear Entry button.

Clusters
A cluster usually collects scans which somehow belong together, for example scans which were recorded on
the same floor of a building, or scans which were taken in the same room. Scan groups, created during the
scanning process, are also automatically put into clusters when they are imported into SCENE.

Clusters are marked with an icon.

The Registration Dashboard allows modifying clusters in a fast and comfortable way. You can either use the
buttons on the right side or click the links provided by the Registration Dashboard.
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Figure 9-2 Finished cluster

You can define standard settings for clusters in the General Registration Settings.

Add Cluster
1. In the Registration Dashboard, open the Cluster Management dropdown list, then click Add Cluster.

A new cluster will be inserted below the one in which you clicked the button.

2. If required, name the new cluster, and click the button.

Drag and Drop Cluster
If you want the cluster at another place, drag and drop it to its new place. SCENE checks if it is allowed to
drop the cluster at the new place.

Disband Cluster
In the Registration Dashboard, open the Cluster Management dropdown list, then click Disband Cluster.
The cluster and its scans will be added to the superordinate cluster. Note that clusters which are scan groups
cannot be disbanded.

Delete Cluster
1. In the Registration Dashboard, open the Cluster Management dropdown list, then click Delete

Cluster.
A warning message will be shown.

2. Click the OK button to delete the cluster and its content.

Manually Finish Cluster
Sometimes clusters are already registered correctly, but SCENE keeps suggesting additional steps because it
assumes the cluster is not yet finished. This can happen, for example, when a project was registered with an
older version of SCENE, or if you decline to optimize the registration.

In such cases theManually Finished feature can be used to force a clusters status to finished (green).

In the Registration Dashboard, open the Cluster Management dropdown list, then clickManually
Finished.

If this feature is enabled for a cluster, the cluster is displayed as finished (green) and contains a hint that
explains the status (to not confuse it with the finished status computed by SCENE). When you click the hint,
a popup is displayed.

To undo theManually Finished status you can:
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l Click Remove Manually Finished at the bottom of the popup.

l Open the Cluster Management and clickManually Finished again.

n NOTE: The activation works recursively. That means if you enableManually Finished for a cluster,
all subordinate clusters will be also marked. The same applies for removing theManually
Finished status. All subordinated clusters will get their “real” registration status back.

TheManually Finished feature locks the cluster and all its subordinate clusters. The flag
tells SCENE that the cluster should always be displayed as finished. Any registration task
can be started as usual on the cluster, but you will not be able to see the resulting
registration status until you remove the Manually Finished flag.

Lock and Unlock Clusters for Registration
You can lock and unlock clusters with the Scan Manager of the corresponding cluster.

Lock a Cluster
1. Right-click the cluster Scan Manager.

2. Select Lock all from the context menu.
The cluster and all its child clusters will be locked.

Unlock a Cluster
1. Right-click the cluster Scan Manager.

2. Select Unlock from the context menu.
The cluster and all its parent clusters will be unlocked

Locked cluster Behavior
The relative position of scans within a locked cluster won’t change. However, the entire cluster will be
moved to be registered against external scans or clusters.

A locked cluster is not flexible, i.e., you can translate and rotate the entire cluster, but you cannot change its
shape or internal geometry.

You should lock clusters after you have finished the registration. Otherwise, SCENE will consider the
registration as not verified. If this happens, you can, of course, simply run the verification procedure. When
this procedure is finished successfully, all clusters will be locked.
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Unlocked Cluster Behavior
The relative positions of scans within an unlocked cluster as well as the cluster position will be modified to
be registered against external scans or clusters.

An unlocked cluster is flexible, i.e., you can translate and rotate the entire cluster, and you can also change
its shape and internal geometry.

Targets
Targets are physical objects in the area to be scanned that SCENE can detect and use to register the scans. A
target can be a naturally occurring plane such as a wall or desk, or you can use extra objects made
specifically to function as targets. These artificial targets are spheres, checkerboards, and markers.

There are several things to consider when deciding which type of targets to use.

l Since planes probably exist in the environment you are scanning, you don’t have to do anything extra to
use them. But you can’t be sure that your environment will have enough planes, and you can’t document
the location of the target by other means, i.e., via GPS coordinates.

l Spheres are highly accurate at any angle to the scanner and are often used in conjunction with GPS
coordinates, but they are more expensive than printed targets, and can be bulky to transport.

l Both checkerboards and markers can be printed with your laser printer. They are easy to transport and
replace, but they do not work if they are placed at an oblique angle to the scanner.

l Checkerboards, when scanned at right angles, can be detected at greater distances than other types of
targets.

l Markers and planes can be automatically detected in scans made by both the FARO Focus Laser
Scanners and FARO Hand-held Scanners, so you can use one set of targets for both types of scanner.

Spheres
Three-dimensional, white surveying spheres can be used as targets. A sphere is determined by its position
and its radius, and its central point is used for the registration. Hence, you can add global position
information to the sphere’s property.

NOTE: Sphere search works best with surveying spheres that are meant for registration. Forensic spheres
(used for determining shot trajectories) may not be found by this target search.
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Spheres with Preset Radius
This type of sphere is particularly well-suited to fitting survey spheres, because their radius is known in
advance. Use one of the following options to create spheres with a preset radius:

l During the Manual Registration, select theMark Sphere button .

l Right-click a scan or a scan point selection, then click Find Objects. In the menu, select Spheres.

You can predefine one or more sphere radii under Settings > Processing.

Figure 9-3 Fitted survey sphere

Checkerboards
A frequently used type of paper target is the checkerboard target. A checkerboard target fit determines the
center point of the target’s four quadrants. This point is used for scan registration.

Figure 9-4 Checkerboard target and fitted checkerboard point
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Creating checkerboard points

1. During the Manual Registration, select theMark Checker Board button .

2. Right-click a scan or a scan point selection, then click Find Objects.

3. In the menu, select Checkerboards.

Markers
Markers are printed and used like checkerboards, but unlike checkerboards, markers are unique. This means
that correspondences between scans are only possible for markers with the same ID. After installing
SCENE, a PDF file containing 200, A4-size pages each with one marker and one unique ID can be found at:

<Installation Path>\
RegistrationMarkers\RegistrationMarkersA4.pdf

You can print the markers at a reduced size to cover up less of the area that you are scanning but this will
change the maximum distance at which the markers can be detected. The table below shows the distances at
which markers can be detected depending on scan resolution and marker size. Note that the markers must be
placed orthogonally (at right angles) to the scanning direction to reach these limits. The values shown in the
table can be increased by 20% when fully processing scans that have color images.

Scan Resolution Marker size 100%
15.5cm (6 in)

Marker size 75% 11.7cm
(4.5 in)

Marker size 50%
8 cm (3 in)

1/16 4 m (13 ft, 1 in) 3 m (9 ft, 10 in) 2 m (6 ft, 7 in)

1/8 7 m (22 ft, 12 in) 5 m (16 ft, 5 in) 4 m (13 ft, 1 in)

1/4 13 m (42 ft, 8 in) 9 m (29 ft, 6 in) 7 m (22 ft, 12 in)

1/2 23 m (75 ft, 6 in) 17 m (55 ft, 9 in) 13 m (42 ft, 8 in)

NOTE: To print the markers at 100% on US letter size paper, select Actual Size, instead of Fit or Shrink.
The A4 pages will be trimmed slightly but the markers and IDs are not affected.

Marker IDs must be unique within a project. Ensure that you do not include two markers with the same ID
in the scan area.

Circular flat target
The circular flat target (referred to as “a Circular Flat Point” in the SCENE interface) is one type of target
which may be used for scan registration. The circular flat target usually consists of a white circle on a dark
background. The mean point of the circle is used for the scan registration.
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Figure 9-5 Circular flat target

To determine this mean point, select the target in the scan and use the object marker tool or the command
Create Objects > Contrast Mean Point in the context menu of the selection. The selection should contain
the complete circle and the selection should be made on the dark background. The shape of the selection is
not important; only that it contains the complete circle.

NOTE: In general, it is recommended to use checkerboard targets instead of circular flat targets. The
recognition of checkerboard targets is usually more precise and SCENE is able to automatically
identify those targets in the scans. This makes reference creation and registration less time-
consuming.

Automatic Registration
The Automatic Registration looks for similar geometric constellations in the scans. The result can then be
viewed and evaluated in the correspondence view.

Automatic Registration uses inclinometer data, if activated in Settings > Registration.

Check the Registration Settings for the type of Registration to be executed. You can select among 4 options:
target-based, top-view-based, cloud-to-cloud, Top View first and cloud-to-cloud registration afterwards.

If you want to run an automatic cloud-to-cloud registration, you should pre-align the scans. You can do this
as follows:

l automatically with a top-view-based registration

l manually with a manual registration

l manually in the correspondence view

You can start the automatic registration as follows:

l Click the Automatic Registration button in the toolbar. You will then be asked to select a cluster.

l Open the Registration dropdown list in a cluster line, then click Automatic Registration. Select the
settings to start registration.
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l Click the recommendation to perform an Automatic Registration in a cluster line. Select the settings to
start registration.

Automatic Registration from the Toolbar

1. Click the Automatic Registration button in the toolbar.

2. Select a cluster, then click the Select Method button on the upper right side.
The Select Method page is shown. Available registration methods are: top-view-based, cloud-to-cloud,
target-based, and a combination of top-view-based and cloud-to-cloud registration.

On the right side, the available settings for this registration method are shown. These settings correspond
with those in the Registration Settings page. If necessary, modify the settings. Your modifications will now
be valid for the current registration. It will not change the settings made in the Registration Settings.

3. Click the Register and Verify button on the upper right side.
The registration is executed. Depending on the number of scans in this cluster, this may take some
time.

4. Verify the registration.

Automatic Registration from the Cluster Line
1. Open the Registration dropdown list in the cluster line, then select Start Automatic Registration.

2. Proceed as described in the section above.

Register and Verify

Figure 9-6 Registration task, verification: 3D view

A 3D view is displayed with which you can check if the registration was successful.
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Use the following options to check:

l Camera Mode buttons and View buttons in the task panel to change the observer's view

l View All button to get a view on all the objects

l Coordinate Coloring button in the task panel to switch between scan colorization modes

Registration was successful
In the verification step, you are asked if the registration was successful.

l Yes: the cluster is marked as registered and you are returned to the dashboard.

l No: marks the registration of the cluster as failed and continues to the dashboard which will suggest a
manual registration for the cluster. You can also visually verify the registration result in the
correspondence view, improve the scan alignment there and then retry running an automatic registration.

Registration failed but Auto Clusters are found
If the automatic registration failed but could create one or more Auto Clusters with some partial results, the
verification step for partial results will be displayed.

1. Decide which of the Auto Clusters you want to keep.
When the task step opens, a 3D view showing all generated Auto Clusters is opened first.

2. Select a view to check the Auto Cluster. For this, use the 3D view or Registration Report button for
each of the generated Auto Clusters.
Additionally, there are also some tools shown in the task step that are useful for this verification step.

Every Auto Cluster that is not selected will be disbanded and its scans will be moved back to the parent
cluster. The selected auto clusters will become normal clusters and are marked as registered.

The Finished button is colored green and clickable when this step is shown. Clicking this button finishes the
task and returns you to the dashboard. The selected clusters from the verify step are shown yellow with the
hint that the registration should be optimized.

Optimize Registration
Optimize Registration executes a cloud-to-cloud registration or target-based registration if targets exit with
the settings you have made in the Registration Settings on page 52.

NOTE: If there is an Optimize Registration step at all depends on the settings you have made in the
Registration Settings on page 52. Optimize Registration is only available if you select Top View
based registration for the Automatic Registration or Manual Registration.
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The result is Not Satisfactory?
Select the No checkbox and click the Other Pair button. You are returned to the Select Scans step, and you
are asked to select the next scan pair.

Manual Registration
NOTE: The manual registration and the visual registration are troubleshooting options that you can use

when the automatic registration does not work.

TheManual Registration can be executed for a cluster.

It offers the possibility to identify corresponding scan points of two scans by picking such scan points. As
soon as there are sufficient corresponding scan points, SCENE will register the two scans. The result can
then be viewed and evaluated in the correspondence view.

Manual Registration uses inclinometer data, if set in the Registration Settings on page 52.

There are three ways to start a manual registration:

l Click theManual Registration button in the toolbar.

l Open the Registration dropdown list in the Cluster Management, then clickManual Registration.

Figure 9-7 Select Registration option in the Cluster Management

l Click the recommendation to perform a Manual Registration in a cluster line.

Figure 9-8 Recommendation to perform a Manual or Visual Registration
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Manual Registration from the Toolbar

1. Click theManual Registration button in the toolbar.

2. Select a cluster.

Manual Registration from the Cluster Line
Open the Registration dropdown list in the cluster’s line, then selectManual Registration.

Select Scans
When a cluster is selected, Select Scans is shown. In this step, scans or clusters that must be registered with
each other, can be selected.

1. Click Select Scans on the upper right of the header line.
Now, the display is divided into two columns, and each column shows previews of the scans in the
selected cluster.

l You can filter the lists by name. Enter the string in the Find name... field above each column.

l It is also possible to sort the scans by Recording Time and Name. Click the text to open the selection,
then select the type of sorting. Click the small field with the triangle to sort upwards or downwards.

l For the right column, it is possible to sort by the Best Match. Best Match means that scans with a similar
recording date as the selected scan on the left side are shown first. For every sort method except for the
Best Match, it is possible to reverse the sort order by clicking on the triangle next to the dropdown.

Figure 9-9 Manual Registration task, first step: select scans

SCENE User Manual
Chapter 9: Registration

SCENE User Manual (2024.0) Page 127 of 372



2. Select a scan by clicking its preview. The header of the scan preview is marked blue. The preview of
this scan in the other column will be grayed and is no longer accessible.

n If by accident the wrong scan was clicked, simply click another one.

n If a cluster contains a subordinate cluster, the scans in these clusters are displayed as a single group
of scans. To register such a subordinate cluster, pick one representative scan. Selected subordinate
clusters are also framed in color, they can be expanded or collapsed.

3. Change to the other column and select a second scan by clicking its preview. Again, the scan preview
is marked with a blue triangle in its upper left corner. The preview of the same scan in the other
column will be grayed and is no longer accessible.

Mark Targets
1. Click theMark Targets button on the upper right side of the header. Now, the display changes to the

Split View.

n In the column on the left side, SCENE will show buttons, notes, and advice which guide you
through the registration.

n The two windows show each the two selected scans in a quick view.

NOTE: Some types of scans will be shown in a 3D view, for example hand-held scans.

Rotate, move, zoom the two scans until you have them in a useful position, i.e., they show the same
part of the scenery.

2. Check for natural targets like points or planes, or artificial targets like spheres, markers or
checkerboards which could be useful and which are not marked yet. Usually planes work better than
points.

n Select theMark Point button to mark a point.

n Select theMark Plane button to mark a plane.

n Select theMark Sphere button to mark a sphere target.

n Select theMark Checkerboard button to mark a checkerboard target.

n Select the Mark Marker button to mark a marker

NOTE:When marking a point in SCENE it’s possible for you to click a position where no point actually
exists. SCENE always selects a group of points around the place you clicked, calculates the median
point, and marks that point. (This can have unexpected consequences if the points in the group
appear close in your view, but are actually far apart in the 3D view. Because of this, we suggest
that, whenever possible, you mark planes instead of points.)
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Plane Normals
A plane is identified by the fact that it is level, i.e., there is precisely one direction that the plane stands
perpendicular to (actually, there are two such directions; however, they are exactly opposite to one another).
This direction is called the Normal of the plane.

Some types of scans will be shown in a 3D view, for example Freestyle3D scans.

In this case, an additional Invert Plane Normal button is displayed on the image, This button can be
selected to invert the Normal. This avoids that the scan is placed with a flipped orientation. Mark the targets
by hopping and clicking between the windows.

Correspondence Tools
There are three tools that can help you locate and work with correspondences: Find Correspondences, Clear
Correspondences and Force Correspondence

Find Correspondence
When you click this icon, SCENE will attempt to automatically locate correspondences in the scans. If
SCENE detects that there are correspondences among the newly marked objects, or one of the newly
marked target corresponds to an earlier marked target, it will mark them with a label.

NOTE: A label shows a name with a maximum of 9 characters. If the name has more characters, only the
last 8 will be displayed and an asterisk (*) will replace the missing characters. As soon as you click
a label, the name is shown completely.

Figure 9-10 Split View with detected correspondences
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The label then has a small green field with a “C” which indicates that those correspondences were found
automatically.

The frame around the label symbolizes the quality of the correspondence:

l Green: good quality

l Yellow: compromised quality

l Red: seriously compromised quality

Continue with marking correspondences until the button on the upper right side changes fromMark
Targets to Register and Verify, and gets a green color. This means that there is a sufficient number of
correspondences to perform the registration.

Clear Correspondence
If you want to start over, you can click the clear correspondences button to remove all correspondences.

Force Correspondence
You can force a correspondence between two points. Click the Force Correspondence button; the cursor
changes to show cross-hairs: . Click the two points where you want to force the correspondence. Use it
only if you are very sure that your targets are placed correctly. For this purpose, you can also select unique
locations in the scan, for example, a unique wall in the scan or a corner of a door or window.

Delete specific targets or correspondences
It may happen that, at the end, your scans show marked targets which were not needed for a
correspondence, or you want to delete a correspondence because it is wrong.

Right-click the correspondence, then click Delete ‘name’.

If two or more correspondences are very close to one another, a list will be shown. Select one of the
correspondences by clicking on it, then click Delete ‘name’.

Register and Verify
1. Click the Register and Verify button on the upper right side.

The registration is executed.

2. Verify the registration.

3. Click either the Finish button, if there are no more scans in this cluster, or click the Next Pair button
to register the next scan pair.
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Auto Cluster
To save registered pairs during registration, they are moved into a so-called AutoCluster. It is created below
the previously selected cluster, which is the cluster in which scans pairs are to be registered. If SCENE
needs more than one AutoCluster, these AutoClusters are numbered.

After all scans and clusters were registered, these automatically created clusters are removed.

NOTE: If you cancel a registration for some reason, you will see such an Auto Cluster in the Registration
Dashboard.

Optimize Registration
Optimize Registration always offers a Cloud-to-Cloud registration. To do this, click the Start
Optimization: Cloud-to-Cloud button.

After a manual registration, the cluster contains scans with user-defined targets. A target-based registration
can be performed using Start Optimization: Target Based step button.

Visual Registration
NOTE: The manual registration and the visual registration are troubleshooting options that you can use

when the automatic registration does not work.

Visual Registration provides an option to place scans and clusters view by moving them with drag and
drop. In other words, the visual registration is like a puzzle where you have to fit the pieces, i.e., the scans,
together. The result can then be viewed and evaluated in the correspondence view. After a placing, an
Automatic Registration can be started to refine the registration.

There are three ways to start a Visual Registration:

l Click the Visual Registration button in the Registration toolbar.
You will then be asked to select a cluster.

l Click the Visual Registration button in a cluster line. Select the settings to start registration.
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Figure 9-11 Select Registration option in the Cluster Management

l Click the recommendation to perform a Visual Registration in a cluster line. Select the settings to start
registration.

Figure 9-12 Recommendation to perform a Manual or Visual Registration

Select Cluster
In the first step, select a cluster that must be used for registration.

Select Method
In the second step, select a method that must be used for registration:

1. Click the Select Method button on the upper right side. The Select Method dialog is shown.

2. Visual Registration provides only two methods:
n Cloud-to-Cloud

n Target-based

Place and Register
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Figure 9-13 Visual Registration: Place and Register Scan

In the third step, place and register the scans. For this purpose, think of the scans as pieces of a puzzle that
you must assemble.

A correspondence view is opened on the selected cluster.

1. Click the scan tag.
Rotation and movement manipulators are shown on the scan.

2. Drag and drop the scans.
Look for unique points in the scans, e.g., trees or buildings and align them. To adjust the height, select
the side view (front, back, left or right).

3. Place all scans and clusters correctly in the correspondence view. Click the button Start Registration.

If the registration is successful, the result is displayed in the 3D view or through the Registration Report. If
the registration is not successful, a dialog is shown to inform the user.

NOTE: To better be able to place the scans/clusters and verify the result, select Unique Color or Scan
Color or create an Auto Clipping Box.

Interactive Registration
The interactive registration, developed in cooperation with FARO key customers, allows registering large
and complex projects. While you can still use the automatic, manual and visual registration options, the
interactive registration now provides intuitive, graphical workflows to register scans.

1. To start the interactive registration, click tab Registration in the workflow bar.

2. Then click icon to access the interactive registration.

The interactive registration contains the following tool groups.

Figure 9-14 Interactive registration tools

① Registration views

② Automatic registration tools

③ Interactive registration tools
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④ Georeferencing tools

⑤ Registration toolbar

The order of views and tools in the toolbar reflects the order of steps of the registration workflow. The
registration toolbar helps you to visualize registration objects and their properties.

Workflow Descriptions and Tutorials
The interactive registration is highly workflow-driven and allows using different registration options at the
same time. While you can find step-by-step descriptions of standard workflows in chapter Interactive
Registration Workflow Examples on page 150 to get you started, we strongly recommend to watch the
Interactive Registration Tutorials in the FARO Academy.

1. Log in to the learn.faro.com.
If you do not have an account yet, you must create a new account.

2. Go to tab On Demand, search for SCENE and launch course FARO SCENE Interactive
Registration.

Interactive Registration Views
This chapter provides an overview of the interactive registration views.

Figure 9-15 Interactive registration views

l Registration View on page 134

l Correspondence View on page 169 (link outside registration chapter)

l Inspect Connection on page 138

l Quick View on page 167 (link outside registration chapter)

l Correspondence Split View on page 170 (link outside registration chapter)

Registration View
Click the registration view icon .

The registration view is opened. This is the main view of the interactive registration.

If you do not select an object in the structure view, there are two options:
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l There is only one cluster under the root element. In this case, the registration view of the cluster is
opened.

l There is more than one cluster under the root element. In this case, the registration view of the root
element is opened.

To show the registration view of a particular cluster, click the cluster you want in the structure view.
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Figure 9-16 Cluster in registration view

The registration view displays the registration results in an intuitive, visual way. Connections between scans,
targets and reference points are colorized based on the registration results (see below). With the interactive
registration tools and the registration toolbar you can interact with the registration:

l Add, delete, edit and compute connections

l Search correspondences

l Quickly optimize scan positions

l Update the registration statistics, etc.

For further information on the interactive registration tools, see Interactive Registration Toolbars and Tools
on page 140.

Scan Symbols
The following scan symbols may be displayed in the registration view:

Scans captured by the FARO Focus scanner

FARO Flash scans

PanoCam scans

Scans taken by another scanner

Connections
Connections are only displayed, if a pre-alignment in Stream or a previous registration in SCENE was done.
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The interactive registration shows connections between scans, between scans and targets and between scans
and reference points.

Connections may have different colors depending on their state:

l Blue: New connections that have not yet been refined are displayed in blue.

l Green: Connections are green if the scan point error is below the green value specified in the registration
settings.

l Yellow: Connections are yellow if the scan point error is between the green and the red value specified
in the registration settings.

l Red: Connections are red if the scan point error is above the red value specified in the registration
settings.

l Purple: Connections are purple if they were rejected by the scan position optimization due to a big scan
point error.

This color coding applies to connections between scans, between scans and targets and between scans and
reference points.

① Connections between targets are solid.

② Connections between scans and targets are thin dash lines.

③ Connections between scans and reference points are thick dash lines.

See examples in the figure below:
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Figure 9-17 Interactive registration connections

If connections overlap, do a right-click and select the connection you want. The connection is then
highlighted in the registration view and in the structure view.

Correspondence View
Click button to open the correspondence view.

You can use the correspondence view or the coarse registration to pre-align scans. For further information,
refer to Correspondence View on page 169.

Inspect Connection
You can retrieve information about a connection and make changes as follows:

1. Click the connection you want to investigate in the registration view or in the structure view.
The connection is highlighted. The connection object in the structure view is also highlighted.

2. Click in the toolbar.
TheManual Alignment dialog opens. At the same time, the two scans connected by the connection
are opened in the correspondence view.
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Figure 9-18 Manual Alignment dialog

Left View/Front View/Top View: Changes the orientation of the scans in the correspondence view.

Coarse Registration: Runs a coarse registration (top-view).

Fine Registration: Runs a fine registration (cloud-to-cloud).

Advanced: Marking this checkbox extends the dialog and shows the following options:

Show Refined Statistics: Shows the connection statistics after you have run a fine registration of the
connection.

Show Current Statistics: Shows the current connection statistics.

Use Current Registration: Uses the current registration settings.

Level Scans: Uses the tilt sensor of the Focus data to level the scans if they were not leveled.

Registration Settings:

Open Split View: Opens the correspondence split view.
If you have worked on correspondences in the correspondence split view, make sure to close the
correspondence split view and the Inspect Connection View and then run Optimize Scan Positions.

The OK button is only available after you have run a Fine Registration or clicked option Use Current
Registration.

Quick View

l Click the scan that you want to open in the quick view.
(For this purpose, you can click the scan in the registration view or in the structure view.)

l Click in the toolbar.
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Correspondence Split View
Open the dropdown behind the icon and select Correspondence Split View.

Interactive Registration Toolbars and Tools
This chapter provides an overview of the interactive registration tools. For a description of the interactive
registration workflow, refer to chapter Interactive Registration Workflow Examples on page 150.

The interactive registration provides the following tools:

l Registration toolbar

l Automatic registration tools

l Interactive registration tools

l Georeferencing tools

In addition to these tools, you can also find the following tools that you know from the Explore toolbar, see
chapter Explore Toolbar on page 173.

Interactive Registration Toolbar
The tools in the toolbar help you to visualize objects in the project.

Figure 9-19 Interactive registration toolbar

Connection Tools
For further information about connections, refer to Interactive Registration Views on page 134.

Color connections by pairwise error
l Cloud-to-Cloud connection: Shows the connections of a scan by pairwise (or local) error. The pairwise
error is the error of the registration of a pair of scans. All other scans are not taken into consideration for
the error calculation.

l Targets connections: Shows the fit quality of the target for spheres, planes, markers and checkerboards
in each scan. Errors after registration are not taken into consideration.

To check the pairwise error:

With a target connection or a cloud-to-cloud connection selected, click icon
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You can open the connection properties and check the calculated error values by right-clicking the
connection in the registration view or the structure view and selecting Properties from the context menu.
For cloud-to-cloud connections, you can also open the properties by double-clicking them in the structure
view.

Color connections by global error
Shows the connections of a scan by global error. The global error is the error after the bundle adjustment.
This means that all other scans and connections are taken into account.

To check the global error:

With a target connection or a cloud-to-cloud connection selected, click icon .

You can open the connection properties and check the calculated error values by right-clicking the
connection in the registration view or the structure view and selecting Properties from the context menu.
For cloud-to-cloud connections, you can also open the properties by double-clicking them in the structure
view.

Reference points connections
Shows or hides connections to reference points. See also Import Reference Points on page 94.

Target connections
Shows or hides the connections between scans and targets. For further explanations on connections, see
Connections on page 136.

Cloud-to-Cloud connections
Shows or hides the cloud-to-cloud connections.

All direct connections
Shows direct connections of a scan to other scans, targets, or reference points.

1. Select the scan for which you want to display all connections.

2. Click icon .

If you want to see also connections to another scan:
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3. Click the next scan.

4. Click icon again.

5. Repeat for more scans if required.

Reset shown scan connections

Click icon to reset all connections that you have displayed with icon All direct connections .

If a scan is still selected, the connections will still be shown after you have clicked . To deselect the scan,
click anywhere in the registration view.

Cluster and Scan Tools

Color points by cluster
Colors scan points by cluster.

Color points by scan
Colors scan points by scan.

Default points color
Uses the default scan point color.

Smart Clipping Box
Creates a smart clipping box around the scan positions to make them visible and hides the exterior.
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Figure 9-20 Before creating clipping box Figure 9-21 After creating clipping box

You can now manipulate the clipping box by grabbing and dragging the handles. The clipping box is stored
and is available in the structure view either on project level or in the cluster in which it was created.

If you resize the clipping box to a subset of the project and you are hiding the interior or exterior, you can

toggle between clipping only points and clipping everything by clicking button .

This is especially useful when you want to register a project with multiple floors.

NOTE: You must click icon in the clipping (or use the context menu) to make the clipping box
invisible. Otherwise, you can't select objects in the registration view.

For further information on clipping boxes, refer to section Clipping Boxes (3D View) on page 194.

Identify scan
Allows you to identify to which scan a scan point belongs.

1. Click any scan point or scan point group in the registration view.

2. Click .

The scan to which the selected scan points belong is highlighted in the structure view and in the registration
view.

Automatic Registration Tools
Using the tools in the order in which they are shown in the toolbar runs a complete registration.

NOTE: The following registration options will work in the selected cluster and its subclusters. If you have
not selected a cluster, the registration will be run for the cluster that is displayed in the registration
view and its subclusters.
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Coarse Registration

NOTE: If you run a coarse registration any previous registration information will be overwritten.

After the coarse registration is finished, the Scan Manager will be displayed. This is a pre-registration
method to position the scans in a way that is good enough to run a fine registration. After running a coarse
registration, there might still be scan point errors with a significant value. You need to run a fine
registration.

If some scans are not in a roughly right position after the coarse registration is finished, you can go to the
correspondence view and change the positioning manually.

Fine Registration
Runs a fine (cloud-to-cloud) registration. Note that the scans must be pre-registered before running a fine
registration.

Depending on your environment and the scan pre-alignment, you can change the Average subsampling
point distance and theMaximum search distance as described below in section Registration Settings
Dialog.

For optimum results, you should leave all clusters unlocked. The only exception to this recommendation
occurs if you are registering to reference points. You can find a detailed tutorial in the FARO Academy.

When the registration is finished, the Scan Manager is displayed. If you go to tab Scan Point Errors, you
can sort for the highest error value and double-click it. The connection in question is then highlighted in the
registration view and in the structure view.

If you are satisfied with the registration results, you should lock the cluster that you have registered.
Otherwise, the registration will be displayed as not verified. If the cluster has subordinate clusters, locking
the topmost cluster will also lock all subordinate clusters.

Note that if a fine registration is run after a coarse registration or on a project that has been pre-registered in
Stream, the connections between scans created by the coarse registration or Stream are refined and new
connections are searched by the fine registration.

Target-based Registration 
Deletes all non-forced correspondences and runs a target-based registration.

You can check the registration results in the Scan Manager of the cluster or root object that you have
registered.
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Registration Settings Dialog
Clicking the three-dots icon behind Target-based Registration opens the Registration Settings dialog. In
this dialog, you can override settings that you have made on the registration settings page.

Figure 9-22 Registration Settings dialog

Tab General
Inclinometer: Leveling ensures that the z-axis of the registered scan corresponds to the z-axis defined by
the inclinometer. If you select this option, the inclinometer measurement is used by the registration bundle
adjustment. The inclinometer weight in the bundle adjustment is properly set by default, but you can change
it from the registration weights menu, see also Expert Settings: Adapt Bundling Weights on page 162.
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Compass: If the scans were recorded with a FARO Focus Laser Scanner equipped with a built-in compass,
orientation information is available for the single scans. Enable this option to use this information as
auxiliary information for the correspondence search. If the correspondence search cannot find any
correspondences that are consistent with the compass data, this may be an indicator that the compass was
influenced by environmental interference and the compass data will be ignored. If you disable this option,
no compass data will be used for correspondence search.

Enable auto clustering: SCENE may not be able to find a spatial relationship between all scans in your
scan project and only groups of scans can be registered to each other. The registration internally recognizes
which scans can be registered correctly and which can not. All groups of correctly registered scans are
automatically arranged in appropriate sub-clusters (named Cluster1, Cluster2 etc.).

Separation distance: Separation distance for auto clusters.

Tab Coarse
Subsampling: The result of the registration can be adjusted through the subsampling rate. The value defines
the size of the grid in which scan point homogenization is performed. The resulting grid of points will be
used to perform the registration. When you move the slider, the set value will be shown. Five centimeters
(0.05m) usually work for all environments. If you are indoors, in an industrial environment, you can reduce
the subsampling to 0.35m or even 0.25m.

Average subsampling point distance: Displays the average subsampling point distance in the current
project.

Reliability: The reliability value determines the amount of additional checks on a registration. It filters out
results that could be contested. Higher values allow for more certainty, but could affect the needed time by
algorithm to provide a solution. Set the slider to the value which you expect to bring the result you want. As
soon as you move the button, the set value will be shown.

Tab Fine
Subsampling: see above under Tab Coarse.

Average subsampling point distance: see above under Tab Coarse. Five centimeters (0.05m) usually work
for all environments. If you are indoors, in an industrial environment, you can reduce the subsampling to
0.3m or 0.35m.

Maximum number of iterations: You can define the maximum number of iterations for the algorithm to
find the best solution. By default, this parameter is set to 30 iterations.

Maximum search distance: The maximum distance in which the registration searches for corresponding
points. The maximum search distance must be larger than the initial misplacement. By default, the distance
is set to 10 meters. If the scan pre-alignment is satisfactory, you can set this parameter to 1, 3 or 5 m.

Tab Target-Based
Enable correspondence search: Enables the search for correspondences.
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Find correspondences for scan positions: Mark this checkbox if the position of a scan is known, for
example, by a surveyed reference point or by a reference sphere representing the position of the scanner in
other scans.

Force correspondences by manual target names: Mark this checkbox, if you want to force
correspondences by target names. The targets in each scan must be named according to their counterparts in
the other scans. This feature requires that targets are already detected by SCENE.

Find correspondences to References: Enables the correspondence search between targets in the scans
(points, spheres, markers and checkerboards) and the reference points.

Target distribution threshold: Sets the limit for registration. If targets are too near to one another,
registration will be refused. In this case, lowering the limits gives you a result.

Use checkerboard normals: If this setting is active, the normals of checkerboards are used for the
correspondence search. Uncheck if the direction of checkerboards has changed from one scan to another.
For example, if you use checkerboard targets that can be tilted and turned for a precise orientation to the
scanner.

Calculate scan point based statistics: If this setting is active, the scan point statistics are calculated in
addition to the target statistics. In other words, the registration will also return the scan point errors. You can
use the result as a double-check of the target-based registration. Note however, that only the targets are used
for the registration.

Use principal directions of scans: Uses planes in scans to determine a principal direction for each scan.
These principal directions are used to avoid wrong registration results. This setting may be useful for
scanned buildings with mainly perpendicular walls. The setting is ignored for scans without planes and
should be turned off in scan projects with mainly non-perpendicular planes.

Use points for validation: Enables an enhanced validation of registered scans by comparing the scan points
of the scans. This additional check may help to avoid wrong registrations.

Interactive Registration Tools
Chapter Automatic Registration Tools on page 143 describes how you can run a coarse1, a fine2 and a
target-based registration automatically. The interactive registration tools will help you to quickly edit and fix
the results from the automatic registrations. See below some registration workflows combining these tools.

l Run a coarse and then a fine registration and then use the interactive registration tools to remove wrong
connections and then use Update Statistics.

l Run a coarse registration and then use the interactive registration tools to add connections (to close the
loop, make the registration more robust). Then, use Refine New Connections and Update Statistics.

l Import a Stream project with pre-registered scans, process the scans, and then use the interactive
registration tools to add connections (to close the loop, make the registration more robust). Then, use
Refine New Connections and Update Statistics.

1top-view based
2cloud-to-cloud
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l Import a Stream project with pre-registered scans, process the scans, and then use the interactive
registration tools to run a correspondence search, which uses the current scan positions. Then, use
Update Statistics.

Figure 9-23 Interactive registration tools

Add Connections

1. Click .

2. Then, connect the scans with the mouse.

A new connection is established. In most cases, the new connection will be blue because it has not yet been
computed. For example, you can add connections to close the loop in the scan capture. If a new connection
automatically turns green after creating it, it had already been computed by a fine registration, but was
discarded.

If there are connections with a high error in the Scan Manager, you can also delete them if they are not
needed:

3. Optional: click the connection in the structure view or in the registration view, then press the DEL key
to delete a connection.

For further information on connections, refer to Connections on page 136.

Add Correspondence
1. Open the dropdown behind Add Connections.

2. Select Add Correspondence.

Run Correspondence Search
1. Open the dropdown behind Add Connections.

2. Select Run Correspondence Search to run an automatic search for correspondences between scans.
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Refine New Connections
Click this button to compute new connections, i.e. run a cloud-to-cloud on new connections that have not
yet been refined. If the registration is successful, the connections' color changes to green.

Color Coding of Connections

l Blue: New connections that have not yet been refined are displayed in blue.

l Green: Connections are green if the scan point error is below the green value specified in the registration
settings.

l Yellow: Connections are yellow if the scan point error is between the green and the red value specified
in the registration settings.

l Red: Connections are red if the scan point error is above the red value specified in the registration
settings.

l Purple: Connections are purple if they were rejected by the scan position optimization due to a big scan
point error.

Optimize Scan Positions
This computes the optimization of scan positions after you have added and refined or deleted connections. It
does not yet change the statistics and takes only a few seconds.

You can undo the last optimization by opening the dropdown list and selecting Undo Last Optimization.

Update Statistics
If you are satisfied with the scan optimization and positioning, click Update Statistics. This will update the
Scan Manager statistics. This process may take seconds or minutes depending on the number of affected
scans.

NOTE: Update Statistics also optimizes the scan positions. The reason for providing an extra button for the
Optimize Scan Positions feature is that you may want to optimize the scan positions, change the
positions and then optimize the scan positions again before you update the statistics.

Georeferencing Tools
It is recommended to lock clusters before you start a registration to reference points. This allows an initial
fit of the scans to the reference points.
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Import Reference Points
Opens a dialog in which you can browse the file system.

Select the reference points file you want and click open.

Register to Reference Points
After you have imported the reference points file, run Register to Reference Points. This registration type
only finds correspondences between targets and scans to reference points. It does not find target connections
between scans.

Interactive Registration Workflow Examples
In this chapter, you will find step-by-step descriptions of two standard workflows, using the automatic
registration tools and the interactive registration tools. Note that the interactive registration allows you to use
automatic and manual steps in one registration procedure. Therefore, we strongly recommend to watch the
detailed tutorials in the FARO Academy. These tutorials include, for example, the following workflow
approaches:

l Hybrid registration where you can add targets.
Hybrid registration which allows you to use cloud-to-cloud and target connections in the same
registration.

l Register to reference points using the georeferencing tools.

To open the FARO Academy:

1. Log in to the learn.faro.com.
If you do not have an account yet, you must create a new account.

2. Go to tab On Demand, search for SCENE and launch course FARO SCENE Interactive
Registration.

Optional Registration Settings Before you Start the Interactive
Registration
Go to the Registration Report settings and change the settings as explained in the NOTE section.
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Open the Interactive Registration
1. To start the interactive registration, click tab Registration in the workflow bar.

2. Then click icon to access the interactive registration.

If required, select the cluster that you want to register.

3. Click icon to open the interactive registration view.

Registration works for the selected cluster. If no cluster is selected, it works for the cluster that is displayed
in the registration view as well as its subclusters.

Make Registration Objects more Visible with a Clipping Box
As a first step, you should make the objects in the registration view, scans and connections, as well as
targets and reference points, more visible by setting a smart clipping box. See explanations in Smart
Clipping Box on page 142.

Workflow: Coarse and Fine Registration with the Automatic
Registration Tools
1. Make sure that the clusters you want to register are unlocked.

If the scans have not been pre-aligned with Stream or if the pre-aligning is not satisfactory, run a coarse
(top-view-based) registration.

2. For this purpose, click icon Coarse Registration.
Note that the coarse registration will remove any prior registration.

If required, you can inspect connections as well as add or delete connections. If the scans are not in a good
position, you can go to the Correspondence View on page 169 and correct the scan positioning manually. At
this point, the connections are still blue because they have not yet been refined.

3. Optional: Adjust the fine registration settings.

4. When the scans are positioned correctly, refine the registration with a fine registration by clicking icon
.

5. Check the scan point errors in the Scan Manager.

6. Lock the cluster(s) that you have registered.
Otherwise, the registration will be displayed as not verified.
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Workflow: Fine Registration with the Interactive Registration
Tools
1. Make sure that the scans are pre-aligned, either in Stream, with a coarse registration or manually in the

correspondence view.

2. If required, add or delete connections.

3. Click Refine New Connections to run a fine registration on the new connections.

4. Click Optimize Scan Positions.
This procedure takes just a few seconds and allows you to view the final positions of the scans. The
scan statistics are not yet updated.

5. If you are satisfied with the scan positions, click Update Statistics.
This will update the Scan Manager.

6. Lock the cluster(s) that you have registered.
Otherwise, the registration will be displayed as not verified.

Optimize Scans after a Registration
You can only run this compensation after registering clusters with cloud-to-cloud connections between
scans. You cannot run this compensation if you have used only a target-based registration.

What is Compensated by this Process?
The process analyzes the geometry within the overlap areas of multiple scans to compensate deviations in
the scans. Such deviations may have different root causes including a not properly warmed up scanner, or
dirty optics. See the user manual of the laser scanner for more details.

What is not Compensated by this Process?
This process does not compensate the angular errors in the scanner. If you detect a gap, for example double
walls in the overlap area between the beginning and the end of the scan, you must run an on-site
compensation on your scanner.

For more information, see your scanner user manual.
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How to Identify Scans that are Affected by Distance Errors
After you have run a registration, you may notice some gaps, for example double walls, during the visual
verification that you cannot fix as usual by changing the registration parameters or by adding or removing
connections between the scans.

Figure 9-24 Registered scans with gaps in overlap areas

Run the Scan Optimization
Before you start the procedure, make sure that the scans are not affected by the angular error described
above.

1. Go to the interactive registration.

2. Open the registration view of the cluster.

3. Unlock the Scan Manager of the cluster for which you want to run the post-registration optimization,
including the subordinate clusters.

4. Right-click the cluster in the structure view and select Operations > Registration > Post Registration
Scans Optimization.

The compensation process will start. When the process is finished, a message will be displayed telling you
how much the registration mean error has been improved.
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Figure 9-25 Example of an optimization message

If no scans were found for optimization, the message will be No scans found that can be optimized.

If serious errors were found, the algorithm will be able to improve the scans. Despite these improvements,
the scans' accuracy will still be compromised. Such errors occur, for example, when a scanner mirror is
extremely dirty. In such a case, the following error message will be displayed:

Figure 9-26 Optimization error message

If the scans in the cluster need to be compensated, the process will take the equivalent time to process and
register (refine connections and update statistics) the scans from the beginning.

The results of the compensation process are:

l Compensated scans.

l The registration is updated using the new compensation scans.
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Figure 9-27 Section of a wall with column before (top) and after (bottom) optimization

Figure 9-28 Small steel profile section before and after optimization

Registration Report
After you have gone through all registration steps, the Registration Report will give you an overview of the
results.

In the Registration Dashboard, click the Registration Report button. This button is also displayed on the
final page of the registration task.

NOTE: For the report, all values with a length unit (point error, subsampling settings, and others) will be
shown in the smallest unit of the selected set (metric = mm, imperial = inch, imperial US = inch
US).
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Target Statistics
Target Statistics shows all reference pairs and target pairs used for the scan registration. Values close to zero
indicate a good registration result. Here you can easily identify reference pairs which are causing problems
in the registration.

As you can see in the figure below, all values are color coded with a bar on the left side, same as the table
cells.

Figure 9-29 Target-based registration report

① Name of the cluster
The name of the registered cluster the report is opened on.

② Switch between Target Statistics on page 156 and Scan Point Statistics on page 158.

③ Maximum Distance Error
This setting as well as the following statistics display the averaged Maximum and Mean error between
all targets in this cluster: Maximum Distance Error / Mean Distance Error

④ Maximum Horizontal Error / Mean Horizontal Error

⑤ Maximum Vertical Error / Mean Vertical Error
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⑥ Maximum Angular Error / Mean Angular Error
Shows the averaged maximum or minimum angular error between all plane targets in this cluster.
Angular errors can only be calculated for plane targets, which are planes, checkerboards, and slabs.

⑦ Settings
Shows the settings used for placing the scans as well as a legend for the color coding of errors.

⑧ Report Mode
The report has three modes:
Simple: Displays all statistics between the first-level scans of the cluster.
Full: Displays all statistics between all scans inside the cluster (recursive).
Color Matrix Mode

⑨ If you require the Registration Report Table for usage outside SCENE, you can either save the report as
PDF or copy the report directly into Microsoft Excel. Mark the table, or parts of it, and copy it to
Microsoft Excel. Save the Registration Report as PDF.

⑩ Click the Close button to close the Scan Report and to return to the Registration Dashboard.

⑪ Matrix
Gives a colored overview for the registration quality of the scans. Displays the error between a pair of
scans or cluster. The type of error shown (e.g., Max Distance Error) can be changed in the Error Type
Selection List.

⑫ Error Type Selection List
Open the dropdown menu to select the type of error you want to see in the corresponding mode.

The view of the matrix depends on the content of the selected cluster. If this cluster contains subordinate
clusters, the matrix displays the registration quality for those clusters. If the selected cluster contains scans,
the matrix displays the registration quality for those scans.
If there is a square in yellow, red, or green color and you want to know which pair of scans or clusters they
represent, use the mouse to hover over the square. The names of the two scans or clusters are displayed,
with the error value.

The Detailed Errors table shows errors between corresponding targets in a structured way:

l In the first level, the registered scans or clusters are listed. The maximum and mean errors for all the
connections of the scans or clusters in the first level are displayed.

l In the second level, the scans or clusters with which the scan or cluster of the first level has targets in
common, are listed. The maximum and mean errors for each connected scan pair are displayed.

l In the third level, individual targets and the errors in the registration of corresponding targets between
the scans of the first and second level are listed. The point errors are displayed for each connected target
pair.

Inclinometer Mismatches
The Inclinometer mismatches list is shown as part of the scan point statistics. This list displays the angular
offsets between a scan's up direction after registration and the scan's up direction according to the scanner's
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inclinometer.

For scans without an inclinometer, a dash ‘-‘ is shown instead of a value.

Scan names are specified as follows:

l Scan Name: For direct Scans of the main report cluster.

l Cluster Name: For sub-clusters.

l Cluster Name_Scan Name: For scans in the sub-clusters of the report cluster.

Scan Point Statistics
A similar report is available for the scan point statistics. However, this report shows the scan point
references rather than the target pair references.

Figure 9-30 Scan point based registration report

① Name of the cluster
The name of the registered cluster the report is opened on.

② Switch between Target Statistics on page 156 and Scan Point Statistics on page 158.
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③ Maximum Point Error
Maximum point error of all shown scan pairs.
Mean Point Error: Mean point error of all shown scan pairs.

④ Minimum Overlap
Minimum percentage overlap of all shown scan pairs. All values are color coded with a bar on the left
side, same as the table cells.

⑤ Settings
Displays the settings used to register the selected cluster.

⑥ If you require the Registration Report Table for usage outside SCENE, you can either save the report as
PDF or copy the report directly into Microsoft Excel. Mark the table, or parts of it, and copy it to
Microsoft Excel as PDF.

⑦ Color Matrix Mode

⑧ Error Type Selection List

Detailed Errors, Scan Point Statistics
The Detailed Errors table (in Simple Mode) shows detailed error values for every registered scan pair or
cluster pair:

l Depending on the selected report mode, in the first hierarchy, all scans inside the cluster are shown. The
errors that are displayed are applicable to all connections of the Scan or Cluster.

l The first hierarchy will show the name of the scan or cluster, the number of connections it has, the mean
point error, maximum point error and minimum overlap.

l By clicking on the first hierarchy row, the connections show the individual scan or cluster Name, point
error, and overlap.

l The three right columns are color coded with red, orange and green according to specific thresholds that
can be adjusted using the registration settings.

The table can be sorted by clicking on the table header of every column.

Saving or Exporting the Registration Report
If you want to use the Registration Report Table outside SCENE, you can either save the report as PDF or
copy the report directly into Microsoft Excel. Mark the table, or parts of it, and copy it to Microsoft Excel.

NOTE:When importing the table to Excel, the decimal separator must correspond to the decimal separator
used in SCENE. Otherwise, the numbers will be automatically converted into another format, e.g.,
a date.

Clicking the Save Report button opens a File Open dialog where a location and a file name can be chosen.
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In the PDF report, the same data is displayed as in the SCENE report. Additionally, some information about
the project are listed like project name and recording period.

Import Surveyed Points
In the Registration toolbar, you have an option to import surveyed points. You can use this option when
you need to include external references. For further information, see Import surveyed reference points.

Project Alignment Dashboard
The Project Alignment Dashboard provides you with tools that enable you to change global coordinates in
your project. Use these tools after you have processed and registered all your project scans. Project
alignment tasks are often helpful when you want to export your project for use with other data, and you
want to ensure that the exported data matches the coordinate system of the data you want to use with it.

All changes that you make are immediately applied to the project. As long as you have the dashboard open,
you can undo the changes that you make during that dashboard session. After leaving the dashboard, the
changes can only be undone by rolling back to a previously saved version of the project.

Dashboard Tools

Two point alignment
Use the two-point alignment tool to change the origin position and orientation of your project's coordinate
system while keeping the "up" direction (Z-axis) unchanged. To use the two point alignment tool:

1. Select a point that should serve as the rotation point.

2. Select a point to define the first axis. This axis will go through this
point and the origin point you selected.

3. Select another point for the z-axis rotation. The axis will be constructed
orthogonal to the z-axis.

Three point alignment
Use the three point alignment tool to change the origin position or the orientation of your project's
coordinate system. You can select an existing scan point to serve as the origin, or you can set an offset to a
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selected point to move the origin to a place where no scan points exist. To use the three point alignment
tool:

1. Select a point that should serve as the new origin, or a point that is close to where the new origin will
be.

2. If the point is not exactly the point that should serve as the
new origin, enter an X, Y, and Z offset, as needed, to define
the position of the origin.

3. Select a point to define the first axis. This axis will go
through this point and the origin point you selected.

4. Select another point. This point defines the direction of the
second axis, which will pass through the origin point at a
right angle to the first axis.

Quality Manager

Quality Manager is a program used to verify and report the quality of FARO SCENE registrations. It also
helps make the registration process for target-based registrations more efficient and improves delivered
results.

The quality of a registration is checked by launching Quality Manager from the toolbar icon. A graphical
interface shows all important data and highlights possible quality problems.

Refer to the Quality Manager User Manual for more information.

Fix the Position and Orientation of Scans
This feature allows you fix the position and orientation of one or multiple scans. This means that the scans
will be used during the registration, but their positions and orientation will not be changed.

You can select a cluster, multiple scans or only one scan. The fixed scans are displayed with an orange

circle in the structure view: 

This feature is especially useful if you add new scans to an existing project where you do not want to
change the position of the existing scans while registering the new scans to them.
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1. Select the scan(s) you want in the structure view, then right-click to open the context menu.

2. In the context menu, select Operations > Registration > Fix Scan.

Expert Settings: Adapt Bundling Weights
The default weights have been set using many projects from different applications and are valid for most
cases.

NOTICE:We do not recommend changing the default weights unless you have considerable experience
in surveying networks adjustments, in least squares or you have been told by a FARO
employee to modify the bundling weights. For example, you should be aware that the
inclinometer is an angular value (weight 8) while the target point is a position (weight 1). This
does not mean that the the inclinometer has 8 times more weight than the target point.

If you need to change the bundling weights, proceed as follows:  

You can select any item in the structure view and modify the default weight of that object. If you click a
cluster, you will modify the weight of all elements in that cluster.

1. Right-click the object you want, either in the structure view or in the registration view.

2. In the context menu, select Operations > Registration > Bundling Weights.
The following dialog is displayed.

Figure 9-31 Adjust bundling weights - example

3. Click into the line you want in column Factor and change the value.

4. Click OK.

You can reset any changes to the default value by clicking button Set To Default.
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Chapter 10: Explore

There are various views to display and explore scans and point clouds. In the views, you take a position as
an observer and look in a certain direction to observe the scanned area with a freely selectable scale.
Depending on the type of view, your selection of position can be limited. In the quick view and the planar
view, you can only assume the position of the scanner, i.e., you cannot move freely in the room as an
observer. This is only possible in the 3D view. The line of sight and the scale are freely adjustable in all
types of view.

When you open the view of a single scan, at first you are in the position of the scanner when it recorded the
scan. You will see the scan points of the scanned area all around you. To change the scale, use the scroll
wheel of your mouse. If you turn the wheel toward you, you increase the scale; the displayed area becomes
smaller. This is similar to using a telephoto lens on a camera. If you turn the wheel away from you, you
decrease the scale. The displayed area becomes larger, similar to using a wide-angle lens.

NOTE:When a project is opened, the scans are not automatically loaded. To load all scans, select Load all
Scans option in the context menu of the project in the structure view. To unload all scans, select
Unload all Scans and Pictures option in the context menu of the Project. However, to unload the
scans, de-select the Loaded option in the context menu of the Scan or Cluster. After a Scan is
unloaded, it can be reloaded by selecting the Loaded option.

View Project
Click the View Project button . The scan project is shown in a 3D view.

There are various views to display and explore scans and point clouds. For further information, refer to
section Basic Concepts.

VR View
With the virtual reality equipment, you can experience your scans as if you were on location, take
measurements, make screen captures, and read annotations. For further information, refer to section Virtual
Reality.

Clusters
To create a new cluster:
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1. In the structure view, right-click the project name, then click New> Cluster.
A cluster will be created.

2. Give the cluster a name.

3. Create more clusters, for example FirstFloor, SecondFloor, ThirdFloor.

4. If required, create subordinate clusters, for example, clusters that contain the scans for special rooms.

5. Arrange those clusters by dragging and dropping them into the respective superordinate cluster in the
structure view.

6. Drag and drop the scans into the clusters in which they belong.
You can also drag and drop subordinate clusters into a cluster folder.

NOTE: You can combine laser scanner scans and hand-held scans in one scan project.

3D View
With the 3D view, you can achieve the most easily comprehensible view of the scan points and CAD
models. The 3D view is normally set up with the field of view corrected, so that you get an impression close
to reality. Unlike the quick view and the planar view, scan points manipulation and analysis is limited in the
3D view.

NOTE: On systems with NVIDIA Quadro graphics processors, rendering performance in the 3D view
might be slow or intermittent. To improve rendering performance, start the NVIDIA Control
Panel application (available in theWindows Control Panel) and select 3D Settings > Manage
3D Settings > tab Global Settings > 3D App – Game Development .

The 3D view will show scan point clouds, or the project point cloud. Such a point cloud must be generated
by SCENE 6.1 or greater.

If there are no such point clouds, these will be generated automatically. During generation, no scan points
are displayed. This is not the case for hand-held scans during capturing, because those scans have a different
format and will be converted later on during processing.

If your scan project contains point clouds of new and old format (including scans for which no point cloud
has been created), the following will happen:

l Automatic conversion of legacy point clouds in the background.

l A warning message is displayed.

It is not possible to edit the legacy point clouds until they are converted.

Point Clouds of Earlier SCENE Versions Available
If your scan project contains point clouds of an old format, editing of the point clouds is possible.
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You will be informed that these point clouds should be updated.

3D View of a Single Scan
Right-click the scan’s name in the structure view, then click View > 3D View in the context menu.

Figure 10-1 3D view of a single scan

3D View of a Cluster
You can also open the 3D view for all the scans within a cluster.

Right-click the cluster’s name in the structure view, then click View > 3D View in the context menu.

In the 3D view, the points of scans have priority over the points of scan point clouds, which means that the
points of loaded scans will be displayed instead of the points of the related scan point clouds.
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3D View of the Project Point Cloud

Figure 10-2 3D view of a project point cloud

Right-click the superordinate cluster in the structure view. Typically, it is simply called scans. Then, click
View > 3D View in the context menu.

NOTE: If no project point cloud is available, this button or command will open the 3D view of all scans of
the project. Displaying the scans of a project behaves like displaying the 3D view of a cluster.

Normally, the 3D view displays the scan points and objects with the correct field of view. In other words,
objects of the same size appear smaller with increasing distance (Perspective View). You can also change
the view to an Orthographic View. Then, objects of the same size always appear the same size, regardless
of how far away they are. This type of representation is common in a lot of CAD systems. You can switch
between these two representations in the Navigation Toolbar (3D View only) on page 32.
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Quick View

Figure 10-3 Quick view

The quick view is the standard view and displays the content of a single scan.

To start the quick view ,

l double-click the scan’s name in the structure view.

l right-click the scan’s name in the structure view, then click View > Quick View in the context menu.

You can also open the quick view in the interactive registration.

After the quick view has been opened and is displayed, the scan point data will be loaded in the background.
Until the data is loaded, you can view the scan and navigate but you cannot manipulate the scan points. As
soon as the scan data has been fully loaded, all the scan point manipulation functionality is available.

The following restrictions apply in the quick view:

l You always see the scanned area from the scanner position, which means you cannot leave this position
until you change your line of sight and scale.

l The field of view cannot exceed 180°.

You can adjust the line of sight by holding the left mouse button down and moving the scan points in the
direction required. In quick view, the Examine Mode is the standard viewing mode.
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Planar View

Figure 10-4 Planar view

Like the quick view , the planar view displays the content of a single scan only.

To start the planar view right-click the scan’s name in the structure view, then click View > Planar View in
the context menu.

At first glance, the planar view may appear very strange because the scanned area seems to be distorted.
Connections between objects in the picture do not run in a straight line but are curved. For the planar view,
uses the same technique as it is used for depicting the earth's surface on a map where the area around the
poles appears to be magnified, and the flight route between two distant cities is not straight but bent.

The consequence of the distortion is that it only succeeds approximately in displaying other objects
congruent with the scan points. If a scanned reference sphere already appears in the view more like an
ellipsoid than a sphere, do not be surprised that the added reference object does not cover the reference
sphere completely. For this reason no CAD models are displayed in the planar view; use the 3D view for
this instead.

The planar view is useful because of the fact that with some scanners, it is the most natural display format
of the scan points. A lot of scanners process the horizontal and vertical angles step by step; it is therefore
practical to display the scan points in a column and row oriented manner accordingly.

The view starts at the left margin with the first column the scanner recorded. In the local coordinate system
of the scanner, this column normally has the horizontal angle of 0°. The subsequent columns then come to
the right, with an increasing horizontal angle until 360° is reached with a circumferential scan. In the top
row, the scan points with the greatest vertical angle reached are displayed, for example, the zenith with
+90°, which is directly over the scanner. From top to bottom, the vertical angle decreases, reaching 0° at the
horizontal line and then becoming a negative value. The smallest possible vertical angle is –90°.

As in the quick view, you always view the scanned area from the scanner position – you cannot leave this
position. However, you can of course change your line of sight and scale.
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As in all views, you can set the scale using the scroll wheel of your mouse. There are also further buttons in
the toolbar for the planar view which you can use to change the scale.

Correspondence View
In the correspondence view, you can change the position of scans. This can be helpful to pre-align scans
before running a cloud-to-cloud registration or to verify registration results.

1. To open the correspondence view, right-click the Cluster node in the structure view.

2. From the context menu select View > Correspondence View.

You can also open the correspondence view in the interactive registration.

If there are clusters that are not located in the center of their scans, a message is shown asking you whether
you want to move the clusters to the center of their scans. You can also make this a default in the
registration settings.

Now you can start placing the scans.

3. Click the scan tag.
Rotation and movement manipulators are shown on the scan.

4. Drag and drop the scans or use the keys described below to move the scans.
Look for unique points in the scans, e.g., trees or buildings and align them. To adjust the height, select
the side view (front, back, left or right).

Keyboard Options for Positioning Scans
The following options are available on a keyboard with a number pad:

l Change the size of the manipulators with the number pad + key (increase size) and - key (decrease size).

l Use keys 8 and 2 to move the selected scan up and down.

l Use keys 4 and 6 to move the selected scan to the left and to the right.

l Use keys 9 and 7 to move the selected scan clockwise and counterclockwise.

NOTE: Only a certain amount of pixels is moved when you use these keys. If you have zoomed in, the scan
representation on the screen will move very slowly. If you want to go faster, zoom out before
moving the scan representation.
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Undo and Redo Changes
1. You may undo and redo your changes with the following buttons:

Undo the last transformation change with .

2. Redo the last transformation change with .

3. Restore the initial transformation with .

Note that this is only possible as long as the current scan is selected. When you select another scan, you can
no longer undo and redo the changes of the previous scan.

Correspondence Split View
The correspondence split view shows two scans side by side in either 3D view or quick view. In the
correspondence split view, you can find and force correspondences between two scans to prepare
registration. You can also use the correspondence split view to check and compare registration results.

1. To open the correspondence split view, right-click the Cluster node in the structure view.

2. From the context menu select View > Correspondence Split View.

You can also open the correspondence split view in the Scan Manager Properties or in the interactive
registration.

The screen splits into two windows. In addition, a toolbar is displayed that provides options for marking
targets as well as finding, forcing and clearing correspondences.

Figure 10-5 Correspondence split view toolbar

3. Drag one scan into the left window and another into the right window.

NOTE: If you want to find correspondences between the scans, both scans must either already have target
references or you must mark targets, like planes or points. The procedure of marking targets is
similar to the procedure described in chapter Manual Registration.

Find Correspondences
1. Rotate, move, or zoom the two scans until you have them in a useful position, i.e., they show the same

part of the scenery.
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2. Click the Find Correspondences button .
SCENE starts to search for corresponding objects and will mark them with a label.

NOTE: A label shows a name with a maximum of 9 characters. If the name has more characters, only the
last 8 will be displayed and an asterisk (*) will replace the missing characters. When you click a
label, the name is shown completely.

Figure 10-6 Correspondence split view with automatically detected targets

When a correspondence has been found, the label gets a small green field with a C which indicates that
these correspondences were found automatically.

The frame around the label shows the quality of the correspondence:

l Green: good quality

l Yellow: compromised quality

l Red: seriously compromised quality

Mark Targets to Find Correspondences
1. Check if there are corners, angles, planes, etc. which could be useful and which are not yet marked.

2. Click one of the following buttons and mark the same target in both scans.

: marks a point

: marks a plane

: marks a circular flat target
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: marks a checkerboard target

: marks a sphere

: marks a slab

If SCENE detects that the marked objects are correspondences, it will mark them with a label.

Force correspondences
1. Check if there are more objects which could be useful and which are not yet marked.

2. Click the Force Correspondences button .

3. Select the first object in the left window.

4. Select the corresponding object in the right window.

5. Repeat the above steps until you have marked all objects for which you want to force a
correspondence.
If SCENE detects that the newly marked objects are correspondences, it will mark them with a label.

6. If no correspondences are found automatically, you can force them by clicking the Force current

correspondences between shown scans button .

Figure 10-7 Correspondence Split View with corresponding and forced targets

SCENE will now force correspondences between these objects. Their labels will then show a small blue
field with a C which indicates that these correspondences are forced.
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Explore Toolbar
The Explore features allow analyzing a scan in different views. The buttons you see in the Explore toolbar
depend on the kind of view that is currently selected, i.e. quick view, planar view or 3D view. Several
buttons include more than one function and are marked with a little arrow beneath the icon. To check those
functions, click the triangle icon and a dropdown menu will open. Some of these functions might be grayed
because they do not work with a certain view. As soon as you select a function out of a dropdown menu, its
icon will be shown in the toolbar.

Figure 10-8 Example: Explore toolbar for a 3D view

Buttons for Quick View, Planar View and 3D View
l View Project

l VR View

l Overview Map

l Annotation

l Measure Points

l Selection
When you click this button, a toolbar with various selection buttons is shown in the work area. If you
click the Expand button, menu entries are displayed next to the selection buttons.

l Mark
TheMark menu provides different options to mark points, planes spheres, checkerboards or markers.

l Project Point Cloud

Buttons for 3D View
l Viewpoints

l Show Grid

l Mesh Selection

l Create Virtual Scan

l Auto Clipping Box
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Button for Planar View
Zoom 100%
Adjusts the zoom of the displayed part of the planar view to 100%

Button for Quick View and 3D View
Save Screenshot

Buttons for Quick View and Planar View
l Color Mode (only quick view and planar view)
This button provides an option to easily switch between color and gray (intensity) mode of a scan. Click
Color Mode to reload the scan in the color mode or gray (intensity) mode. If more than one view of this
scan is opened, all views are updated and the scan data is visualized in the selected mode. If the color
mode is selected and the scan contains only color or gray mode views, a warning is displayed. This
button is now also available in the interactive registration quick view because detecting spheres is more
accurate in color mode.

l Mark Distance Range (only quick view and planar view)

Navigating with the Mouse in 3D View
Left mouse button click and drag: Move the image area.

Left mouse button double click: When you double-click a scan point the 3D view, the camera flies toward
that scan point. Each time you double-click again on the same scan point, the camera flies even closer to
that scan point. To stop this Fly to point feature, move the view with the mouse or with the respective keys.

Mouse wheel scroll: Zoom in or out.

Middle mouse button or mouse wheel click: Shift the image.

Right mouse button click: Open the context menu.
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Navigating with the mouse in Quick View
Left mouse button click and drag: Move the image area.

Left mouse button double click: When you double-click a scan point the 3D view, the camera flies toward
that scan point. Each time you double-click again on the same scan point, the camera flies even closer to
that scan point. To stop this Fly to point feature, move the view with the mouse or with the respective keys.

Mouse wheel scroll: Zoom in or out.

Middle mouse button or mouse wheel click: Shift the image.

Right mouse button click: Open the context menu.

Navigating with the mouse in Planar View
Left mouse button click and drag: Move the image area.

Mouse wheel scroll: Zoom in or out.

Right mouse button click: Open the context menu.

Overview Map
The overview map provides a top view overview to the whole scan project. The map is by default, a gray
scale image. It is recommended to create the map after the registration and cleanup of scan points is
completed. (Note that the map is created from the points in the individual scans—not from the project point
cloud.)

Scans in the Overview Map
In the overview map, the scanner positions are displayed as colored dots. If you click a dot, the scanned area
is highlighted and a menu opens that allows opening the scan in the 3D view, the quick view or the planar
view.

The icon with the dropdown button provides a menu with the following options:
If no overview map is available, clicking on this icon will create an overview map.

NOTE: An overview map can also be opened on a single scan or a cluster. Right-click the desired object to
open the context menu and select View > Overview Map. This overview map displays only the
scan or the scans that are part of the cluster.
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Create
Select this option to create a new overview map for a scan project.

Update
If you change the transformation of scans or clusters, or if scan points are deleted after the map has been
created, the map becomes invalid. Update the map in such instances.

Delete
Select this option to delete the overview map.

NOTE: Even though an overview map is deleted, it may be available in older revisions of your project.
Perform theWipe Project History operation to free the space allocated for the overview map files
in old revisions, if required.

The toolbar contains a view all button, zoom in/zoom out buttons, and a button that opens the Overview
Map settings, see below.

The lower left corner also contains a scale bar that shows the metric and imperial scale. The default scale is
meter or feet.

Each scan is marked with an icon. Hover on a scan marker icon to view the name of the scan. Click the
icon, to open a popup. The popup contains the name of the scan and buttons to open quick and 3D views of
the scan.

Overview Map Settings

You can adjust the visible objects and the color of the overview map. Click the Settings button in the
toolbar and go to Views Settings. In section Overview Map, you can set the foreground, background and
scan highlight color, show or hide the scanner positions and scan highlight points. Refer to chapter
Overview Map Settings for more information.

You can also change the overview map settings directly in the Explore category. If you open the overview
map several times in different tabs, you can have different settings in each tab.

Click icon in the small toolbar at the bottom of the screen to open the settings for the current overview
map.

If you want the settings to be identical in all open tabs, click in the tab that has the settings you want and
switch on Apply To All Maps. When you open an overview map in any project, default values are always
used. You can use the settings in any map to set new default values by clicking in the map and then
switching on Save to Default Settings.
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Export the Overview Map
The overview map for a scan project can be exported as a high resolution TIF image or as a DXF file that
can be opened in any CAD system for further modeling.

In the Export toolbar, click Export Overview Map.

A file dialog opens where you can enter a name of the exported file.

An additional text file is also created that contains information about the resolution, the image size in pixels
and in meter, and the corner points of the image and the associated TIF file.

In the Export tab, you can not only export the complete scan project, but also scan clusters and single scans.

Annotations (3D View, Quick View, Planar View)
To attach an annotation to a certain scan point:

1. Open a view of a scan, a cluster, or a scan project.

2. Select the annotation tool from the toolbar, then click the point of interest in the view.

3. The new annotation and its Documentation Properties dialog are displayed.
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Figure 10-9 Documentation object in 3D view

Documentation Properties
You can enter detailed information in the Documentation Properties dialog.

Position – determines the position of the documentation object in the working area.

Description – detailed information about the documentation object.

Hyperlinks – hyperlinks to files or websites.

l Add a new hyperlink by entering its address into the lower text field, then press Add.

l Change the order of the hyperlinks with the Up and Down buttons.
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l Delete them with the Remove button.

l Open them by double-clicking the list item or by pressing the Open button.

General Tab
You can enter the name of the documentation object in the General tab. Since a documentation object
usually consists of a text string, its Layer should be defined as Text.

Create Annotations at the Scanner Position
To create a documentation object at the scanner position:

1. Right-click the scan in the structure view.

2. Select New > Documentation.
The Documentation Properties dialog is displayed.

3. Proceed as described above.

Measuring (3D View, Quick View, Planar View)
With renovations, you are often confronted with the question of whether there is still enough space in the
building for the intended machinery. Since you can only rely on the CAD model of the building to a certain
extent, you will probably have to examine and take measurements of the site.

There are two different approaches for measuring distances:

l Between scan points

l Between objects such as spheres or planes
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Shot Direction Tool
The Shot Direction Tool can only be used with the Forensic Wizard app. On a crime scene, investigators
can mark bullet holes with rods and spheres and then scan the crime scene. With the Shot Direction Tool ,
you can connect these spheres. In the Forensic Wizard app, these connections are evaluated to determine the
bullet trajectory and the position of the shooter.

You can find detailed information on the FARO Knowledge Base.

Measure Points

Figure 10-10 Point-to-point measurement

1. Open theMeasure dropdown list in the toolbar and clickMeasure Points.
The appearance of the dropdown list depends on your previously selected measuring mode.

2. Select valid scan points in the respective view with the left mouse button.

3. Select the last measure point and finalize the measurement by a double-click with the left mouse
button.

4. To leave the measurement process, click the right mouse button or press the Esc key.

Several keyboard commands are available in the quick view and the 3D view:
ENTER : Finalize the measurement without adding a last measure point.

Backspace : Remove the last measure point.
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Home : Add a last measure point at the start position and finalize the measurement.

A new point-to-point measurement gets added as a child object in theMeasurements folder of the structure
view.

A point-to-point measurement made in the 3D view is only visible in the 3D view. It is not linked to any
individual scan. If the involved scans are changed later or transformed, the measurement stays in the same
place. In this case you could delete the measurement and create a new one.

In the quick view and the 3D view, a yellow dashed line is drawn between the measure points. Labels show
the overall distance and the length of each measure segment. In the planar view, only the overall distance is
shown.

Invalid measure points of point-to-point measurements are indicated by a red outline. An invalid measure
segment is indicated by a red dashed line.

Two additional lines show the vertical and horizontal distance between the first and last measure point.

Measure Objects
Probably you frequently have to measure distances to level surfaces, for example to the wall, the floor or the
ceiling. In this case you should fit a plane through the wall and measure from the plane to the point you are
interested in. When using a plane, the measurement is automatically taken perpendicular to this plane.

NOTE: Object measurements are also available in the structure view.

Figure 10-11 Object measurement

You can measure between objects of the following types:

Point objects
l Sphere (A sphere is a point object because its central point is used for measurement)

l Checkerboard

l Point Object, Corner Point

l Scan, i.e. the scanner icon which stands for a scanner position

SCENE User Manual
Chapter 10: Explore

SCENE User Manual (2024.0) Page 181 of 372



Figural objects
l Plane, including Expanded Plane, Rectangle, Slab

l Pipe

Figure 10-12 Checkerboard point – plane measurement

1. Open theMeasure dropdown list in the toolbar and clickMeasure Objects.
The appearance of the dropdown list depends on your previously selected measuring mode.

2. To select objects for your measurement, select them with the left mouse button.
You can also select objects in the structure view this way.

It may happen that objects superpose. In this case, a small dialog opens which lists these objects.

3. Double-click the one you want to use, and continue measuring.

You can measure the distance between more than two objects if you hold down the Shift key when clicking
on the next object. However, an object measurement can only contain one figural object.

A new object measurement gets added to theMeasurements folder of the structure view.

If the position or location of the objects used for the measurement change, for example, by a new fit or by
updating the registration, the measurement is automatically updated.

Measure Object
The representation of a measurement is called a measure object. To open the Properties dialog of a measure
object, double-click it in the structure view, on its label, or near a measure line.
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Figure 10-13 Properties of measurement object

The Properties dialog provides distance information and a list of the involved objects of an object
measurement.

You can hide the lines for the vertical and horizontal distances and the label for the overall distance by
selecting the Show Distance checkboxes.

Selecting Scan Points (3D View, Planar View, Quick
View)
Depending on the view, it is possible to select scan points and then apply commands to this group of points:

l Selecting Scan Points in the Planar View or the Quick View

l Selecting Scan Points in 3D View

l Inverting a selection of scan points

You can also delete scan points.

Selection Combinations
There are different types of selection combinations which determine what effect the next selection to be
executed has on the selection that already exists.
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1. If there is no selection: select scan points with one of the scan point selection tools.

2. Select the required combination type from the toolbar:

New selection button : The next selection replaces the existing selection.

Add selection button : Combination mode whereby the next selection is added to the existing selection.

Subtract selection button : Combination mode, whereby the next selection is removed from the existing
selection.

Intersect selection button : Combination mode whereby the difference of the two selections is retained.

Selecting Scan Points in the Planar View or the Quick View
In the planar view and in the quick view, it is possible to select scan points and then apply a variety of
commands to this group of points.

l Apply filters on the selected scan points

l Delete scan points

l Push or pull
Push: All scan points of a selection which are situated betweenMinimal Distance andMaximal
Distance, are moved away from the scanner position (being the origin of the local coordinate system of
the scan) by the value that is specified in Scan > Properties > Scanner Info > Range.
Pull: All scan points of a selection which are situated betweenMinimal Distance andMaximal
Distance, are moved toward the scanner position (being the origin of the local coordinate system of the
scan) by the value that is specified in Scan > Properties > Scanner Info > Range

l Apply a white-balance

l Colorize scan points using scanner based pictures

l Export scan points into a CAD system

l Create a new scan from the selected scan points.

Selected scan points are colored yellow. There can only be one selection simultaneously in all views, in
other words, if you make a selection in one view, the selection disappears from the view worked on before.

NOTE: If you wish to select an area that you cannot see with the set line of sight, you can also switch into
navigation mode during the selection process. Simply press the control (Ctrl) key.
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Available Selection Tools in Quick View and Planar View
Click Selection in the Explore toolbar. The tools options toolbar is opened.

Select Polygon Button

1. Click the polygon tool in the toolbar.

2. Click the left mouse button to define the starting point of the selection.

3. Release the mouse button, move the mouse to the next point and click to fix the point.
A straight connection is drawn automatically between these two points.
You can also hold the mouse button down and drag the mouse over the area you want to select. Then
all the scan points that you move over with the mouse are selected.

4. Lock the selection by double-clicking with the left mouse button.

When completing the selection, the line will be closed; in other words, the last fixed point is connected to
the starting point. The selection comprises all the scan points that are enclosed within the outline.

Select Rectangle Button

1. Click the rectangle tool in the toolbar.

2. Select a rectangular area by first defining a corner of the rectangle by clicking and holding the left
mouse

3. Drag the mouse over the area that you want to enclose in the rectangle and then release the mouse
button.

Select Circle Button

1. Click the circle tool in the toolbar.

2. Click the left mouse button to define the starting point of the selection.
A circle with the radius just set is displayed.

3. Change the radius by turning the mouse wheel.

4. Click and hold with the left mouse button and drag the circle to the position you want.
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Select Ellipse Button

1. Click the ellipse tool in the toolbar.

1. Click the left mouse button to define the starting point of the selection.
An ellipse with the starting point of the major axis just set is displayed.

2. Change length of the minor axis (i.e., the width) by turning the mouse wheel.

3. Click and hold with the left mouse button and drag the circle to the position you want.

Select Line Button
A linear selection has a thickness of one point.

1. Click the ellipse tool in the toolbar.

2. Click the left mouse button to define the starting point of the line.

3. Release the mouse button, move the mouse to the next point of the line and click to fix the point.
A straight connection is drawn automatically between these two points.

4. Lock the selection by double-clicking with the left mouse button.

Planar View only: Select Poly Edge Button
Select an arbitrarily shaped area of scan points, with the polygon following the visible edge in the scan
points.

1. Click the ellipse tool in the toolbar.

1. Click the left mouse button to define the starting point of the selection.

2. Release the mouse button and move the mouse to the next point.
If you reach an edge, i.e., an area in which there is a noticeable difference in the reflection value, the
selection will automatically follow this edge. If there is no such edge, a straight connection is drawn.

3. Click to fix the point.

If you are not confident with the polygon, you can undo the last part of the polygon by backtracking it in the
opposite direction. You can always backtrack to the last fixed point.

With a right click, you switch edge detection on or off, and you can cancel the selection.
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Selecting Scan Points in the 3D View
In the 3D view, it is possible to select scan points and then apply a variety of commands to this group of
points.

l Delete a scan point selection

l Invert a scan point selection

l Export scan points into a CAD system

l Create meshes

l Send selected scan points to WebShare

Available Selection Tools in the 3D View
Click Selection in the Explore toolbar. The tools options toolbar is opened.

Select Polygon Button
The polygon selection applies to point clouds.

1. Click the polygon tool.

1. Click the left mouse button to define the starting point of the selection.

2. Release the mouse button, move the mouse to the next point and click to fix the point.
A straight connection is drawn automatically between these two points.
You can also hold the mouse button down and drag the mouse over the area you want to select. Then
all the scan points that you move over with the mouse are selected.

3. Lock the selection by double-clicking with the left mouse button.

When completing the selection, the line will be closed; in other words, the last fixed point is connected to
the starting point. The selection comprises all the scan points that are enclosed within the outline.

Select Brush Button
The brush selection can be used similar to brush tools known from 2D image processing programs. It works
with scan point clouds or project point clouds.

The brush works in three-dimensional spaces, meaning that you can use the mouse to literally paint points
which are going to be selected.
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The brush has the shape of a sphere. A transparent red circle will highlight the area where the selection
sphere is currently located.

1. Click the left mouse button to define the starting point of the selection, hold the button down to paint
the points.

2. Moving the cursor around while having the brush selector tool activated will highlight the scan points
that are currently within the selection sphere.

3. Use the mouse wheel to modify the radius of the sphere.

4. Hold the shift key to modify the sphere radius more quickly.

Inverting a Selection of Scan Points
There may be applications in which the marking of scan points is difficult or time-consuming, and it would
be much easier if you could mark those scan points you do not need.

1. Open a 3D view of a point cloud.

2. Click Selection, and choose the Select Polygon or the Select Brush selection tool.

3. Create a selection in the 3D view.

4. Scan points of a house, marked with the Polygon selection
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5. Right-click the selection, then click Selection > Invert Selection.

Your selection will be cleared and all other scan points will be selected.

Figure 10-14 Scan after using the invert function

Delete Scan Points
You can delete scan points from scans, scan point clouds, or project point clouds in the 3D view, the quick
view and the planar view.

In scan point clouds or project point clouds in the 3D view, you can also undo and redo deletions, see
below.

Option 1: Delete Scan Points from a Selection

1. Click the Selection button in the toolbar.
The Selection toolbar is shown.

2. Select a selection tool from the toolbar, e.g., Polygon or Brush .

3. Create the selection at the position you want.

4. Right-click anywhere in the work area to open the context menu.
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5. Select Current Selection > Delete Points.
The points inside the selection will be deleted.

If you select Current Selection > Invert and then select Current Selection > Delete Points, the points
outside your selection will be deleted.

Option 2: Delete Scan Points from a Clipping Box

1. Open the Clipping Box dropdown menu in the toolbar and select the clipping box option you want.

2. Create the clipping box.
While creating the clipping box, you can also decide whether you want to hide the interior or the
exterior of the clipping box.

3. Right-click into the clipping box to open the context menu.

4. Select Active Clipping Boxes and then either Delete visible points or Delete invisible points.

l Delete visible points of all active clipping boxes: All visible points of all active clipping boxes will be
deleted, regardless of whether they are inside or outside the clipping boxes.

l Delete invisible points of all active clipping boxes: All invisible points of all active clipping boxes will
be deleted, regardless of whether they are inside or outside the clipping boxes.

Undo and Redo Scan Point Deletions
You can undo and redo scan point deletions in the 3D view of a scan point cloud or a project point cloud.

NOTE: Undoing and redoing scan point deletions is not possible in the quick view, the planar view or in
the 3D view of raw scans.

You can delete scan points of more than one selection or clipping box and then undo and redo these
deletions. This also means that you can make deletions in several scan point clouds. When you go back to
an individual scan point cloud, you can still undo and redo the deletions you have made there.

For Deletions Based on Selections

Undo scan point deletions:

1. Right-click anywhere in the work area to open the context menu.

2. Select Current Selection > Undo Delete Points.
The last deletion is undone.

3. Repeat for further deletions if necessary.

Redo the last scan point deletion after an undo procedure:
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1. Right-click anywhere in the work area to open the context menu.

2. Select Current Selection > Redo Delete Points.
The last undone deletion is redone.

3. Repeat for further deletions if necessary.

For Deletions Based on Clipping Boxes

Undo scan point deletions:

1. Right-click anywhere in the work area outside the clipping box to open the context menu.

2. Select Current Selection > Undo Delete Points.
The last deletion is undone.

Redo the deletion after an undo procedure:

1. Right-click anywhere in the work area outside the clipping box to open the context menu.

2. Select Current Selection > Redo Delete Points.
The last undone deletion is redone.

Creating Scans from Selected Scan Points
If you would like to reduce scans to their important sections without losing the original data, you may select
the relevant scan points of these scans and create new scans from the selections.

1. Open the planar view or the quick view of the scan.

2. Select the scan points for which you would like to create a new scan.

3. In the context menu of the selected area, click Scan Points > Create Scan.
The following dialog opens:

Figure 10-15 New scan
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4. Assign a name.
Make sure that there is no other scan in the project that has the same name.

With a noise compression rate of 2:1 or 4:1, the number of rows and columns will be reduced accordingly.
So with a rate of 4:1, the resulting scan will only have 1/16 as many scan points as the original selection.

5. Optional but recommended: Mark checkbox Smooth to activate the smoothing filter if you reduce the
noise in a ratio of 2:1 or 4:1.

Dist. Threshold is the threshold for calculating the mean value. If the distance between the center scan
point and a scan point of the surrounding area is beyond the threshold, this scan point will not be used when
calculating the mean value. The smoothing filter never removes scan points but rather alters their respective
position.

A new independent scan is created.

Save Screenshot (3D View)
You can save the view currently being displayed, for example, to share the view or to use it as a preview for
your scan project.

1. Open a 3D view of a scan.

2. Move the 3D view until it shows the view you want to see in the screenshot.

3. Click the Save Screenshot button in the toolbar.

An information box opens, saying: “The screenshot will be saved in the structure view in the folder named
Screenshot.” (The name will be different if you renamed the folder. If the screenshots folder doesn't exist, it
will be created.)

The screenshot's name is generated automatically as Screenshot. Subsequent screenshots have a number
appended. When the screenshot is created, a child object called a Viewpoints is also created.

The screenshot image will show exactly what you have seen in the 3D view, including annotations or
measurements, scan point selections, etc.

If you want to export the screenshot to a file, right-click the screenshot and select Import/Export > Export
Picture.

Viewpoints (3D View)
Save the current camera position and line of sight as a viewpoint, so that you can return to it later. In the
dropdown menu of the Viewpoints button, you can activate the previous or next viewpoint.
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Create Viewpoint
1. Move the camera to a position that you would like to keep for later use.

2. Click the Viewpoints button . The dropdown menu opens.

3. Click Create. A little dialog opens in which you can enter a name for that viewpoint.

4. Click OK to save the viewpoint.

NOTE: You can also create a viewpoint with the by pressing hot-keys Ctrl + F2.

Viewpoints are added to a folder called Viewpoints in the structure view. Viewpoints are part of the project
and will be saved when saving.

In the structure view, you can organize the viewpoints into folders. Create new folders, and drag and drop
the Viewpoints into them.

Go to a viewpoint
In the structure view, right-click the Viewpoint, then select Activate in its context menu.

Activate viewpoints
1. Click into the 3D view.

2. Click the Viewpoints button . The dropdown menu opens.

3. Click either Locate Previous, or Locate Next.
The view will move to that position.

NOTE: All viewpoints can also be successively activated in the order of their creation by using the hot-key
F2 or in reverse order by using Shift+F2.

Mark Distance Range (Quick View and Planar View)
The scan points in the quick view and the planar view are normally displayed so that the reflection value of
a scan point determines the brightness of the pixel. You can also display the scan points so that the pixel
assumes a different color depending on the distance of the scan point from the scanner. You can also then
choose to either have all scan points in a range assume the same color or have the color reflect the actual
distance.

This type of visualization is appropriate, for example, when analyzing a scan, if it must not fall below a
certain level of precision. Generally, the quality of a scanner's distance measurement is not constant across
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the entire range but decreases as the distance increases. You can then highlight in color the range in which
the distance measurement is no longer satisfactory.

You can switch the highlighting on or off using theMark Range on/off button in the toolbar.

The colors are displayed corresponding to your entries:

l Scan points that lie close to the lower limit is colored red.

l Scan points that lie in between are colored yellow to green.

l Scan points that lie close to the upper limit is colored blue.

l Scan points lying outside this range are not colored.

Figure 10-16 Scan points colored depending on distance

You can edit layers, objects and ranges in the Visibility Settings dialog. To open this dialog,

1. right-click in the planar view.

2. Select Visibility Settings from the context menu.

Clipping Boxes (3D View)
Clipping boxes provide an easy access to areas of interest of a 3D point cloud. They allow slicing the point
cloud and clipping away specific areas which enables you to display or hide certain points of the 3D point
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cloud.

There are two types of clipping boxes:

l Clipping boxes with the points outside of the box hidden. Only the points inside the box are displayed.

l Clipping boxes with the points outside the box displayed. Points inside the box are hidden.

If you resize the clipping box to a subset of the project and you are hiding the interior or exterior, you can

toggle between clipping only points and clipping everything by clicking button .

Clipping boxes may also be used to select scan points in the 3D view to perform certain operations on these
points.

NOTE: Clipping boxes can be applied to the points of point clouds, not to the points of scans. If your scan
project contains more than one scan, register those scans first, then use the clipping boxes for the
entire scan project.
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Figure 10-17 3D view without clipping box (upper picture) and with clipping box (lower picture)

Creating a Clipping Box
1. Open a 3D view and navigate to the area of interest.

There are various ways to create a clipping box:

2. Click Auto Clipping Box to get the following options:

Figure 10-18 Clipping Box dropdown menu

Auto Clipping Box
Click the Auto Clipping Box button in the toolbar.
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The clipping box toolbar opens. For details about how to use the toolbar, refer to the section Manipulating a
Clipping Box.

A clipping box will be created close to the center of the current 3D view. The created clipping box will be
scaled so that it covers roughly two thirds of the screen.

One Click Clipping Box
1. Open the dropdown menu of the Clipping Box button and select entry One Click Clipping Box.

2. Select a point in the 3D view to determine the surface.
The clipping box will then be created with one of its faces being coplanar to the defined surface, and
with the selected point in the center. The created clipping box will be scaled so that it covers roughly
two thirds of the screen.

Three Clicks Clipping Box
1. Open the dropdown menu of the Clipping Box button and select entry Three Clicks Clipping Box.

2. Select three points in the 3D view to determine the surface.
The clipping box will then be created with one of its faces being coplanar to the surface defined by the
three picked points. The clipping box will be scaled in such a way as it exactly encloses the picked
points.

Aligned to a Limited or Unlimited Plane Object
Select New > Aligned Clipping Box in the context menu of a plane object to align a clipping box to the
object. You can mark a plane by opening the context menu of button Mark Object in the toolbar and
selectingMark Plane .

l Unlimited plane: The new clipping box will be created as a unit cube centered on the reference point of
the plane. Its faces will be parallel to the selected plane.

l Limited plane: The new clipping box will tightly enclose the boundary polygon of the limited plane.

The created clipping boxes are saved for later use and will be added to a folder ClippingBoxes in the
structure view. Those folders are added as follows:

l New clipping boxes are local, which means, they will be placed below the object the 3D view is opened
on.

l If the overall project 3D view gets opened, created clipping boxes will be global.

l In scan projects imported from earlier SCENE versions, clipping boxes will stay global.

l Operations started from a 3D view which operates with clipping boxes will use only the clipping boxes
visible in that 3D view.
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After you have created the clipping box, you can reposition and resize it.

NOTE: After it has been created, the rotation point of the view will be set to the center of the clipping box.

Creating clipping boxes does not delete any points from the point cloud. The points outside or
within the clipping box are simply hidden and may be displayed again at any time.

Deleting a Clipping Box
If you would like to have one or more of the available clipping boxes not being regarded, you can enable or
disable them or delete them from the project.

1. To delete a clipping box, right-click the clipping box either in the work area or in the structure view to
open the context menu.

2. Select menu entry Delete Clipping Box.

Visualizing Scales and Distances
SCENE allows visualizing dimensions and distances in the 3D view by displaying a customizable two-
dimensional grid.

This tool is only available in the 3D view.

The grid is a set of visible lines that serve as a visual distance reference and can be seen as a two-
dimensional ruler. The grid can be positioned anywhere in SCENE and gives a good impression of distances
and scales in the point cloud. You can attach the grid to a scan point, or with one or three clicks.

Figure 10-19 Regular grid in 3D view

SCENE User Manual
Chapter 10: Explore

SCENE User Manual (2024.0) Page 198 of 372



Figure 10-20 Polar grid in 3D view

Displaying and customizing the grid
1. Open the Grid dropdown menu and select Show Grid.

By default, the grid is located in the coordinate origin and lies in the XY plane.

2. Then, use the dropdown menu options to make your adjustments.

Figure 10-21 Grid dropdown menu
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Grid Properties
Open the Grid Properties dialog from the Show Grid dropdown menu. The dialog has different options to
set the grid properties.

Style

l The regular grid divides the space in axially parallel and evenly spaced rectangular areas. Both scales
in X and Y direction show the distance in relation to the grid’s origin.

l The polar grid consists of concentric rings and radial dividers. The concentric rings show the distance
to the grid’s origin. With the radial dividers one can estimate the angles between two points of interest.

Start/End – Define the dimensions of the displayed grid in both directions by entering a Start and an End
value.

Colors – Change the color of the lines for the two directions.

Resolution – Define the resolution of the grid by changing the distance between the displayed grid lines for
both directions.

Resolution

Increase the resolution of the grid by decreasing the distance between the displayed lines by a factor of 2.

Decrease the resolution of the grid by increasing the distance of the displayed lines by a factor of 2.

Tab Display Options

On this tab you can toggle the visibility of certain visible grid elements:

Direction X – x-axis (colored line)

Direction Y – y-axis (colored line)

Labels X – labeling of lines parallel to the x-axis

Labels Y – labeling of lines parallel to the y-axis

Primary Scale X – labeled lines of the grid in x direction

Primary Scale Y – labeled lines of the grid in y direction

Secondary Scale X – non-labeled lines visible at certain zoom levels in x direction

Secondary Scale Y – non-labeled lines visible at certain zoom levels in y direction.

Attach to Scan Point
Change the position of the grid’s origin. Pick a point in the SCENE and the grid’s origin will be moved to
that point.

Attach with One Click
Align the grid by picking one click, if the plane has an even surface.
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Attach with Three Clicks
Align the grid by picking three points, if the plane is uneven, or if you need a high accuracy. Picking three
points for planes makes sense for outdoor scans, or for a scans of an old building in which floors or ceilings
often are more or less curved.

Manipulating a Clipping Box
You can change the transformation of a clipping box by rotating, moving, or changing its size.

For this, click the clipping box in the 3D view, or click its name in the structure view. A floating tool bar
will appear which provides the manipulation functionality.

Figure 10-22 Clipping Box toolbar

Scale button

Figure 10-23 Resizing a Clipping Box

1. Select the Scale button from the clipping box toolbar to resize the clipping box.
Handlers will appear on the clipping box allowing you to resize it.
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2. Drag one of the red, blue or green handlers to resize the clipping box.
The corresponding face of the box will move.

3. Drag the gray cubes at the corners to resize the clipping box proportionally.

When dragging one of the handlers, the length of the movement will be indicated in the view as shown in
the picture below.

Figure 10-24 Length of movement

Rotate button

Figure 10-25 Rotating a Clipping Box

1. Select the Rotate button from the clipping box toolbar to rotate the clipping box.
Handlers will appear on the clipping box allowing you to rotate it around different axes.
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2. Drag one of the red, blue or green handlers and rotate the clipping box along the corresponding axis.

Move button

Figure 10-26 Moving a Clipping Box

1. Select theMove button from the clipping box toolbar to move the clipping box.
Handlers will appear on the clipping box allowing you to change the position of the box.

2. Drag one of the handlers (white arrows) and move the clipping box within two dimensions.
The dimensions depend on the used handler. You may also use the keys 2, 4, 6 or 8 on the number pad
instead.

You can change the size of the handlers with the number pad + key (increase size) and - key (decrease size).

You may undo (and reapply) your transformation changes with the following buttons of the clipping box
toolbar:

l Undo the last transformation change with

l Redo the last transformation change with

l Restore the initial transformation of the clipping box with
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Hiding and Displaying Points by Means of Clipping Boxes
Click button Hide in the clipping box toolbar to select which points should be displayed.

l Hide exterior: Hide the points outside the selected clipping box. This is the default setting.

l Hide interior: Hide the points inside the selected clipping box.

This does not have an effect on the visible objects in the 3D view.

If you resize the clipping box to a subset of the project and you are hiding the interior or exterior, you can

toggle between clipping only points and clipping everything by clicking button .
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Figure 10-27 Exterior hidden (upper picture) and interior hidden (lower picture)

Depending on this setting, the boundaries of the clipping box as well as the icon in the structure view will
be displayed in different colors:

l transparent blue when the exterior is hidden.

l transparent orange when the interior is hidden,

This setting will be saved in the clipping box properties for later use and may also be changed in the
Properties dialog.

Working with Multiple Clipping Boxes
You can combine the point visibility settings of several clipping boxes. For this, the following rules apply.

Adding a clipping box with Hide Exterior enabled to already available and active clipping boxes:

l The points inside this box will always be added to the currently visible points, even if this box intersects
with boxes that have the interior hidden.

l The points outside this box will not be hidden. In that case the clipping settings of the already available
clipping boxes have the precedence.

Adding a clipping box with Hide Interior enabled to already available clipping boxes:
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l This will cut out the points that are inside this box from the points that are visible at that time, even if
this box intersects with boxes that have their exterior hidden (and the interior displayed).

l The points outside this box will not be displayed. In that case the clipping settings of the already
available clipping boxes have the precedence.

The order of creation of the clipping boxes thus matters and has an effect on which points are displayed.

Example: You want to show the motor of the car. For this, you use a scan in which the hood is opened:

Figure 10-28 Example: Complete point cloud

Now you add the first clipping box around the car that has its exterior hidden (clipping box 1).
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Figure 10-29 Example: First Clipping Box with hide exterior added

All the points outside the clipping box are now hidden, only its interior is displayed. Now you would like to
remove the hood because it disturbs the view. So you add a new clipping box with hide interior enabled
(clipping box 2).
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Figure 10-30 Example: Second Clipping Box with hide interior added

The points within clipping box 2 are now hidden. But now you would like to hide the points of the two front
fenders. So you add two new clipping boxes but this time with hide interior enabled (clipping boxes 3 and
4).

Figure 10-31 Example: clipping box 3 with hide interior added

The points in the overlapping areas between clipping boxes 1 and clipping boxes 3 and 4 are now removed.
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Figure 10-32 Example: Result with hidden clipping boxes

Deleting Points by Means of Clipping Boxes
You may delete points of all active clipping boxes. For further information, see Delete Scan Points.

Enabling and Disabling Clipping

Click button Enable/Disable Clipping in the clipping box toolbar to enable or disable the clipping of the
selected clipping box.

When disabled, the points hidden by this box will be displayed again. The color of the clipping box
boundaries and its icon in the structure view change to gray.

This option is also available in the context menu of the clipping box in the structure view.
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Figure 10-33 Disabled Clipping Box

This setting will be saved in the clipping box properties for later use and may also be changed in the
Properties dialog.

Toggle Application of Clipping Boxes Button

Click button Toggle Clipping Boxes in the 3D toolbar at the bottom of the screen to enable or disable
clipping of all available clipping boxes globally.

This setting will not be saved in the properties of the individual clipping boxes.

Toggling the Visibility of Clipping Boxes
Toggle the visibility of a clipping box as follows:

l With the Clipping box visibility button in the clipping box toolbar

l In its context menu

l In its properties dialog

Disabling the visibility of a clipping box will only hide its boundaries. The clipping box is still active (if
clipping is enabled) and it still has effect on the visibility of the points in the 3D view.
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Creating Multiple Clipping Boxes Along an Axis of an Existing
Clipping Box
You can create multiple clipping boxes along one of the three axes of an already available clipping box
which also serves as a template for the new clipping boxes. This allows slicing the point cloud into specific
areas of interest and can be a useful feature, for example to divide a building into its several floors.

Do the following to create multiple clipping boxes along an axis of an already existing clipping box:

1. Open the 3D view.

2. Navigate to the clipping box which should serve as the template.

3. Check if this clipping box has the clipping mode Hide Exterior.
If not, select Hide Exterior, see Hiding and Displaying Points by Means of Clipping Boxes.

Figure 10-34 Clipping boxes along an axis – Hide Exterior

4. Right-click this clipping box to open the context menu and select Create Clipping Boxes along an
axis.
Two new clipping boxes will be displayed according to the default settings.
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Figure 10-35 Clipping boxes along an axis – Preview

5. Enter your settings in the dialog.
In our example, there should be a clipping box for the front part, for the middle part, and for the rear
part of the car.

Figure 10-36 Clipping boxes along an axis – Settings dialog

Axis

Select the axis of the existing clipping box along which the new clipping boxes will be generated. A
preview of the new clipping boxes will be available in the current 3D view.

Disable Clipping
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Disable clipping in the preview.

Sign of Axis

Select the direction of the axis in which the clipping boxes will be created.

Number of Clipping Boxes along axis

Define the number of clipping boxes to be created.

Space between boxes / Space between box origins

The distance between the clipping boxes. There are two ways to define the distance, either between the
origins of the clipping boxes or between the adjacent faces of the clipping boxes.

6. Click OK to create the clipping boxes with the selected settings.

Figure 10-37 Clipping boxes along an axis – preview

The initial clipping box will be moved to the new clipping box folder and will be renamed according to the
folder’s name. The other clipping boxes will get the name of the folder and a number. The clipping boxes
will be surrounded by the so-called Clipping Box container.
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Figure 10-38 Clipping boxes along an axis, with Clipping Box container

Working with Clipping Box Containers
A clipping box container contains all the clipping boxes which were created along an axis of an existing
clipping box. It has a transformation which consists of scale, rotation and translation.

You can rotate, move, or resize a clipping box container similar to a clipping box.

Figure 10-39 Clipping box container with resize handlers

These transformation changes will be proportionally applied to the clipping boxes within the container.

If required, you can change the size of the clipping boxes inside the clipping box container. It is no longer
possible to rotate one of the clipping boxes, nor is it possible to move one of the clipping boxes to the
outside of the clipping box container.
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NOTE:
All clipping boxes within a clipping box container have constrained functionality:

l The single clipping boxes cannot be rotated individually.

Their clipping mode cannot be changed.

l The single clipping boxes cannot leave the volume of the clipping box container.

l You can change the visibility of the clipping box container and the clipping boxes in the
container with the Clipping box visibility button in the clipping box toolbar or in its
context menu.

l Any transformation of the clipping box container will transform the single clipping boxes.

l The visibility state of the clipping box container is a global state and not view-specific.

Figure 10-40 Resizing the Clipping Boxes inside the Clipping box container

Exporting Scan Points by Means of Clipping Boxes
You may also export 3D points into different file formats using the active clipping boxes.

1. Right-click the 3D view, or,

2. Right-click a clipping box to open the context menu and select entry Active Clipping Boxes > Export
3D Selection.

SCENE will then create a 3D selection and export the selected points afterwards.
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Additionally, you may export the points in a local coordinate system defined by one of the available
clipping boxes. For this, select Use Local Coordinates in the export dialog and select the clipping box from
the list.

NOTE: Only the points of point clouds will be exported. The Export menu shows the Color/Gray option
as well as the Full scan option grayed out, because they don't make sense for a point cloud.

Meshing (Planar View and 3D View)
This section describes how to use the meshing feature in SCENE.

What is a Mesh?
When an object is scanned, the scan points represent individual spots on the surface of the object. If you
want to reconstruct the surface itself, you can create a mesh which takes the scan points as a basis and
approximates the surfaces within certain limits.

NOTE: Creating a mesh for a very large object (for example, a building) may not produce satisfactory
results. Create several smaller meshes of the various parts of the large object, instead.

The approximation of the scanned surfaces is done with a set of triangles.

Depending on the curvature of the real surface and the required approximation quality, the number of
triangles can vary between a few and a huge number.

Making Your Mesh Watertight
To print a 3D model with a 3D printer, the 3D model must not have any gaps. The 3D model must have a
solid volume, it must have a solid surface without gaps. A commonly used term for this is watertight.

Creating a Mesh in Planar View

NOTE: Meshes created in the planar view do not have the same quality as meshes created in the 3D view.

1. Create a 2D selection as described in Selecting Scan Points in the Planar View or the Quick View.

2. Right-click the selection, then click Current Selection > Mesh. Doesn't exist --> Context menu Create
objects > Mesh, node is created but can't be opened.
The Mesh Generation Parameters dialog is shown.

To create a mesh in planar view, select the Mesh Generation Parameters in the following dialog:
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Figure 10-41 Mesh generation parameters
2nd level simplification: Activate 2nd level simplification based on the distance between scan point and
nearest triangle.

Distance threshold: A triangle approximates all scan points within this distance threshold. The smaller the
value, the more triangles you’ll get.

Activate triangle removal: If an object is in front of a different object, neighboring scan points shouldn’t
be connected by triangles. Here you can activate the removal of triangles which match both of the following
requirements.

Angle below: The angle between the scanner and the surface of the triangle. The larger the value, the more
triangles will be removed.

Edge length above: The edge length of the triangle. The smaller the value, the more triangles will be
removed.

Although the resulting mesh may be a relatively small collection of triangles, its appearance can show more
details. This is done by a texture, which is similar to a photo glued onto the triangles. By default the display
contains textures.
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Figure 10-42 Mesh without and with texture

Creating a Mesh in the 3D View

Figure 10-43 Meshing Object

NOTE: Meshing in the 3D view is only available for point clouds. For information about creating point
clouds refer to topic Processing on page 99.

There are two methods to create a mesh:
Mesh Selection: You can make a freehand selection of scan points.

Mesh Clipping Boxes: You can use one or more clipping boxes to select what you want to be meshed.

Meshing a Selection
1. Create a 3D selection as described in Selecting Scan Points (3D View, Planar View, Quick View) on

page 183

2. Click the Mesh dropdown menu and selectMesh Selection.
The Create Mesh – Settings dialog is shown. You can also right-click the selection, then click
Selection – Mesh Selection.
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Mesh Clipping Boxes

Figure 10-44 Object selected with a Clipping Box

1. Create and adapt one or more clipping boxes around the object as specified in Creating a Clipping Box.

2. Click the Mesh dropdown menu and selectMesh Clipping Boxes.
The Create Mesh Settings dialog is shown. You can also right-click the clipping box, then click
Active Clipping Boxes > Create Mesh.
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Settings

Figure 10-45 Create Mesh Settings

Mesh Name
Specify a name for the mesh.

Gap Filling
Watertight (3D Print Ready)

Select this option if the mesh will be used for 3D printing. The mesh will then be generated “watertight”,
which means, it has a solid surface.

Non-Watertight Mode

Select this option if the mesh will not be used for 3D printing.

Slider – Meshing Mode
The slider in theMeshing Mode box, allows closing holes and expanding the mesh beyond the points. This
option is available when Non-Watertight mode is selected.
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Smoothing
Perform Smoothing

Select this checkbox to apply a post-processing operation to make the mesh smoother.

Slider – Smoothing

The slider in the Smoothing box allows making mesh smoother.

The higher the slider value, the smoother the mesh will be.

Color Generation
You can color the mesh as follows:

Generate Texture

This creates color in the texture by applying a graphic file to each triangle. It is the method supported by
most 3rd-party software products and will likely have the best results.

Generate Vertex Colors

This method creates color in the texture by applying color information to the vertices in the mesh.

Maximum Number of Triangles
Slider – Maximum Number of Triangles

The slider under this category allows you to control how many triangles will be created in the mesh, if non-
watertight mode is active.

If you know the maximum number of triangles which your software is able to process, enter this number.
Otherwise, the default value is recommended.

Mesh Optimization
Geometry vs. Vertex Colors

Geometry is selected by default if you have selected Generate Texture. If you have selected Generate
Vertex Colors, choose Geometry if you want the mesh to have the most accurate shape even at the expense
of color. Choose Vertex Colors if accurate color is more important.

Create
Click the Create button to start the mesh creation. The created mesh will be added to the structure view and
displayed in the opened 3D view. It is also possible to open a 3D view on the mesh, through the context
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menu.

Mesh Properties
You can review the mesh properties by right-clicking the name of the mesh in the structure view and
selecting Properties. The surface area of the mesh is calculated by taking the sum of the surface area of all
the triangles in the mesh.

Figure 10-46 Mesh Properties Dialog

Manipulating a Mesh
A mesh can be moved to a different orientation or placement within the 3D view.

Select a mesh (or a folder containing only a mesh) while a 3D view is open, and a 3D manipulator appears
at the center of the selected object in that 3D view. This manipulator lets you modify the local
transformation of that object by rotating or moving it. Click and drag on the colored circles to rotate the
mesh, or the arrows to move it. Immediately after modifying the position of the mesh, a small toolbar

appears near the mouse: . With this toolbar you can step forwards and backwards through the
recent orientations, or undo them all.
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Figure 10-47 Meshed Clipping box with Handle and toolbar

NOTE: Because legacy meshes imported from VRML files don't have transformation attributes of their
own, you may only move them by selecting their containing folder and using its manipulator.

Colorizing Scan Points
Besides the distance information, a scan may also contain information about the reflectance or even the
color of the individual scan points.

By default, SCENE loads the color information whenever it is available. But sometimes it is useful to load
the scan with its original gray value. You can achieve this when you change the corresponding setting under
Settings > Views > Planar/Quick View > Scan Data Load Behavior and then either Color or Grey
(Intensity).

Color information can be added to a scan after the scan has been taken.

If you have a scan taken by a scanner with the color option, this scan will also contain the digital pictures
which the scanner took automatically during the scanning, see Colorizing Using Scanner Based Pictures.

If you don’t have such a scan, you can still add color information if you have taken digital pictures of the
scanned environment, see Colorizing Using Additional Pictures.

To add the color information of digital pictures to the scan, some prerequisites must be matched:

l The digital picture must be free of any distortions caused by the lens. Especially wide-angle lenses tend
to cause so-called barrel or pin-cushion distortions. In a picture with such distortions, a straight line
doesn’t appear straight but bent.

l Position, orientation, and zoom factor of the camera must be known or must be computable.

In addition, you can enhance the color overlay and enhance the white balance of pictures.

Colorizing Using Scanner Based Pictures
The scanner based pictures are stored within the scan and are visible in the structure view.
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Figure 10-48 Scan with pictures

Colorize One Scan
1. In the Structure view, right-click the scan and select Operations > Color/Pictures > Apply Pictures.

This will open the scan and all its pictures.

Then, it will remove any distortions from the pictures. Finally, it will add the color information to the scan
points.

2. Save the scan afterwards by clicking the icon in the Workflow bar.
This is not done automatically.

Colorize All Scans in a Scan Folder
In the Structure view, right-click the scan folder and select Operations > Color/Pictures > Apply Pictures.

In this case, the scans are saved automatically afterwards if you have the correct setting of Save modified
scan points.

NOTE: If you get an out of memory error during applying the pictures, you should check the Colorize all
scan points option under Tools > Options > Scan Data. If it is switched off, switch it on and try
again. If you want to colorize raw scan data (raw scans that have not yet been loaded in SCENE,
manipulated and saved again), the original gray values of these scans will be overwritten by the
color information. The gray values get lost. SCENE will inform you before that happens. It is
recommended to load the raw scans at least once and save them afterwards. For example, this will
be done if you apply the recommended standard filters to the scans while preprocessing the scan
data with the preprocess option.

Export pictures
If you want to manipulate the taken pictures with a professional graphics editing program before applying
them to the scan, you can export them to your hard drive.

In the structure view, right-click the scan and select Operations > Color/Pictures > Export all Pictures.
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This will open a dialog to select the storage location and to select the export format of the pictures.

Figure 10-49 Export all pictures

Original format will export the pictures without changing their format. JPG will export them in JPEG-
format, PNG in Portable Network Graphics format.

Colorizing Using Additional Pictures
As mentioned above, you can also use your own additional pictures, but then you must perform additional
tasks to meet the prerequisites.

The most important requirement is that the picture is free of distortions. It is not recommended to use
pictures with visible distortions, as these will be mapped onto the scan and will result in a confusing visual
impression. You can avoid these distortions if you use high quality lenses.

The position, orientation, and zoom factor of the camera can be calculated by the software. All it needs are
at least 6 pairs of matching points in the scan and in the picture.

1. In the structure view, right-click the scan or a picture within a scan, and select Operations >
Color/Pictures > Colorize Scan.
The Colorize Scan dialog is shown.

Figure 10-50 Colorize scan
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Colorize Scan
2. Select the picture to be used.

Use the Browse button to look for the picture in the file system.

3. Press Add to add it to the scan.

Alternative Picture Selection
When you start Colorize Scan on a picture within a scan, you don’t have to browse for the picture and add
it to the scan.

1. Open a planar view of the scan.

2. Press View in the Colorize Scan dialog to open a view of the picture.

3. Press Select to find the pairs of matching points in both, the picture and the scan.

Select Matching Scan Points
4. Select at least 6 pairs of matching points.

The selected points are displayed in the Colorize Scan dialog.
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Figure 10-51 Selecting pairs of matching points

You can select the points in any order you want. You can first select all points in the planar view of the
scan, then in the picture view, or vice versa. Or select the points pair by pair, changing back and forth
between the planar view and the picture view.

If you want to modify the selection, you can change the sequence of the points, re-assign it, or delete a pair.
Simply right-click the point in the corresponding table of the Colorize Scan dialog, and select the
appropriate command.

Figure 10-52 Context menu: Matching points

NOTE: Make sure to cover all 3 dimensions! The points should not lay more or less on a plane, but should
span a box with reasonable length, width, and depth.

It’s always good to have some redundancy and to select more than 6 pairs.
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5. When you’re done with the selection, press Apply or OK.

Now the software will calculate the position, orientation, and zoom factor and will then add the color
information to each scan point.

You must open a new view to see the scan in color. The already open planar view of the scan will not
change.

The Colorize Scan dialog will display information about the quality of the projection by calculating the
mean distance between the 2D projection of the selected 3D points and the corresponding points that have
been selected in the picture. This distance is called projective deviation (2D) and is measured in pixels.

If you are not satisfied with the results, you can adjust some of the selected points and try again. You can
also export the list of selected points to a file and continue the work the next day.

6. Save the scan.

Enhancing the Color Overlay
As soon as the scans have been colorized, you may want to enhance the color overlay of the scans. You can
do this automatically with the built-in color contrast filter or manually by manipulating the color overlay
with a professional graphics editing program.

Color Contrast Filter
The color contrast filter automatically enhances the dynamic range of the scan’s color overlay. To apply the
color contrast filter to a single scan or to all scans within a scan folder, execute the command Operations >
Color/Pictures > Color Contrast Filter in the appropriate context menu.

Figure 10-53 Colored scan points without color contrast filter
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Figure 10-54 Colored scan points with color contrast filter

Manually edit the color overlay
To manually edit the color overlay of a scan, you may export its color overlay as a picture to your local hard
drive, manipulate this picture in any way with a professional graphics editing software and then replace the
initial color overlay of the scan with the manipulated picture.

Export color overlay
To export the color overlay of an already colorized scan as a picture:

1. Select Operations > Color/Pictures > Export Color Overlay in the context menu of the scan.

2. Save the color overlay to your local hard drive.

3. Manipulate the exported color overlay.

4. Select Operations > Color/Pictures > Replace Color Overlay to replace the initial color overlay of
the scan with the manipulated picture.

The color overlay can be replaced with a picture in JPEG (.jpg), Bitmap (.bmp) or Portable Network
Graphics (.png) format. Makes sure that the manipulated picture has the same pixel resolution as the initial
one.

White Balance
Scans may appear with biased colors when they were recorded under certain lighting conditions.

The White Balance function offers the possibility to select a scan point of which you know that, in reality, it
has a white color.

SCENE will then adjust all colors of the scan according to this setting.
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NOTE:White balance is available in planar view, quick view and 3D view. For 3D view, a scan point
cloud is required.

1. In the structure view, right-click the scan, then click Operations > Color/Pictures > White balancing.

2. Click a scan point which should be displayed in white color. If the currently shown view is not
suitable, you can rotate the scan by pressing the Ctrl key and clicking the scan.

SCENE will now use a sphere-shaped selection around the selected scan point to adjust the colors.

Figure 10-55 Scan before using white balance

Figure 10-56 Scan after using white balance

SCENE will ask you whether you are satisfied with the result. If you do not like the result, click the No
button, and the settings will be undone.
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Virtual Scans (3D View)
For technical reasons, hand-held scans cannot be displayed as a Panorama View in WebShare. They must be
converted to so-called virtual scans first and can then be uploaded.

Virtual scans are created from the point cloud data of already existing scans. After the virtual scans were
created, they behave like scans which were recorded with a laser scanner.

You can open a virtual scan in

l quick view,

l planar view, and

l 3D view.

You can export a virtual scan as

l an image,

l as an object,

l as scan points, and

l as a new scan project.
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1. Click the Create Virtual Scan button in the toolbar. The Create Virtual Scan dialog is shown:

Figure 10-57 Create virtual scan dialog

Name

Enter a name for the virtual scan.

Resolution

Set the resolution with the slider. The first number corresponds to the number of columns, the
second number for the number of rows.

Point interpolation

Select, if the virtual scan shall include interpolated points.

2. Click the OK button to start the creation of the virtual scans. A folder named VirtualScans will be
created which contains the virtual scans.

Create PanoCam Scans
When you use a PanoCam with the FARO Focus Laser Scanner, SCENE provides an option to create a
photo-realistic spherical visualization of the scans by creating so-called PanoCam scans. You can use them
in SCENE, WebShare Cloud, SCENE 2go and ReCap. PanoCam scans enable creating virtual tours where
you can measure objects and scan points as well as add annotations. They are independent of the scan
resolution.
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Figure 10-58 Before and after creating a PanoCam Scan

General Information on PanoCam Scans
l The First PanoCam Picture is used to create the PanoCam scan.
Note that points hidden by the scanner cover are not included in the PanoCam scan.

l The minimum resolution is the PanoCam resolution (8000x4000) not the original scan's resolution.
If the original scan resolution is higher, the PanoCam resolution will also be increased.
If the original scan resolution is lower, some points will be interpolated.

l The original scan metadata is transferred to the PanoCam scan.

l PanoCam scans contain intensity and color.

NOTE: Some hidden areas may not be colorized correctly. Created PanoCam scans cannot be read by
SCENE versions older than 2023.0.

Create PanoCam Scans at Processing
If you want to create PanoCam scans at processing, go to the Processing Settings and activate checkbox
Create PanoCam Scans.
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Figure 10-59 Processing Settings

If you mark this checkbox, PanoCam scans will be created for every stationary scan whose color was
captured with the PanoCam. As a result, after processing, only the PanoCam scans will remain in the
project.

Recommended Workflow 1
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Create PanoCam Scans after Registering and Cleaning Scans
1. Right-click a scan or a cluster containing scans that were taken with the PanoCam.

2. In the context menu, select entry Operations > Create PanoCam Scan.
The PanoCam scan is created in the project. In the structure view, they are at the same level as the
previously selected scan or cluster.

This procedure also works in calibration scans.

Note that the original scans and the PanoCam scans exist in the project. Consider deleting the original scans.

Recommended Workflow 2

Working with the Project Point Cloud
Like the scan point clouds, the project point cloud is optimized for fast visualization of large amounts of
scan points in the 3D view. It is organized in a spatial data structure that facilitates fast visualization of the
scan points. The project point cloud consists of the points of all the scans within your scan project.

For this reason, the amount of points in a project point cloud can be enormous. Unlike scan files, such large
amounts of points cannot be loaded into a physical memory at once. Therefore, the points of the project
point cloud are automatically loaded and visualized on demand based on the camera position and point
visibility. This allows you to actually see all scans of a scan project at once, regardless of whether or not
they fit into your computer’s physical memory. Manual scan file loading is not necessary.

The project point cloud is the best way to visualize and manipulate enormous amounts of scan data
interactively. here can only be one project point cloud per project.

You can:

l Create a project point cloud

l Update a project point cloud

l Delete a project point cloud

If your project has a project point cloud:
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1. Open a 3D view with the View Project button from the toolbar, or

2. use View > 3D from the context menu of the project folder.

3. Start exploring.

As the point cloud visualization technique is constantly loading scan points from the hard disk drive based
on point visibility, the overall performance strongly depends on the speed of your hard disk drive. While
project point clouds outperform all other visualization methods (including scan point clouds) on regular hard
disk drives, we recommend using a solid state drive for maximum performance. Using a solid state drive
will also speed up the process of creating the project point cloud.

Creating the Project Point Cloud
The project point cloud is typically created from all the single scans in your project after they have been
processed and registered.

1. Open the scan project from the Project Overview, or by clicking the Open Project button in the
Project toolbar.

2. Click the Explore button in the workflow bar.

3. Click the Project Point Cloud button in the toolbar. A dropdown menu opens.

4. Select Create .

Preparing your Scan Project
The resulting point cloud is about two to four times the size of your scan files. SCENE will create large
amounts of temporary data during point cloud creation, which will be deleted after the point cloud was
successfully built. The amount of space needed for the temporary data during the point cloud creation
process can be up to seven times the size of the original scan data. The actual amount of temporary data and
the size of the project point cloud strongly depend on the point data itself and cannot be safely predicted
beforehand. Make sure to have enough free space on your target hard disk drive (the location of your scan
project) and in the location of the temporary data folder when creating project point clouds. The temporary
data folder can be changed in the Settings.

NOTE: Project point cloud creation will only consider the global position of the scan points at the time of
the creation. All changes to scans, clusters, or folders that are performed after the project point
cloud has been created will not alter the project point cloud. This will lead to an inconsistency
between the point cloud and the traditional scan-based data of the scan project. For this reason, we
recommend creating the project point cloud after you have completed the registration.

You can, of course, change your registration at any time, even if a project point cloud already exists, but be
aware that the project point cloud will not have these changes applied until it is updated or recreated.
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Project Point Cloud Creation Settings
After you have initiated the project point cloud creation, the point cloud settings dialog shows up:

Figure 10-60 Create project point cloud settings

Filter
For the creation of the project point cloud, the following point filters are available. Each of these filters will
reduce the overall point count by eliminating different types of (unwanted) points.

Eliminate Duplicate Points
The filter removes duplicate points that always exist when points are recorded from several different scanner
positions. Overlapping areas can be optimized by removing some of the duplicate points. This filter can
improve the visual quality of your project point cloud significantly while reducing overall point count and
therefore improving interactivity and loading times of the point cloud.
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Points are considered duplicates of others when they were recorded from different scanner positions and
their 3D positions are similar. The actual distance threshold for duplicate points depends on point-to-scanner
distances. The farther from the scanner a point is recorded, the “larger” we consider this point to be, because
the farther a point is recorded, the greater the spatial distance to its neighbors.

The filter is configured to always keep the highest quality point. Higher quality means smaller distance to
the scanner position. If two points are considered duplicates of each other, the point with the greater distance
– and therefore lower quality – is dismissed. Only the higher quality point is added to the project point
cloud.

When creating a project point cloud from a project that contains both, laser scanner scans and hand-held
scans, all points are considered. Usually, hand-held scanner points are used only where no laser scanner
points are available.

With the Search Radius slider you can adjust the distance threshold for point elimination. The default
setting should be sufficient for almost all scenarios.

Adjust the Search Radius slider to the right to enlarge the search radius and increase the number of
eliminated points. This may help to reduce point count when your registration is not very accurate (for
example when using natural targets only).

Adjust the Search Radius slider to the left to reduce the number of eliminated points. This can be useful if
too many points have been deleted by this filter in previous point cloud iterations.

Close Surfaces
Select this checkbox if you want to have additional points interpolated between original scan points, to
create a denser impression of the surfaces. The color or gray value of these additional points will also be
interpolated.

NOTE: Scans captured using FARO hand-held scanners are interpolated immediately after they are
captured (if the appropriate option was enabled during capture). No additional interpolation is
performed for these data sets during project point cloud creation. Nevertheless, you need to select
this option to get a closed surface representation of your data. If you don’t, points of hand-held
scans are stored with smaller sizes.

Full Color Detail

Select this option if the color of the points shall be retrieved from the laser scanner's high resolution camera
images. Moreover, additional even smaller points are interpolated to transfer the color information from the
camera images into the point cloud. By using the images from the camera images, smearing effects are
reduced and more color details are visible in the project point cloud.

NOTE: The time needed for the interpolation and the creation of the point cloud will greatly increase. The
files will need much more disk space.

Homogenize Point Density
This filter balances the density of points within the point cloud by reducing the number of points in areas
where the average target density is exceeded. This is especially the case close to scanner positions, where
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the point density is particularly high or in areas where two or more scans overlap. By reducing the total
number of points in the point cloud, less hard disk space is required and the performance of the point cloud
visualization is increased, while preserving the overall visualization quality.

The achievable rate of data reduction is highly dependent on the input data. Outdoor projects with little
overlap between scans will benefit less than densely scanned indoor projects where a data reduction of 25%
and more can be achieved with hardly any perceivable loss of visualization quality.

Cell size

You can adjust the cell size of the existent homogenization feature. The standard value of 1.5 mm was
empirically chosen so that no band artifacts emerge. The unit of the maximum distance is adapted according
to the setting of the small standard units. The homogenization and Close Surfaces are mutually exclusive,
which means that setting the Close Surfaces will unset the homogenization checkbox and vice versa.

Apply Color Balancing
A typical effect seen in real world laser scanning projects is that the overall perception of color may not
always be consistent across colored scans. This effect can have two different reasons:

l The internal camera of the FARO Focus Laser Scanner performs white balancing on a per-scan basis. As
a result, the internal camera may choose to apply a different white balancing at different scan positions,
given that the lighting conditions vary. For example, the scanner is set up in a room illuminated by neon
lights as opposed to natural light when scanning outdoors.

l While carrying out a scanning project, lighting conditions may vary over time. For example, when the
project starts in the morning and is completed in the evening (or even on another day).

This effect may especially become apparent when such differently colored scans are combined into a project
point cloud and visualized together as shown in the following figure:
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Figure 10-61 Inconsistent color of a floor due to scans taken under varying lighting conditions.

When enabled, the color balancing filter minimizes the color contrast between scans in the project point
cloud and results in a more homogeneous overall perception of color as shown in the following figure:

Figure 10-62 Significant reduction of color inconsistencies by applying color balancing
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Distance Filter
If this checkbox is set, all points which are more thanMaximum Distance units away from the associated
scanner position will not be used to create the project point cloud. This filter can be used to restrict the point
cloud to the more precise near the area of the scanner. For example, if you scan a windowed room, you can
now ignore most outside stray points, which are probably bad, because they were scanned through the
window glass. The unit of the maximum distance is adapted according to the setting of the standard units.

Temporary Data Folder
During the project point cloud creation process all scans in the project will be loaded successively; their
point data will be processed and saved as temporary data. This temporary data will be stored inside the
temporary data folder. Do not delete, move or copy any of these files during the point cloud creation process
or the process might fail. The temporary data will be deleted automatically after the process is complete.

Section Disk Space shows if there is enough free space on the hard disk used for the temporary data and the
(target) hard disk used for saving the final point cloud data. The target hard disk is the disk on which the
scan project data is stored.

Updating the Project Point Cloud
The project point cloud can be updated to make changes such as deleted points or scans persistent. When
points are deleted or scans have been removed from the scan project, they are not deleted from the point
cloud but rather marked as removed. The point cloud will no longer visualize these points; they are filtered
out during the point loading process. Unfortunately these filter operations will slow down the process of
point loading. This may not be noticeable for only a few delete operations but as you work with your point
cloud, deleting more and more points over time, you might notice a decrease in performance. When this
happens, the project point cloud should be updated.

1. Click the Project Point Cloud button in the toolbar.
A dropdown menu opens.

2. Select Update .

3. In the dialog that appears, confirm that you want to update the project point cloud.

Update When Saving the Project
In the Share Changes dialog, mark the Update Point Cloud checkbox.
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Figure 10-63 Share changes

This way the project point cloud will be updated automatically after the sharing and saving operation is
complete.

After the update has been initiated, you are asked to specify the same parameters as for the initial creation of
the point cloud. If point filters where enabled during its creation, it is not necessary to apply them during
updating again since the resulting points will just be the same (and the updating will also take longer
without any visual benefit).

Deleting the Project Point Cloud

1. Click the Project Point Cloud button in the toolbar. A dropdown menu opens.

2. Select Delete .

Visibility Settings
The views can also show objects other than the scan points, such as:

l The positions of the other scans in the project.

l The simple objects assigned to a scan that were created by a fit, for example spheres, and 3D points.

l CAD models.

Not all views can display all these objects. For further information, see the more detailed description of
views.

You can decide whether to display the objects using the visibility settings, which are arranged in three
levels:

l The visibility of the layer to which the object is assigned.

l The visibility according to the prominence of the object.
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l The distance of the object from the observer.

An object is only visible if the visibility on the first two levels is set accordingly and it is located in the set
range.

The visibility settings are maintained separately for each view. It is therefore possible that an object is
visible in one view and not in another. When you open a new view, this view initially takes over the default
values of the visibility settings. You can also change these default values.

Right-click in a view in the work area, then select Visibility Settings. The Visibility Settings dialog is
displayed.

Figure 10-64 Visibility settings –view

View (3D View only)

NOTE: If Auto apply changes is selected, new settings are visible immediately; you do not need to click
the Apply button.

Quality Settings – Determines the image quality while moving.
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If the handle of the slider is moved to the left, the quality of the rendering is reduced during movement in
favor of performance.

If the handle of the slider is moved to the right, the quality increases and the performance decreases. If the
handle of the slider is moved completely to the right, there will be no quality penalty during movement.

Clear View Settings – In the clear view mode, points in areas with low point density will be displayed
more transparently and points in areas with a high point density will be displayed more brightly.

Enable Clear View – check if you want to use Clear View. By changing the settings with the slider you can
intensify or weaken this effect.

Gap Filling – The gap filler fills gaps between scan points that are physically close to each other.

Figure 10-65 Gap filling turned off (left) and turned on (right)

NOTE: If clear view and gap filling are grayed out, Offscreen Rendering under Tools > Options > View
might be disabled. Offscreen Rendering must be enabled for Gap Filling and Clear View.

Supersampling – renders the point cloud with a resolution higher than the resolution of your screen and
then shrinks the point cloud to fit the screen resolution. This reduces anti-aliasing effects and gives the point
cloud a smoother visual appearance. Fine and filigree structures look sharper and stray points will appear
less annoying. Set the resolution of the initially rendered point cloud compared to the screen resolution by
selecting one of the options 2x2, 3x3, or 4x4. For example, choosing 2x2 means that the point cloud will be
rendered with a resolution that is 4 times the resolution of your screen.

Figure 10-66 Supersampling turned off (left) and turned on (right)

NOTE: Objects like walls might appear transparent when using small point sizes in combination with
supersampling. High supersampling resolutions like 4x4 require large amounts of graphics card
memory.
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Coloring
The coloring tab lets you set values that are used in coordinate coloring. For more information, see
Coordinate Coloring.

Reference Object: Reference is the object used as a reference for coloring x, y, z, xyz, and distance. The
reference object can be scan origin, clipping box, or marked point. If you choose custom, you can define the
reference origin to be anywhere, even where no point exists. Default is currently (0 ,0, 0) for x, y, z, xyz,
and camera position for distance coloring.

Reference Origin: Only active if you selected custom as your reference origin.

Coloring Ranges: Minimum and maximum values are required in order map the data to colors. A larger gap
between the minimum and maximum value makes the bands of color larger. Points outside the minimum
and maximum are colored the same as minimum and maximum.

Use active clipping boxes: Creates a temporary clipping box that is large enough to contain all the clipping
boxes that are active in the project, then sets the origin and ranges to apply coloring within the confines of
the new clipping box.

Blend point color with coloring: The original colors of the scan points can be blended with the colors
produced by coordinate coloring to give a shading. This helps to retain the original features of the scan,
while still getting the additional information provided by coordinate coloring.

Colormap. Choose the colormap for coloring. Choices are:

l Rainbow

l Cold-Hot, which is blue, white and red values

l Linear, which is black increasing to red (x), green (y), blue (z) and white (distance)

Select Discrete if you want to have solid colors instead of continuous colors. Use Increments to set the
number of discrete colors.

Shading
For more information, see Coordinate Coloring.

Shading Strength: Increases or decreases the strength of shading.

Apply to meshes: Applies shading to the meshes. Initially off.

Layer
Toggle the visibility of the available layers and their related objects and the object names in the view. See
chapter Layer on page 245 for more information.
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Extra
Objects – Display or hide certain types of objects:

Models Folder – Display CAD models.

References Folder – Display reference objects.

Scan positions – Display the scanner positions in the view. If enabled, the positions will be visualized
by this symbol:

Figure 10-67 Scanner position

Cameras – Display the camera positions of other views.

Scan objects – Display or hide the objects that are assigned to the scans in the view. You may display these
objects only if the scan is loaded.

Visibility – Set the minimum and maximum distance at which objects are shown.

Documentation Objects – Set the maximum distance at which documentation objects are shown.

Import CAD layout plans or aerial photographs as Image Files
in SCENE
This method allows importing image files into a scan project to be used as a floor plan or background image
for the scan.

l In 3D view, this image can be aligned and modified

l with the manipulators known from the clipping box.

l by entering dimension and aligning values in the Properties menu of the image.

This is done as follows

1. Go to the Import .

2. Click Import Images.
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3. Select the image and click Open.

Figure 10-68 Import picture dialog

4. Select Layout plan that may be used as map layer in, for example in Sphere XG.

5. If there are several pictures, you can select Apply to all.

Figure 10-69 Predefine alignment dialog
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6. Predefine the position, the size (width and height) and the resolution in which the picture shall be
imported. If a TIFF image with valid GeoTIFF coordinates (http://trac.osgeo.org/geotiff/) is imported,
the position and size will be preset automatically.

7. Click OK to import the picture.

Manual alignment
1. In the 3D view, use the manipulators to move, rotate and scale the picture in an easy way.

An imported layout plan with scale manipulators (left picture) and rotation manipulators (right picture)

2. Choose an appropriate button from the toolbar to align the layout plan to the point cloud.

Scale Manipulator : Select to resize the picture. Handlers will appear on the picture allowing you to
resize it.

Rotate Manipulator : Select to rotate the picture. Handlers will appear on the picture allowing you to
rotate it around different axes.

Translation Manipulator : Select to move the picture. Handlers will appear on the picture allowing you
to change the position.

Restore previous transformation : Undo the last transformation change.

Reapply transformation change : Reapply a transformation change.

Restore initial transformation : Restore the initial transformation of the picture.

3. To align the picture in a precise manner, use the properties dialog of the picture.
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Figure 10-70 Properties dialog with transformation settings

4. Set or modify

Position: The translation portion of the transformation.

X: To key in a transformation in the x direction.

Y: To key in a transformation in the y direction.

Z: To key in a transformation in the z direction.

Scroll bar: Set the transformation using the mouse. The direction of the transformation will be the x, y or z
coordinate that is highlighted in yellow.

Each tick increments by: Set the increment for the scroll bar.

Rotation Angle: The angle of rotation if the rotation axis is split along the coordinate axes.

X: The angle of rotation around the x-axis.

Y: The angle of rotation around the y-axis.

Z: The angle of rotation around the z-axis.

Scroll bar: Set a new angle of rotation.

To change a value, you can either enter the required value directly into the appropriate field, or you first
select the field and then use the corresponding slider to change the value step by step. You can set the

SCENE User Manual
Chapter 10: Explore

SCENE User Manual (2024.0) Page 249 of 372



increment using the dropdown box. If you hit the edge with the slider, simply reselect the field and the
slider will return to the center without you losing your previous changes.

Axis snap: If checked, you can change the rotation for the current axis independently from the others. This
is achieved by changing the order in which the rotations are applied.

Size: Enter length, width and height, if you know the data.

Scroll bar: Set the transformation using the mouse. The direction of the transformation will be the x, y or z
coordinate that is highlighted in yellow.

Each tick increments by: Set the increment for the scroll bar.

Global Coordinates: If checked, coordinates are displayed in the global coordinate system; else they
are displayed in the coordinate system of the scanner (see chapter Global Coordinates on page 308).

Auto Apply: If selected, new settings are applied and visible immediately; you do not need to click the
Apply button after changing the settings.

Click Apply to use the changed values and OK to use them and close the dialog.
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Chapter 11: Export

To use scan points from the scans in other applications such as CAD systems, SCENE provides the
possibility to export scan points in various data formats and write them to a file. You can then import this
file into the application you want.

You may change certain settings in the Export dialog before you export the scan points.

NOTE:
Due to the nature of the underlying data, the export of points from 3D selections provides only a
reduced set of export settings. The mismatching will be grayed in the export dialog when exporting
points of a 3D Selection.

Not all export formats are available when exporting points from a 3D selection. The supported
formats are CPE, E57,VRML, DXF, XYZ Text, XYZ Binary, IGES, FLS, PTS, RCS, LAS,
and POD.

The export of multiple scan point clouds of a scan folder does not support exporting all points into
a single file.

The export of scan point clouds and of the project point cloud will consider activated Clipping Boxes in the
same way as they are applied in the 3D views (what you see is what you get).

If Clipping Boxes exist in the project, but should temporarily not be considered during the export, deactivate
the Clipping Boxes individually or with the global Clipping Box setting.

Exporting the Scan Project

Figure 11-1 Export toolbar

1. Click the Export button in theWorkflow bar.
The toolbar will now show the available Export functions.

2. Click the button of the Export function you want to execute for the entire scan project.

You can: 
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l Export scans

l Export the project point cloud

l Export the project

l Export the overview map

l Export and upload data to WebShare

It is recommended to use the new cloud solution Sphere XG instead of WebShare.

Export Scans
In the Export toolbar, click Export Scans, then click one of the following options:
Export Scans – ordered: Export all scans of this scan project

Export Scan Point Clouds – unordered: Export all point clouds of this scan project. Exporting scan point
clouds on a scan or cluster will only apply the Clipping Boxes below the scan or cluster, instead of all
available Clipping Boxes.

The Export Scan Points dialog opens, and you can specify the export format, and the required settings.

Export Project Point Cloud
In the Export toolbar, click Export Project Point Cloud.

The Export Scan Points dialog opens, and you can specify the export format, and the required settings.

All clipping boxes will be applied.

Export Project
In the Export toolbar, click Export Project.

The dialog opens. Set the following three options:
Format: select one of the following: SCENE Project (*.lsproj) or ReCap Project (*.rcp)

Project Name: Enter a project name for the new project.

Location: Select the target folder to save the new project.

Note that a project export requires a large amount of disk space.

Export Overview Map
Export Overview Map of the Scan Project
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The overview map for a scan project can be exported as a high resolution TIF image or as a DXF file that
can be opened in any CAD system for further modeling.

In the Export toolbar, click Export Overview Map.

A file dialog opens where you can enter a name of the exported file.

An additional text file is also created that contains information about the resolution, the image size in pixels
and in meter, and the corner points of the image and the associated TIF file.

Export Overview Map of the Scan Cluster

To export the overview map of a single scan or a cluster:

Right-click the cluster and select Export> Overview Map.

Export Overview Maps of the Single Scans

To export each overview map of a scan into a single file:

Right-click the cluster and select Export > Scans > Overview Map.

A file dialog opens where you can enter a base name of the exported file. For each overview map exported,
the corresponding scan name is added to the base name.

Export and Upload Project Data to WebShare

NOTE:WebShare is being replaced by the new cloud solution Sphere XG. Contact the FARO support or
find information in the Sphere XG user manual.

In the toolbar, click WebShare.

A dropdown menu opens in which you can select one of the following options:
Export WebShare Project: Export the project for WebShare

Upload WebShare Project: Upload an existing export to WebShare

Upload Project Point Cloud Data: Upload the project point cloud to WebShare as a CPE file. This CPE
file can be used as source data for the 3D view in WebShare.

Export Objects
In the structure view, right-click the scan, then click Export > Objects.

The Export Objects dialog opens, and you can specify the export format, and the required settings.

Export Meshes
1. Right-click the mesh, then click Export.

The Export dialog is shown.
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2. Select the file format in which you want the meshed object to be exported.
Available file formats are: .stl, .ply, .obj, and .wrl. Note that with .obj files, the material and texture
files are also saved.

3. Click OK to start the export.

Exporting Scan Points of an Entire Scan
1. Open the scan in planar view or the quick view .

2. Right-click into the view, then select the command Export > Direct Export or Export > Export Scan
Points.

l Select Direct Export to export the scan points without opening the Settings dialog. The prior settings
will be used and the data will be saved directly to a file.

l Select Export Scan Points to open the Settings dialog to make certain settings prior to exporting the
points.

Exporting scans
To export scans:

1. In the structure view, right-click the cluster.

2. Select Export > Scan Points.
This command will be grayed out if a scan point cloud of the respective scan does not exist.

There are the following scan export options:

l Exporting the scans of a cluster

l Exporting the scans bundled as a new project

l Exporting panoramic images of scans or the scan project

Exporting the Scans of a Cluster
In the structure view, right-click the scan, then select Export  > Scan Points.

The Export Scan Points dialog opens, and you can specify the export format, and the required settings.
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Exporting the Scans Bundled as a New Project
In the structure view, right-click the cluster, then select Export > As Project. The Export as Project dialog
opens.

Format: select one of the following:

l SCENE Project (*.lsproj)
Recap Project (*.rcp)

l Project Name: Enter a project name for the new project.

l Location: Select the target folder where you want to save the new project.

Note that a project export requires a large amount of disk space.

Exporting Panoramic Images of Scans or the Scan Project
Single Scans

1. In the structure view, right-click the scan, then select Import/Export> Panoramic Images.

2. Select Scan Resolution to create images that have the same color resolution as the scan, or select Full
Color Resolution if you want to create panoramic images with the highest color quality possible, and
which are compensated to remove the offset between the two halves of the scan, as well as any
distortion cause by the scanner’s rotation.
Full color resolution panoramas have a white stripe at the bottom of the picture because the proportions
of the scan and the picture are different. (Scans made with FARO scanners versions M70, S70, S350
and later create 160 megapixel images. Scans from older scanners only output panoramic images with
40 megapixel images.)
The Select a folder for images export dialog opens,

3. Browse to the target folder where you want to save the images.

Scan Project

If you want to export the panoramic images of all scans and import them in your own app or web viewer, it
is not enough to simply export the single images. You also need the position and orientation of each image.

1. In the structure view, right-click the scan project (topmost folder) and select Import/Export>Export
Positions.

2. In the dialog, enter a file name and select a target folder.
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3. Click Export.
A .txt file with specifications of all scans and reference objects is created and saved. The format of
scan positions is: Scan Name, X, Y, Z, 4 values for the rotation in axis-angle representation1 (i.e., 3
vector components and rotation around the vector), date, time. Be aware that the Z component of the
vector can be negative and the rotation direction is defined by the right-hand rule

4. In the structure view, right-click the scan project again and select Import/Export>
Panoramic Images and either Scan Resolution or Full Color Resolution (see above).

5. Browse to the target folder where you want to save the images and click Select Folder.

The export is started.

Export Formats
SCENE supports the following scan export formats. Click a link below to learn more about the export
options for each format:

l CPE Export Settings on page 257

l DXF Export Settings on page 259

l E57 Export Settings on page 261

l SCENE Scan File Export Settings on page 273

l IGES Export Settings on page 263

l LAS Export Settings on page 266

l PointoolsTM POD Export Settings on page 267

l PTS Export Settings on page 270

l PTX Export Settings on page 271

l SPW Export Settings on page 274

l VRML Export Settings on page 275

l XYZ ASCII Export Settings on page 278

1If you are not sure about the meaning of axis-angle representation you can, for example, browse
www.wikipedia.org for further reference.
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l XYZ Binary Export Settings on page 279

l Exporting Slices on page 281

CPE Export Settings
File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.

Export Tab

Figure 11-2 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.
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Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.

Slices Tab
In the slices tab you can configure the export so that only slices of the scan are exported. You might use this
to create a floor plan of a building, see Exporting Slices for more information.

CPE Tab
CPE is a file format for point data developed by FARO that combines minimal file size with flexible quality
settings.

Figure 11-3 CPE Export

When exporting scans to the CPE file format, the following information must be provided:
File name: Name and location of the file to be created.

Export each scan in a separate file: If not selected, all scans will be saved in one file.

> Numerical Resolution: Set the numerical resolution (quantization) for the exported scan points to one of
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Set the numerical resolution (quantization) for the exported scan points to one of the recommended values or
your own desired value.Color: Set the number of colors used for the exported scan points to “True Color”
or use “High Color” for a smaller file size, but with a reduced visual quality of color gradients.

Export Reflection Values : Export with raw reflections, that can be between 0 and 2047 for the
FARO Focus Laser Scanner. Otherwise, the monitor brightness will be exported (values between 0 and
255). Export the original reflection values of the scan points if they're available.

Export Normal Vectors: Export the normal vectors of the scan points.

Estimated size: The estimated file size in MB per million exported scan points.

Color and Grey

Export RGB and grayscale (intensity) values of each scan point if available. This function is enabled for the
formats E57, XYZ text, POD, PTX and PTS. To export both values, the scan will be unloaded first and re-
loaded with both values. After the export, the scan will be unloaded again and the initial scan status will be
restored.

DXF Export Settings
File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.
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Export Tab

Figure 11-4 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.
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Slices Tab
In the slices tab you can configure the export so that only slices of the scan are exported. You might use this
to create a floor plan of a building, see Exporting Slices for more information.

DXF Tab
DXF is a data format developed by AutoDesk for the exchange of CAD drawings. SCENE uses DXF
version 12.

The scan points in DXF are always displayed as points. Since DXF has very few gray scales at its disposal,
the visual appearance is not as good as in SCENE.

Figure 11-5 Setting for DXF export

Export Object Names

Select this checkbox if you want the names of the selected objects to be exported.

E57 Export Settings
When exporting scans to the E57 file format, the following information will be stored in the exported file:

l For each scan point in a scan, the xyz-coordinate, RGB or intensity values, and the corresponding index
of row and column. This information is part of the binary section of the E57 file. It is possible to store
several scans in one E57 file.

l Additional meta information such as the scan name, the unique ID (UUID) of a scan and the software
version that is used for the export1. This information is stored in the XML-part of the E57 file.

File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.

1For more detailed information refer to www.libe57.org or www.astm.org/Standards/E2807.htm
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Export Tab

Figure 11-6 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.

Color and Grey
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Export RGB and grayscale (intensity) values of each scan point if available. This function is enabled for the
formats E57, XYZ text, POD, PTX and PTS. To export both values, the scan will be unloaded first and re-
loaded with both values. After the export, the scan will be unloaded again and the initial scan status will be
restored.

Export Scan Pictures

Exports pictures taken by the scanner.

Full Color Resolution Panorama Image

Exports a full color resolution panorama image taken by the scanner.

IGES Export Settings
File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.

Export Tab

Figure 11-7 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:
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Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.

Slices Tab
In the slices tab you can configure the export so that only slices of the scan are exported. You might use this
to create a floor plan of a building, see Exporting Slices for more information.

IGES Tab
IGES is a multi-vendor-capable standard for the exchange of CAD drawings. SCENE uses IGES version
5.3.

The scan points are exported as gray points or color points, if color information is available. When you
import the IGES file into your CAD system, it decides how it will represent these points in its own gray or
color space.
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Figure 11-8 Settings for IGES export

Part

Naming the parts is a required component of an IGES file.

Author

Specifying the author is a required component of an IGES file.

Organization

Specifying the organization is a required component of an IGES file.

Represent Scan Points as

Points – Scan points are displayed in the CAD system as points.

Spheres – Scan points are displayed in the CAD system as small spheres.

Set Color to

Settings for the colors to be used.

IGES default – The export file does not contain any color specifications so the CAD system will use
the default color.

Scan point color – Use the gray value or color value of the scan point.

Scan specific – If the export consists of several scans, the scan points from the different scans will have
different colors.
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Set Level to

Settings for the level to be used.

IGES default – The export file does not contain any level specifications so the CAD system will use
the default level.

Scan specific – If the export consists of several scans, the scan points from the different scans will have
different levels.

Objects

Unbounded Planes – The idealized planes without border are also exported as idealized and without
border. Otherwise, a square is exported.

Export Object Names – Object names are exported.

Level – The level allocation for object names.

LAS Export Settings
File name

Name and location of the file to be created.

Export Tab

Figure 11-9 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.
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Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.

PointoolsTM POD Export Settings
File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.
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Export Tab

Figure 11-10 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.
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Slices Tab
In the slices tab you can configure the export so that only slices of the scan are exported. You might use this
to create a floor plan of a building, see Exporting Slices for more information.

Color and Grey

Export RGB and grayscale (intensity) values of each scan point if available. This function is enabled for the
formats E57, XYZ text, POD, PTX and PTS. To export both values, the scan will be unloaded first and re-
loaded with both values. After the export, the scan will be unloaded again and the initial scan status will be
restored.

POD Tab
Pointools is a third-party application that provides an environment for viewing, analyzing, editing, and
producing visual content from a range of 3D data types.

Figure 11-11 Settings for Pointools export

Compression Accuracy

POD files compress cloud data for efficient storage and faster retrieval from disk. You can set the level of
accuracy you want to maintain. It is important to consider the accuracy of the instrument used to acquire the
data and to not set the compression accuracy too high.
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Normal Generation

Normals are required for point lighting. This data is either imported from the source file or generated upon
import.

Normal – no altering.

Sharpest, Sharper, Sharp – Quality of normals, degree of faceting on object’s surface.

Smoothest, Smoother, Smooth – Quality of normals, degree of curvature on object’s surface.

Spatial Filter Strategy

For advanced users. Default setting is usually sufficient.

Spatial Filter Accuracy: Much like the compression accuracy, setting this too high may result errors.

NOTE: For details about the export, refer to the PointoolsTM manual.

PTS Export Settings
File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.

Export Tab
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Figure 11-12 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.

Slices Tab
In the slices tab you can configure the export so that only slices of the scan are exported. You might use this
to create a floor plan of a building, see Exporting Slices for more information.

Color and Grey

Export RGB and grayscale (intensity) values of each scan point if available. This function is enabled for the
formats E57, XYZ text, POD, PTX and PTS. To export both values, the scan will be unloaded first and re-
loaded with both values. After the export, the scan will be unloaded again and the initial scan status will be
restored.

PTX Export Settings
File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.

SCENE User Manual
Chapter 11: Export

SCENE User Manual (2024.0) Page 271 of 372



Export Tab

Figure 11-13 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.

Color and Grey
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Export RGB and grayscale (intensity) values of each scan point if available. This function is enabled for the
formats E57, XYZ text, POD, PTX and PTS. To export both values, the scan will be unloaded first and re-
loaded with both values. After the export, the scan will be unloaded again and the initial scan status will be
restored.

Slices Tab
In the slices tab you can configure the export so that only slices of the scan are exported. You might use this
to create a floor plan of a building, see Exporting Slices for more information.

SCENE Scan File Export Settings
File name

Name and location of the file to be created.

Export Tab

Figure 11-14 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.
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Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.

SPW Export Settings
File name

Name and location of the file to be created.

Export Tab

Figure 11-15 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:
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Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.

Color and Grey

Export RGB and grayscale (intensity) values of each scan point if available. This function is enabled for the
formats E57, XYZ text, POD, PTX and PTS. To export both values, the scan will be unloaded first and re-
loaded with both values. After the export, the scan will be unloaded again and the initial scan status will be
restored.

VRML Export Settings
File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.
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Export Tab

Figure 11-16 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.
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Slices Tab
In the slices tab you can configure the export so that only slices of the scan are exported. You might use this
to create a floor plan of a building, see Exporting Slices for more information.

VRML Tab

Figure 11-17 Settings for VRML export

Export

Scan points as is – Scan points are exported as points.

NOTE: Many VRML viewer programs do not support points.

Scan points as sphere – Scan points are exported as small spheres.

Scan points as boxes – Scan points are exported as small boxes.

VRML2 – Export in VRML2 format. Otherwise, VRML1 is used.

Coordinate System

Select the target coordinate system.
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XYZ ASCII Export Settings
File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.

Export Tab

Figure 11-18 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .
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Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.

Color and Grey

Export RGB and grayscale (intensity) values of each scan point if available. This function is enabled for the
formats E57, XYZ text, POD, PTX and PTS. To export both values, the scan will be unloaded first and re-
loaded with both values. After the export, the scan will be unloaded again and the initial scan status will be
restored.

Slices Tab
In the slices tab you can configure the export so that only slices of the scan are exported. You might use this
to create a floor plan of a building, see Exporting Slices for more information.

XYZ Tab
With XYZ text format, the export file contains one scan point per row. Each scan point is identified by its 3
Cartesian coordinates X, Y, and Z and the reflection value. You can also specify the row and column
number of the scan point. Both these numbers will then be next to the current scan point in the export file.

Figure 11-19 Settings for XYZ ASCII

XYZ Binary Export Settings
File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.
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Export Tab

Figure 11-20 Export tab

Full Scan and Selection – These selections become available only when exporting from a single scan within
the tree or from a point selection.

Distance – To reduce the number of points you export, you can indicate a threshold for the distance that a
scan point may be from the scanner to be exported:

Min. Distance – The minimum distance the exported scan points may be from the scanner. Scan points
that are closer are not exported.

Max. Distance – The maximum distance at which the exported scan points may be from the scanner.
Scan points that are farther are not exported.

Subsample – Because even small selections of a scan can contain a great number of scan points, it may be
necessary to reduce or thin out the exported scan points. Thinning out is achieved by only exporting every
second, or third scan point of a row or column. Scan points are thinned according to their arrangement in the
planar view or quick view .

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so on. For example, if you enter
the value 10 in both fields, you export 1 in 10 columns and 1 in 10 rows, so in total you will export one
hundredth of the scan points.
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Slices Tab
In the slices tab you can configure the export so that only slices of the scan are exported. You might use this
to create a floor plan of a building, see Exporting Slices for more information.

Exporting Slices
If you want to very quickly create the floor plan of a building from the scan points, it is practical to use the
slice export. When exporting slices, only those scan points are exported, which are between the top and the
bottom limit you have specified. If you select a slice where there is little furniture or machines blocking the
view, you obtain the floor plan of the building very easily.

Figure 11-21 Slice of scan points

When exporting slices, only those scan points are exported which are between the top and the bottom limit
you have specified. You can also apply the threshold outlined above for reducing and thinning out when
exporting slices.

Slices Tab
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Figure 11-22 Export of a single slice

One Slice

The orientation and position of the slice are defined by the reference plane. The default setting of the
reference plane is the ground floor, so top and bottom limits refer to the z coordinate and are limits in
height.

If you want to create vertical slices, you can select the corresponding predefined plane with the normal
pointing along the x-axis or y-axis.

The reference plane will be added to the project after the export. It will be called ExportRefPlane and will
be available in the folder named References.

However, the export of slices is not limited to planes with normals pointing along the axes. With the
Custom button you can use arbitrary planes as reference planes. Custom reference planes make it very easy
to export scan points of objects that are located above a flat surface, like objects on the floor or on a table,
by fitting a plane to the surface and using this plane as a reference.

Use Tomograph

When exporting slices, scan points from horizontal surfaces in the slice are also exported. This can make it
difficult to define the floor plan. The Tomograph resolves this: it brings out vertical surfaces and hides
horizontal surfaces, thereby allowing walls and supports to stand out.

Figure 11-23 Tomograph

The Tomograph works like an X-ray apparatus – the X-ray goes through the slice from above and comes out
on a photo plate below. The photo plate is covered with a fine raster and a raster field now either turns black
or it remains white. If the X-ray hits sufficient scan points on its way through the slice, the raster field turns
black. This occurs predominantly with vertical surfaces. If the X-ray hits only very few scan points, as is the
case with horizontal surfaces, the raster field remains white.

The Tomograph brings out vertical surfaces and hides horizontal surfaces, thereby allowing walls and
supports to stand out. The Tomograph can be used with any reference plane.

Slice by plane

If you want to export several slices at the same time, you can define the slices with a set of planes. In
contrast to the export of a single slice, here each plane directly defines the location of the slice. Instead of
having a plane and a top and a bottom distance, each plane defines the center of the slice. All slices have the
same thickness which you can input into the dialog.

Also in contrast to the export of a single plane, here only those points of a slice are exported which are
located within a given radius around the center point of the slice.

The center point of each slice is defined by the position of the corresponding plane.
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You can create planes either by fitting or manually. Notice that all planes of the project will be used as
reference planes – even if they are defined in other scans or in completely different folders of the project.

In the figure below you can see an example of an export with a set of equidistant planes that were defined
manually. This figure shows the exported scan points after they have been imported back into SCENE.

Figure 11-24 Slices defined by a set of equidistant planes

Figure 11-25 Export of several slices

You can create planes either by fitting, or manually. Observe that all planes of the project will be used as
reference planes – even if they are defined in other scans or in completely different folders of the project.

Exporting Scan Point Clouds
Export the scan points of one scan point cloud:

In the structure view, right-click the scan, then select Export > Scan Points. This command will be grayed
out if a scan point cloud of the respective scan does not yet exist.

Export the scan points of several scan point clouds of a scan folder:

In the structure view, right-click the scan, then select Export > Scan Points. This command will be grayed
out if the respective scan folder does not contain any scan point clouds.

SCENE User Manual
Chapter 11: Export

SCENE User Manual (2024.0) Page 283 of 372



Exporting the project point cloud
To export the project point cloud of a scan project:

1. Click the Project Point Cloud button in the Export toolbar. It does not matter what you clicked in
the structure view before.

The Export Scan Points dialog is shown.

2. Select the file format in which you want the project point cloud to be exported.

3. Click OK to start the export.

Legacy: Export and Upload a WebShare Project from
within SCENE
NOTE:WebShare and Sphere are migrated to the new cloud solution Sphere XG. Please see Upload and

Download SCENE Projects to/from Sphere XG on page 64for information how to upload a project
to Sphere XG.

With WebShare, panoramic scan images can be put on the Internet, thus enabling anyone to share scan
information of scan projects with other parties, like far-off company sites, customers, suppliers or partners
without the need of additional software.

WebShare is a web service hosted by FARO Technologies inc. which enables you to share your scan
projects without setting up a web server on your own. The project data can be accessed with a standard web
browser, no additional software or plug-ins are needed. Connect to faro.websharecloud.com to view the
publicly available projects.

See the WebShare online help for more information.

NOTE:WebShare is being replaced by the new cloud solution Sphere XG. Contact the FARO support or
find information in the Sphere XG user manual.

You can also upload a SCENE project to Sphere using the Sync Agent. From Sphere Legacy, you can
upload the SCENE project to WebShare. For further information refer to the Sphere Legacy User and
Administrator Documentation, chapter Sync Agent.

Export WebShare Project
Before publishing a scan project in WebShare, special WebShare data must be created from the project.
Follow these steps to create such data:
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1. Open your scan project. Make sure that the scan project is processed and registered.

NOTE: Hand-held scans are visible in overview maps, but if you want to view your hand-held scans
as panoramas in WebShare, you must first create virtual scans.

See Upload Project Point Cloud on page 290 to learn how to create 3D views from hand-held
scan data in WebShare.

2. In the Export tab, click the WebShare button in the tool bar. A small menu opens.

3. Click the ExportWebShare Project button in that menu.

4. You will be asked to save the scan project first.

5. The WebShare export dialog appears. This dialog has three tabs:

n Export Settings – allows configuring the data export of the WebShare Overview Map and the
Panorama Views.

n Project Settings – allows providing the name of the project and its URL identifier plus additional
project information to be published in WebShare.

n Upload Settings – allows entering the user login data, and starting the project upload to WebShare
immediately.
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6. Configure the data export on tab Export Settings of the WebShare export dialog.

Figure 11-26 WebShare export dialog – Export Settings

Export Settings
Overview Map settings

Settings for the Overview Map, which is a top view of your entire scan project.

Standard View – Select an option in this dropdown list to export the Overview Map with the following
options:
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l Standard View

l Clear View

l Gap Filler

l SCENE Overview Map

Background color – Select the background color of the Overview Map. Selecting a color other than
white might be useful when the scan project contains crucial structures which are white themselves.
You can test this by selecting a white background in the 3D view and looking at the project from above.

Create Scan Overlays – If this checkbox is selected, the coverage of each scan can be shown in the
overview map.

If this checkbox is activated, the coverage of each scan can be shown in WebShare's overview map.
Since the creation of the scan overlays increases the export and upload time significantly, the option is
deactivated by default.

Single-layer map

Apply Clipping Boxes – Sometimes, it might be useful to hide points (for example, the roof of a
building) with the help of Clipping Boxes to improve readability of the map.

Select this option to create the Overview Map from the visible scan points, defined by the available
and active Clipping Boxes.

Multi-layer map – These map layers can be toggled on and off separately in WebShare. Clipping
boxes are used as the basis for the map layers. Select one or more clipping boxes from the given list.

The Clipping Boxes must show their inside. They do not need to be active.

Export layout plans – If the project contains layout plans, select here if you want them to be exported
and if yes, if you want all layout plans or only some of them.

Panorama settings

Settings for the panoramic scan images.

Resolution

l Export images in HD resolution – Select whether to export the panorama images in the standard
resolutions only (width of the standard panorama images is up to 4096 pixels) or, to export the
panorama images in the standard resolutions and additionally in a higher resolution (HD resolution,
width of images is 8192 pixel or 16384 pixels). Such HD images can only be displayed on desktop
PCs or Notebooks. On mobile devices like tablet computers, the panorama images will be displayed
in the standard resolutions.

l Export scan data in HD resolution – The scan data which is necessary for measurements and
annotations in the panorama images can be exported in two sizes, in the standard size and,
additionally, in the maximal size. Exporting scan data in the maximal sizes needs additional storage
space of 128 MB per scan on the server, but facilitates the exact positioning of measurements and
annotations in HD panorama images.

Color Settings
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Panorama images can be exported in color or as gray scaled images, or both. If there are scans in the scan
project that are not colorized, gray scaled images will be exported from these scans, even if Export gray
scale images is not selected. And vice versa, if there are scans in the project that do not have their original
reflection values anymore, only colored images will be exported from these scans, even if Export color
images is not selected.

Project Settings
1. Set up project information on tab Project Settings:

Name – Enter the name of the scan project.

URL identifier – Enter a unique identifier for the project in the WebShare. Every project in the
WebShare must have a unique URL identifier. The following characters are allowed: a-z, 0-9, and -.

Preview image – Select a preview image for the project. This image will be displayed in the
WebShare project selection. Supported picture formats are BMP, JPEG, and PNG.

Access control

n Make public – If you set this option, everybody will be able to see and access the project in
WebShare. If you do not set this option, the project will not be visible to the WebShare users. After
project has been uploaded, the appropriate project access rights must be defined in the
Administration area of WebShare to make the project visible to certain users or user groups. See the
WebShare online help for more information.

n Feature project – If you set this option, the project will be shown in the slide show on the
WebShare Project Overview page.

Description – Enter a description text for the project.

Keywords – Enter keywords associated with the project, separated by commas.

Project coordinates – Enter the project’s world coordinates. The project location will be displayed
on a map in the WebShare. The latitude must be a decimal number between -90 and 90, the
longitude between -180 and 180.

2. Click Show the project location in Google Maps button to test the entered coordinates in
Google Maps.

3. If you want to upload the data to the WebShare immediately, switch to tab Upload Settings.

Upload Settings
Immediately start upload – Starts to upload all files created during the WebShare export immediately. If
you do not want to upload the WebShare data immediately, you can do this at any time later.

NOTE:We recommend exporting and uploading the data in parallel.
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Upload options – enter your Sphere login credentials to access WebShare:

Save Credentials – Select to save your login credentials so that you do not must enter them again in the
future.

Point Cloud Options

If a project point cloud exists in the SCENE project, both boxes are checked by default.

l Upload Project Point Cloud – Check this box to upload the SCENE project point cloud as a CPE file
after the WebShare Cloud project is successfully uploaded. If no point cloud exists, you are prompted to
create it.

l Create data forWebShare 3D View – After the CPE file is successfully uploaded, data creation for the
WebShare 3D view begins. Note that this can take some time. The 3D view will be available in the
WSC project after it is created.

After you are finished, click Export to start the creation of the WebShare data that will be saved to the
project folder. The data is uploaded to the WebShare Cloud.

Uploading WebShare Project
If WebShare data is already available for your scan project, you can upload it to the WebShare at any time.
Follow the steps below to do this:

1. Click the WebShare button in the toolbar. A small menu opens.

2. Click Upload Data in that menu. The WebShare upload dialog will show up. This dialog has two tabs,
Upload Settings and Project Settings.

Upload options – enter your Sphere login credentials to access WebShare:

Save Credentials – Select to save your login credentials so that you do not must enter them again in the
future.

Point Cloud Options

If a project point cloud exists in the SCENE project, both boxes are checked by default.

l Upload Project Point Cloud – Check this box to upload the SCENE project point cloud as a CPE file
after the WebShare Cloud project is successfully uploaded. If no point cloud exists, you are prompted to
create it.

l Create data forWebShare 3D View – After the CPE file is successfully uploaded, data creation for the
WebShare 3D view begins. Note that this can take some time. The 3D view will be available in the
WSC project after it is created.

After you are finished, click Export to start the creation of the WebShare data that will be saved to the
project folder. The data is uploaded to the WebShare Cloud.
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1. Specify project relevant information on tab Project Settings.

2. After you are finished, click Upload to start uploading the data to WebShare.

You must have a Sphere account with project role Uploader to upload scan projects. Ask your Administrator
for more information.
You can resume interrupted uploads: To resume an interrupted upload, make sure to enter the same URL
identifier in the Project Settings as used in the previous upload attempt.

Upload Project Point Cloud

NOTE: This upload functionality is now only useful if you have an existing WebShare Cloud project. For
new projects you upload the point cloud automatically.

It is now possible to upload point clouds to WebShare or export the point clouds generated in SCENE to a
particular project in the WebShare domain. Select the Upload Project Point Cloud option in the WebShare
dropdown menu to open the Send toWebShare tab.

This functionality can also be accessed from the:

l context menus of scans or clusters, select Point Cloud > Send toWebShare

l context menus of clipping boxes, select Active Clipping Boxes > Send toWebShare

l context menus of selections, select Selection > Send toWebShare

NOTE: It is recommended to upload the project point cloud, or selections based on it.
Due to filtering and color balancing, a better visualization quality can be achieved than with scan
point clouds.

Login
The Login page is displayed. Login with your Sphere login credentials.

You must have a Sphere account with project role Manager to upload project point clouds. Ask your
Administrator for more information.

If the login credentials are already saved, you are automatically logged in with the saved credentials.

Select Project Settings
The Select Project Settings page opens.

Based on the project properties of the current SCENE project, matching WebShare projects are
recommended.

Other projects can be selected by expanding the section Other Projects in this Domain.

If you want to upload the CPE file into a new empty WebShare project, create the project in WebShare first.
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NOTE:When uploading to an existing WebShare project, make sure that you did not modify the scan
positions in SCENE after the WebShare export. Otherwise, the uploaded point cloud will not be
aligned to the scan positions in the WebShare project.

Point Cloud Settings
The Point Cloud Settings page opens.

The project point cloud is generated in CPE format. Enter the name of the file, and file format properties.

Start Upload
Click Start Upload to upload the project point cloud. After the upload has successfully completed, you can
use the Create 3D Data task in WebShare to create the data for the 3D view. Select the uploaded CPE file
in the Select Sources option. You can additionally select other CPE files or scans to get a combined 3D
view. After the 3D data creation has finished, you can view the uploaded point cloud in WebShare.
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Chapter 12: Virtual Reality

SCENE gives you the ability to step into your point cloud with virtual reality (VR). You can now
experience your scans as if you were on location, take measurements, make screen captures, and read
annotations.

Virtual Reality

Introduction
SCENE gives you the ability to step into your point cloud with virtual reality (VR). You can now
experience your scans as if you were on location, take measurements, make screen captures, and read
annotations.

VR System requirements
See System Requirements on page 1 for all VR system requirements.

SCENE Project Requirements
l Your project requires a point cloud.

l Closed surfaces are strongly recommended.

SCENE Virtual Reality Features
When you view your project using VR goggles, the following features are available:
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l View a project point cloud

l View imported meshes

l Choose among different movement modes:
n Teleporting

n Flying

n Flying with fixed vertical position (walk mode)

n Jump directly to measurements, annotations, and scans

l A virtual tablet that serves as your user interface while using the VR goggles. It can be minimized when
you don’t need it.

l Keep track of your location with a 2D overview map (if present in your project)

l Take and delete measurements

l View and delete annotations and attached image files

l Take and delete screen captures. The images are stored in the structure view under the Screenshots
folder. To export the screen captures, select the images in the structure view, right-click and choose
export images.

l View the help page for Oculus and HTC VIVE that explains how to use the controllers to explore the
virtual world

l VR Settings (Within VR only)

Starting the Virtual Reality in SCENE
1. Ensure that the VR hardware is correctly connected to the computer.

2. Open the Explore toolbar and click the VR icon.
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Chapter 13: Scanning

The Scanning category available in SCENE and FARO Laser Scanner provides the options for Scanner
Control, On-Site Registration, and On-Site Compensation.

Typically, you will not see the Scanning feature in SCENE since it is hidden. If you need it, activate it in
Settings > General > User Interface > Show Scanning Category under the User Interface option. The
Scanning feature will then appear in the workflow bar.

Scanning

Figure 13-1 Scanning toolbar

The Scanning toolbar provides the following options:

l Scanner Control

l On-Site Registration

l On-Site Compensation

l Open Target PDF

Scanner Control
The Scanning category has the Scanner Control option. It can be used to start a remote connection to
control the laser scanner. The scanner can be controlled by using the scanner user interface that is displayed
in SCENE.

To connect to the scanner:
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1. Click button in the toolbar.

2. Enter the IP address of the scanner. Note that after connecting to a scanner, its IP address is stored in
the computer’s registry. It will appear by default the next time you try to connect to the scanner.
You can change it on the Connect page, if necessary.

Figure 13-2 Connect page: Enter the IP address

3. Click Connect to retrieve the details of the scanner. The page will be updated.

4. If the IP address is not associated to an active laser scanner, an error message is displayed.

5. If a connection is successful to a supported FARO Focus Laser Scanner, the Control button becomes
active and green.

6. Click this button to control the scanner through the HTML user interface.

NOTE: After connecting, SCENE checks the version of the firmware that is installed on the scanner. If
a newer version of the firmware will work better with the current version of SCENE, you are
encouraged to update your scanner.
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7. SCENE starts the Scanner Control task and displays the scanner user interface. You can control the
scanner remotely through this HTML interface.

Figure 13-3 Finish or Cancel task

8. Click the Finish or Cancel button to close the scanner user interface, scanner control task and
disconnect from the scanner.

On-Site Registration
NOTE:We recommend using the FARO Stream app for on-site registration.

The On-Site Registration feature enables the user to process and register scans on-site remotely through the
computer running SCENE software. The scanner must be connected to SCENE and can be controlled by
using the scanner user interface displayed in SCENE. The processing and registration of the scans are
performed in SCENE

The user can operate on-site registration functionality as follows:

l directly on the scanner
Or

l through a connected device like a phone or tablet, showing the scanner user interface
Or
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l within SCENE. The scanner can be remotely accessed through WLAN or Ethernet through a computer
running SCENE.

On-Site Registration Setup
To enable on-site registration, see On-Site Compensation on page 298.

The procedure to setup on-site registration is as follows.

On the Scanner

Configure the scanner
1. Configure the WLAN connection on the laser scanner. See Connecting the Scanner to WLAN.

2. Configure scan project/cluster, scan name, scan parameters.

NOTE: Refer to the Operating Software chapter in FARO Focus Laser Scanner User Manual for more
information about on-site registration settings and related user interface pages.

Enable On-Site Registration
1. Go to Home >Manage > On-Site Registration Settings.

2. Turn On-site Registration ON or OFF by sliding the button. The scanner now connects to a remote
system in the network, running SCENE.

3. The IP address and port will be automatically set on the scanner.

4. The Start Scan button leads to the new map page. When Start Scan is selected, the map page will be
displayed.

On your Computer

Configure SCENE
1. Configure the WLAN network of the computer.

NOTE: The scanner and computer must be continuously connected to the same WLAN network.
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2. Start SCENE on the computer.

3. Start On-Site Registration task in the Scanning category of SCENE.

4. Enter the IP address of the laser scanner. You can find the IP address of the laser scanner by tapping
Manage > General Settings >WLAN > IP Address on the scanner user interface. Enter the IP
address as it is, following exactly the given scheme of digits.

5. Connect to the FARO Focus Laser Scanner after entering the IP address in the On-Site Registration
task. The scanner Home page is displayed.

6. On the scanner home page click theMap button. A map is displayed with the available scans in a
project.

Figure 13-4 On-Site Registration overview map with list and status of scans

7. Now click Start Scan button to start a new scan on your scanner, or remotely in SCENE. All recorded
scans on the current cluster or project opened on the scanner will be uploaded to SCENE. The scans
will be automatically processed by SCENE.

NOTE: If one scan fails to register, run a connection scan with the scanner placed in between the area of
the two different scans. To validate the registration of scans, highlight their points in the map.

On-Site Compensation
On-Site Compensation process is a procedure to test and improve the angular accuracy of the scanner using
SCENE software.

NOTE: On-Site Compensation feature is not available for Focus M 70.
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Preparing the Compensation Station

Site Setup
Before you begin the On-Site Compensation process, ensure that the scan site has the following facilities:

l Target sheets must be setup at the scan site at regular distance to the laser scanners between 1.5 m to 3
m.

l No windows or other reflective planes: The markers on the target sheets would be reflected if the scan
site has any windows or reflective surfaces. This can cause incorrect measurements.

l Lighting conditions are less important because On-Site Compensation is done with the laser, video
images are not used.

Connect Laser Scanner to Computer through Wireless LAN
To be able to transfer the scanned data directly to your computer, you must connect the computer with the
laser scanner and through WLAN to remotely access and control the scanner.

Using the scanner as a WLAN access point

NOTE: Disable the proxy server to make the connection work. If this is not possible for some reason, enter
the addresses of both devices in the Exceptions field.
We recommend using a WLAN card that supports IEEE 802.11n.

On your scanner
1. Enable WLAN on your scanner (see Connect Laser Scanner to Computer through Wireless LAN on

page 299).

2. Look up your scanner’s network name by tappingManage > General > WLAN > Network Name on
the scanner’s user interface.

On your Computer
Establish a WLAN connection between the computer or tablet and the scanner by using the network name as
the SSID.

NOTE: The following ports must be open to establish a LAN/WLAN connection between the Laser
Scanner and SCENE:
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8765 SOCKS Channel communication between Scanner and SCENE/SDK/Scanner
API

8775 Broadcasts - discover Scanner in the current network
8888 Scanner WebAPI, e.g., for On-Site Registration
80 Port for the HTML GUI: HTTP
443 Port for a secure HTML GUI: HTTPS
15975, 16824, 17673,
18522, 19371, 20220

Ports used in SCENE for the WebAPI, e.g., for On-Site Registration (15975 + x *
849)

On-Site Compensation steps

On your computer

Select Output folder
1. Click Start On-Site Compensation button in the Scanning toolbar by selecting the Scanning toolbar.

All data captured during On-Site Compensation, including the Compensation Report will be stored in the
output folder.

2. Click the Browse button to open the file system browser.

3. Browse to the folder. Click the OK button.

Setup

Enter Scanner IP Address
1. Enter the IP address of the laser scanner. You can find the IP address of the laser scanner by tapping

Manage > General Settings > WLAN > IP Address on the scanner user interface. Enter the IP
address as it is, following exactly the given scheme of digits and dots.

2. Click the Connect button.

3. In the dialog, click the Place Targets button to continue with the next step.
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Place target

On your Computer
1. In the Place Targets page, a picture is shown that describes how to place the targets and the scanner

for the compensation.

2. If the 6 Target Sheets are not available In SCENE, click the Open Target PDF button.

3. Select among the DIN/ISO A4 format, or US letter format. Your standard PDF viewer will open,
showing the target PDF sheet.

4. Print at least 6 marker sheets.

NOTE:We recommend gluing the target sheets on suitable rigid plates, especially if On-Site Compensation
is done at an outdoor location.

On Site
Place at least 6 Target sheets on site as follows:

1. Place the target sheets in a vertical range of -50° to 50° from the scanner device.

2. Distribute the target sheets uniformly over the specified range. At least one board must be close to the
horizon (0°).

3. Make sure that the distance between the target sheets and the scanner is between 1.5 m to 3 m.

4. Make sure that all target sheets are vertically aligned.

Laser Scanner Placement
1. Mount the laser scanner on a tripod.

2. Place tripod and scanner on a stable and plane ground. The tripod must not move during scanning.
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Horizontal Alignment

Figure 13-5 Horizontal Alignment

Horizontally align the scanner tripod as follows:

1. Rotate the tripod of the scanner to point approximately toward the center of the targets.

2. Start scanning and compensation by clicking the button Scan & Compensate.

During the compensation process, the status of progress is displayed. You can cancel the process if required.

Scan & Compensate
1. Select whether you want to apply the compensation data to the scanner.

2. Click disconnect to disconnect from scanner and finish the On-Site compensation.

3. To apply this compensation to the scanner choose “yes” and click the Finish button. Choose “no“ if
you do not want to apply this compensation.

When the compensation is finished, the Compensation Report is displayed with the results of the
compensation. Open the compensation report as PDF by clicking the button Open Report. The
Compensation Report is saved as PDF to the location specified in the left side of the page.

Troubleshooting

Error
Reading and writing to the selected data output folder failed.
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Solution
Make sure that you have sufficient rights to read and write in the selected output folder. Ensure that you
have sufficient disk space. Approximately 330MB are necessary to perform an On-Site compensation.

Error
The process did not identify enough targets for compensation.

Solution

In the output folder a targetImage.png file is stored. This image shows the identified markers as blue circles.
Areas with a sufficient amount of detected targets have a green background color. Areas with an insufficient
amount of detected targets the background color is red.

Error
No consistent solution could be determined.

Solution

Make sure that the tripod and the targets did not moving during the procedure.

Error
The SD card of the scanner could not be accessed.

Solution

Make sure that the SD card is inserted and that it is not write-protected and has sufficient free space left
(approximately 330MB).

Error
Communication with the scanner failed.

Solution
Make sure that the WLAN connection to the scanner is stable.

If this error appears when connecting to the scanner or applying the compensation parameters, try to repeat
the corresponding step.
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Chapter 14: Apps

For developers SCENE offers an application programming interface (API) which gives the opportunity to
integrate own functionality into SCENE. This API allows anyone to create custom applications (Apps)
which integrate seamlessly into the SCENE user interface to extend the functionality. Developers are free to
share their Apps with others (for free or for sale), so that everybody can benefit from them.

Publicly available apps may be downloaded from the FARO 3D App Center. 

Installing and Managing Apps
You can install and manage apps with the SCENE App Manager.

Click the Apps button on the right side of the workflow bar.

Figure 14-1 Apps toolbar

The Apps toolbar shows the Apps button, and all the Apps that are available. Note that the number of apps
displayed in your toolbar may differ from the apps shown in the figure above.

App Manager
The SCENE App Manager provides the following functionality:

l It allows installing new apps. For more information, see chapter Installing and Managing Apps on page
304.

l It gives an overview of the already installed Apps with additional information, like the version number.

l You can activate or deactivate already installed apps or remove them from the system. For more
information, see chapters Activating / Deactivating Apps on page 306 or Updating Apps on page 306.

l Developers can create an app package file (app in installation file) from their app files (with the Pack
App… button that will be displayed when checkbox Developer Options is enabled).
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Figure 14-2 App Manager

Use the button to uninstall an app from your system.

Installing Apps
To install a SCENE App, do one of the following:

1. Click the button and select an App package file (with the extension .fpp) from your hard
disk. In the dropdown menu of the button you will find:

n the possibility to install an App that is not packed to an App package but whose individual program
files are available within a folder on the hard disk.

n a link to the FARO 3D App Center to download new apps.

2. Drag & drop a downloaded App package file into SCENE.

3. Double-click an App package file in Windows Explorer.

If the App is already installed you will get an error message and the installation will be canceled.

SCENE also checks whether the App is compatible to the current version of SCENE. If the App and
SCENE are not compatible, the installation will be canceled.

After installation is complete, the App will be activated by default.
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Updating Apps
If you would like to install a new version of an already installed App, remove the former version of the app
from your system first, and then install the new version as described above.

Activating / Deactivating Apps
Use the Activate checkbox in the App Manager to enable or disable certain Apps at runtime.

Uninstalling Apps

Use the button to uninstall an App from your system.  
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Chapter 15: Advanced Functions

This chapter explains the use of local and global coordinates. The chapter also lists options that enhance the
software's speed and ease of use.

Coordinates
The coordinates of a point describe its exact location in relation to an agreed reference point. This reference
point is referred to as the origin of the coordinate system. With a scan, you receive points in the three-
dimensional space. Therefore, for a precise description of a measured point, you need the definition of the
origin and three other values which then indicate the relative location to this origin.

Depending on the choice of origin, you can decide between local coordinates or global coordinates. The
three other values can be set to different degrees, for example polar coordinates or Cartesian coordinates.

Local Coordinates
When scanning, the position of the scanner emerges as the natural origin of the coordinate system because
when recording the scan, all position specifications of the points are initially recorded in relation to the
scanner. This coordinate system is therefore described as the local coordinate system.

Due to the rotation of the scanner, its natural coordinate system is the polar coordinate system, with which
two angles and a distance value are used to determine the position.

Figure 15-1 Polar coordinates

For the single scan points created by the scanner, you can find the polar coordinates in the bottom status bar:
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Figure 15-2 Display the polar coordinates of a scan point

Cartesian Coordinates
In day to day use, you would generally use Cartesian coordinates, which have a direct reference to concepts
such as length, width and height, rather than polar coordinates.

Figure 15-3 Cartesian coordinates

The conversion of polar coordinates into Cartesian coordinates occurs automatically in SCENE. It is
completely independent from the location of the scanner or other influencing variables because it simply
converts between two types of representation at the same level. The converted coordinates are displayed
directly next to the polar coordinates in the bottom status bar:

Figure 15-4 Display of the Cartesian coordinates of a scan point

Global Coordinates
If a scan is viewed in its 3D position against another scan, local coordinates are no longer practical. If, for
example, two scans were recorded at different positions, the points within each one can have the same local
coordinates; they match reality but not one another.

Therefore, you should relate the coordinates to one reference point which remains the same for all scans.
This reference point is normally selected so that it is also possible to make a comparison using other
systems, for example a CAD system.

By doing so, you can view polar coordinates and Cartesian coordinates again. However, since the polar
coordinates do not produce a clearer representation than the Cartesian coordinates. They are therefore not
explained in any more detail here.

You can calculate the global coordinates using the local coordinates of a point if you know the relationship
between the local and the global coordinate system. To do this, you transfer the local coordinates into global
coordinates by tracing the movement which would make both coordinate systems match. You can
differentiate between two types of movement:
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If the local origin does not match the global origin, all coordinate specifications must be moved by the
difference between the local and global origin. This movement is also called Translation.

Figure 15-5 Translation

If the orientation of the coordinate axes is different, you must make them match with a Rotation.

Figure 15-6 Rotation

The rotation is described by a rotation axis and the corresponding angle of rotation. Generally speaking, any
rotation can be described with a single rotation axis. This rotation axis, however, does not necessarily match
one of the coordinate axes. It is difficult to show this rotation graphically. However, you can also split the
rotation up into three separate rotations around the coordinate axes. In this type of representation you can
imagine the result of a rotation more easily. SCENE saves the rotation internally with a single rotation axis
and a single angle of rotation. The user interface, however, displays the more comprehensible type of
representation of the three rotations around the coordinate axes.

NOTE:When splitting the rotation into three separate rotations around the coordinate axes, it is important
to have a defined sequence of the axes. If you first rotate around x, then around y, and finally
around z with some specific angles of rotation, you get different results than you would get with
the sequence x, z, y.
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Figure 15-7 Rotation of 90° around y and then 90° around z

Figure 15-8 Rotation of 90° around z and then 90° around y

In the user interface, SCENE uses the sequence x-y-z.

If you want to fine-tune a rotation on a per-axis basis, this default sequence may lead to some unexpected
behavior. For example, you want to place an object interactively and you are so far satisfied with the
orientation around the x-axis and the z-axis. Now you want to adjust the orientation around the y-axis. But
when you change the corresponding rotation angle, the object seems to move around a totally different axis.
This is caused by the fact that the rotation around the y-axis is applied in the middle of the two other
rotations. A more intuitive behavior is achieved when the rotation is last in the sequence. You can enforce
this more appropriate sequence, when you select Axis snap in the dialog (see below).

Local coordinates can always be transferred into global coordinates with a simple combination of these two
basic movements: translation and rotation. This transfer is also called Transformation. The sequence in
which the basic movements are executed is important because it makes a big difference whether you first
move and then rotate or first rotate and then move. In SCENE the rotation takes place first and then the
translation.

Coordinate Transformation of a Scan
To know the coordinate transformation of a scan, you must know its position and orientation. You can see
these values if you click the scan with the right mouse button in the structure view and select Properties in
the context menu.

On the Scan tab, the position and orientation are displayed in compact notation with a single angle of
rotation.
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Figure 15-9 Orientation displayed compactly

On the Transformation tab, you will see the same information displayed in a more intuitive way.
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Figure 15-10 Orientation displayed more intuitively

Of course, coordinate transformations cannot only be applied to local coordinates but can also be used to
convert from one global coordinate system to another. For example, you could use a hall coordinate system
as the first coordinate system, which has the origin in the corner of a hall and whose axes run along the
walls of the hall. On a greater scale, you could define a plant coordinate system whose origin lies in the
south-west corner of the plant premises and whose axes match the four points of a compass.

Then you only have to describe the transformation between the hall and the plant premises to automatically
obtain all the coordinate specifications within the hall in plant coordinates. SCENE proceeds from the inside
to the outside: first, the local coordinates within the scan are transformed into hall coordinates and these are
then converted into plant coordinates.

When using hierarchical transformations, you should note that the scan file only stores the local
transformation and not the global transformation. In the example above, this means that the scan file only
contains the relative position to the hall, not to the plant.
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Transformation and Registration
Registration of scans is always performed in the global coordinate system. If you have added
transformations in the scan folders, these transformations will of course also be used during the registration.
The result might not be the one you expect: the scans will be positioned on the same global coordinates as
they would have without the additional transformations. Only their local coordinates may differ.

If you want to add a transformation because you don’t want to use the coordinate system of the surveyor,
you should input it into the References folder.

Quick Change of Global Origin
For some tasks it might be helpful to use a different coordinate system than it is currently defined globally.
But as not all tasks need this specific coordinate system, it should be possible to switch between such
coordinate systems easily. For example imagine the examination of a robot cell in a plant. The global
coordinate system might be defined according to the plant, but now you would like to export scan points in
the local coordinate system of the robot cell. In this case you would like to switch to the local coordinate
system of the robot cell temporarily, and later switch back again. For this you need the position and
orientation of the robot cell within the plant and you put this transformation in a folder, and the mark this
folder to be used as definition for the global coordinate system.

When you want to work in the local coordinate system of a folder (or scans folder or scan), you activate its
transformation by Operations > Global System > Set as Global Origin in its context menu. The folder is
now marked with icon to indicate that it is currently defining the global coordinate system.

If you want to switch back to the original global origin, you may select Operations > Global System >
Clear Global Origin in the context menu of this folder.

Exemplary Driver Configuration for the Stereoscopic
Mode
This chapter describes how to enable OpenGL Stereo for an exemplary hardware and driver configuration.
Enabling OpenGL Stereo on comparable configurations should be similar. The stereoscopic mode will most
likely run with other driver versions, too. However, the menu structure may look different than described
here.

Exemplary hardware and driver configuration used for this description:

Hardware

l NVIDIA Quadro Graphic Card

l NVIDIA 3D Vision (Shutter Glasses)

l 120 Hz Monitor

l Compatible cable (HDMI 1.4 or Dual Link DVI)
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Driver

NVIDIA Quadro/NVIDIA Tesla Driver (Release 295.73)

Enable OpenGL quad buffering:

1. Open the NVIDIA system control. Right-click the Desktop and choose NVIDIA system control in the
context menu.

2. In the NVIDIA system control tool selectManage 3D Settings the structure tree on the left.

3. In the pane that is shown on the right set 3D OpenGL Stereo as global preset under global settings.

Figure 15-11 Enabling OpenGL quad buffering

Set the 120 Hz Monitor as the primary output device (only when using multiple displays):

4. Select Set up multiple displays in the structure tree on the left.

5. In the pane that is shown on the right, right-click the 3D monitor and selectMake this in the
Windows main display.
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Figure 15-12 Select primary display

Ensure that the monitor refresh rate is set to 120 Hz:

6. Select Change resolution in the structure tree.

7. Select the 3D monitor and then choose 120 Hz in the refresh rate dropdown box.
The refresh rate of 120 Hz is not available for some resolutions. If the refresh rate is not available for
any resolution, the display was not recognized as a 3D display. In this case refer to the manual of the
display.
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Figure 15-13 Select primary display

Activate NVIDIA vision:

8. Switch on the shutter glasses.

3DConnexion 3D Mouse Support
3DConnexion is a manufacturer of 3D mice for navigating and manipulating 3D content. The 3DConnexion
3D mice are supported by SCENE. Compared to the use of traditional mice and keyboards, such a 3D
mouse may make navigation in your 3D data much more intuitive and controllable.

Gently push, pull, twist or tilt the Controller Cap of the 3D mouse to pan, zoom and rotate in your 3D data.
Increase pressure to go faster or decrease pressure to make intricate adjustments.

When operating the Controller Cap, the 3D mouse acknowledges the selected camera mode. In fly mode, for
example, you can rotate the camera by twisting the cap. In camera pan mode, twisting it has no effect since
only left-right and up-down movements of the cap are recognized. When a 3D view tool such as the
measurement tool is selected, the 3D mouse operates in the examine mode. You can also use the 3D mouse
to rotate and zoom in the quick view and to pan and zoom in the planar view.

NOTE:When using a 3DConnexion Mouse, make sure to always use the latest drivers. You can download
them from www.3dconnexion.com. Refer to the 3DConnexion documentation for more
information on installing and setting up the 3D mouse.
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Predefined Commands
If the 3DConnexion Add-in for SCENE has been installed with the driver of the 3D mouse, the following
assignment of keys will be available (the number of available buttons varies with the available 3D mouse
model):

l Fit – Move the camera to show the whole scene in the 3D view; return to the initial zoom level in the
quick view and planar view.

l Menu – Open the settings menu of the 3D mouse

l T – Display the top view

l B – Display the bottom view

l L – Display the left view

l R – Display the right view

l F – Display the front view

l Bk – Display the back view

l Rot – Toggle rotation on/off

l Pan Zoom – Toggle pan and zoom on/off

Optionally, the following commands can be assigned to the function keys from 1 to 10 with the
3DConnexion settings tool. This tool is accessible from the Windows start menu or the task bar. See the
manual of the 3DConnexion mouse for more information.

l Switch to fly mode

l Switch to examine mode

l Switch to walk mode

l Switch to camera pan mode

l Set the rotation point automatically during movement

l Set the rotation point automatically after movement

l Don’t set the rotation point automatically

l Show the rotation point always

l Show the rotation point during movement

l Hide the rotation point
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Adjusting the 3D Mouse Behavior
To adjust the behavior of the 3D mouse and to access further functions, open the settings menu with the
Menu button on the 3D mouse.

Figure 15-14 3DConnexion Mouse – Settings

Rotate – Switch the rotation capability on/off

Pan and Zoom –Switch the pan and zoom capability on/off

Disable Rolling – Switch the roll axis – on/off

Invert 3D Mouse in Examine Mode – Invert all axes in the examine mode

Invert 3D Mouse in Quick View – Invert all axes in the quick view

Speed – Set the speed of movement

Fly Mode – Switch to fly mode

Examine Mode – Switch to the examine mode

Walk Mode – Switch to walk mode

Camera Pan Mode – Switch to camera pan mode

Rotation Point – Adjust the behavior of the rotation point. For more information, see Navigation Toolbar
(3D View only) on page 32.
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Chapter 16: Reference Handbook

This chapter explains the symbols and elements of SCENE.

Symbols in the Structure View
Note that this list is not exhaustive.

Symbol Meaning

Project Folder

Cluster

Scan

Virtual scan

Point

Sphere

Plane

Slab

Pipe

Scan path

Mesh, imported mesh object

Documentation

Region

Clipping box

View point

Picture
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Symbol Meaning

Overview map

Fit

Marker

Scans and Cluster

Fully loaded

Reference scan or cluster

Fixed scan or cluster

Locked Scan Manager

Global Origin

Missing file

Freestyle3D: Not processed completely

Freestyle3D: Recoding finished. Some single frames unloaded because of low
memory.

Freestyle3D: Post processing done

Freestyle3D: Reduced quality because of low machine performance

Freestyle3D: Capture or Replay

Freestyle3D: Next step is Replay

Freestyle3D: Next step is Optimize Scans

Freestyle3D: Next step is Color Smoothing

Freestyle3D: Next step is Stray Point Filter

Freestyle3D: Next step is Point Cloud Creation

Fitting

Active fit

Outdated active fit
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Symbol Meaning

Good quality

Compromised quality

Seriously compromised quality

Registration

Ignored for Place Scans

Object with automatically found correspondence

Object with user forced correspondences

Context Menu Entries for Objects in the Structure View

Plane
New

Reference on Folder Level – Place a copy of the selected object in the reference objects folder of the
current scan. The copy does not have any link to a fit object that may exist.

Reference on Workspace Level (i.e. Project Level) – Place a copy of the selected object in the
reference objects folder of the workspace. The copy does not have any link to a fit object that may
exist.

Intersection Point – Creates an intersection point on the plane at the spot determined by the mouse
pointer.

Plane with Border – Creates a new limited plane with border lines from the point selection that was
used to create the selected plane.

Slab By Plane – Creates a slab from the plane.

Aligned Clipping Box – Creates a new Clipping Box aligned to the selected plane.

Documentation – Attach a documentation object to the selected object.

View > 3D View – View the selected object 3D view.

Visible – Make the selected object visible or invisible.

Operations > Correspondences > Delete Correspondences – Deletes the correspondences of the selected
object. You can select to delete user forced, system found or anti-correspondences.

Alignment – modifies the overall orientation of the entire project according to the desired alignment of the
plane to a cardinal direction (north, south, east, west, ceiling, ground or custom).

Flip – turns the plane’s Normal for 180 degrees.
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Export… – Exports the selected object.

Delete – Deletes the selected object.

Properties... – Opens the properties dialog.

Limited Plane
New

Reference on Folder Level – Place a copy of the selected object in the reference objects folder of the
current scan. The copy does not have any link to a fit object that may exist.

Reference on Workspace Level (i.e. Project Level) – Place a copy of the selected object in the
reference objects folder of the workspace. The copy does not have any link to a fit object that may
exist.

Documentation – Attach a documentation object to the selected object.

View > 3D View – View the selected object 3D view.

View Scan Point Distance – Deviations from a level surface relation to

a plane are highlighted color.

Operations > Correspondences > Delete Correspondences – Deletes the correspondences of the selected
object. You can select to delete user forced, system found or anti-correspondences.

View Scan Point Distance – Analyze the evenness of the surface. Deviations of the scan points from the
plane will be highlighted different colors.

Export… – Exports the selected object.

Set Border from Selection – The border line of the plane is replaced by the border line of the selection.

Delete – Deletes the selected object.

Rename – Renames the selected object.

Plane Fit
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Flip – turns the plane’s Normal for 180 degrees.

Delete – Deletes the fit object.

Rename – Renames the fit object.
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Properties – Opens the properties dialog.

Constrained Plane Fit
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Sphere
Locate – Displays the selected object in the center and enlarges the active view.

New

Reference on Folder Level – Place a copy of the selected object in the reference objects folder of the
current scan. The copy does not have any link to a fit object that may exist.

Reference on Workspace Level (i.e. Project Level) – Place a copy of the selected object in the
reference objects folder of the workspace. The copy does not have any link to a fit object that may
exist.

Fit – Only available if a selection of scan points exists. Creates a new fit from the selected scan points.
Both the sphere position and the sphere radius are ascertained from the scan points.

Fit (fixed radius) – Only available if a selection of scan points exists. Creates a new fit from the
selected scan points with a fixed preset sphere radius. The sphere position is ascertained from the scan
points.

View > 3D View – View the selected object 3D view.

Operations > Correspondences > Delete Correspondences – Deletes the correspondences of the selected
object. You can select to delete user forced, system found or anti-correspondences.

Update Fit – Recalculates the fit of the sphere.

Export... –

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.
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Sphere Fit
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Region
New

Reference on Folder Level – Place a copy of the selected object in the reference objects folder of the
current scan. The copy does not have any link to a fit object that may exist.

Reference on Workspace Level (i.e. Project Level) – Place a copy of the selected object in the
reference objects folder of the workspace. The copy does not have any link to a fit object that may
exist.

Documentation – Attach a documentation object to the selected object.

Select – The selection that was used to create the region is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Import/Export – Export the region as object.

Delete – Delete the region object. The scan points are not deleted.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Point
Locate – Displays the selected object in the center and enlarges the active view.

New

Reference on Folder Level – Place a copy of the selected object in the reference objects folder of the
current scan. The copy does not have any link to a fit object that may exist.
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Reference on Workspace Level (i.e. Project Level) – Place a copy of the selected object in the
reference objects folder of the workspace. The copy does not have any link to a fit object that may
exist.

Documentation – Attach a documentation object to the selected object.

View – Opens a new 3D view of the point.

Set Rotation Point – Sets the rotation point to the center of the scan point.

Visible – Make the selected object visible or invisible.

Operations > Correspondences > Delete Correspondences – Deletes the correspondences of the selected
object. You can select to delete user forced, system found or anti-correspondences.

Export… – Exports the selected object.

Delete – Deletes the selected object.

Properties – Opens the properties dialog.

Point Fit
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Pipe
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.
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Properties – Opens the properties dialog.

Pipe Fit
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Line
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Line Fit
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.
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Properties – Opens the properties dialog.

Rectangle
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Rectangle Fit
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Scan
Visible – Make the selected object visible or invisible.

View

3D View – View the scan 3D view.

Planar – View the scan planar view.

Quick – View the scan quick view.

Locate – Resumes the initial perspective of the view. 3D view the rotation point will be set to the position
of the scanner.

SCENE User Manual
Chapter 16: Reference Handbook

SCENE User Manual (2024.0) Page 327 of 372



Loaded – Loads the scan points of the scan. Here a check mark shows whether the scan points of a scan are
loaded.

Process Scan – Opens the Configure Processing page to configure the settings for processing and start
processing.

Point Cloud – Create or delete a Scan Point Cloud from the scans within the scan folder or cluster.

Create Scan Point Cloud – Create a Scan Point Cloud from the scans within the scan folder or cluster.

Delete Scan Point Cloud – Delete a Scan Point Cloud from the scans within the scan folder or cluster.

Send to WebShare Cloud – Export the Point Cloud to WebShare. An account is required.

Export

Image – Obtains an overview image from the scan points and saves it the file system the same folder as
the scans.

Objects – Export the objects of this scan.

Scan Points –

l Export Scans – unordered to export the scan points of the selected scan.

l Export Scan Point Clouds – ordered to export the point cloud of the selected scan.

As Project – Create a new SCENE project, or a new ReCap project. A dialog opens in which you can
select the export format, a file name, and the location in which the new project shall be saved.

Delete – Deletes the scan from the workspace. The associated file is not deleted.

Properties – Opens the properties dialog.

For Unprocessed Hand-held Scans
Operations > Registration

Level

l by picking one point, if the plane has an even surface.

l by picking three points, if the plane is uneven, or if you need a high accuracy.

Process the scan – Processes the steps Replay, Optimize Scans, Color Adjustment, and Stray Point Filtering.

Global System > Set as Global Origin – Select to work the local coordinate system of the scan. The scan
will be marked with a red G to indicate that it is currently defining the Global Coordinates system.

Create virtual scans – creates one or several virtual scans from a scan.

For Processed Hand-held Scans
Operations > Registration
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Level

l by picking one point, if the plane has an even surface.

l by picking three points, if the plane is uneven, or if you need a high accuracy.

Fixed Scan – Mark the scan alignment as fixed and exclude it from further automatic registration
attempts.

Reference Scan – Set the scan as reference scan.

Find Objects – Detect checkerboards, spheres, planes, corner points, rectangles or lines the scan.

Filter – Apply filters to the scan.

Preprocessing > Preprocess Scan – Opens the preprocess menu dialog. With the preprocess option you
may apply a series of processing steps such as filters, automatic object detection or scan registration to the
scan. The scan is automatically loaded, processed, saved and unloaded again.

Correspondences > Delete Correspondences – Deletes the correspondences of the scan and of its objects.
You can select to delete user forced, system found or anti-correspondences.

Preprocessing > Preprocess Scan – Opens the preprocess menu dialog. With the preprocess option you
may apply a series of processing steps such as filters, automatic object detection or scan registration to the
scan. The scan is automatically loaded, processed, saved and unloaded again.

Correspondences > Delete Correspondences – Deletes the correspondences of the scan and of its objects.
You can select to delete user forced, system found or anti-correspondences.

Delete inactive Fits – Deletes all inactive fit objects.

Color/Pictures

Apply Pictures – Apply the color information of the picture onto the scan. Position, orientation, and
zoom factor of the camera are already known. This command is only available if the pictures reside
inside a scan.

Adjust Picture Angles – Adjust the picture angles.

Export All Pictures – Exports all pictures of the scan (if the scan has been recorded color). Opens a
dialog to select the storage location and the export format of the pictures. You can select between
Original format and jpg. Original Format will export the pictures without changing their format; jpg
will convert the pictures and save them as JPG.

Import All Pictures – Opens a dialog to select the storage location of the pictures you want to import.
This option is only available for scans which already contain pictures.

Color Contrast Filter – Enhances the dynamic range of the color pictures.

Restore Grey Image – Remove the color information and restore the original reflectance values.

Replace Color Overlay – Import a manually edited picture to replace the scan’s initial color overlay
with this picture. See chapter for more information.

Export Color Overlay – Export the scan's color overlay as a picture to your local hard drive.

Point Cloud Tools – Create a scan point cloud from the scan or delete an existing scan point cloud.
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Global System  > Set as Global Origin – Select to work the local coordinate system of the scan. The
scan will be marked with a red G to indicate that it is currently defining the Global Coordinates system.

Create virtual scans – creates one or several virtual scans from a scan. Virtual scans are required if
you want to export scan projects made by hand-held scanners to WebShare.

Import / Export

Export Objects – Export the objects of this scan.

Export Scan Points – Export the scan points of the selected scan. This applies to the points of the scan
only and does not export the scan points of any possible scan point cloud.

Export Scan Point Cloud – Export the scan point cloud of the scan.

Export as Project – Create a new SCENE project, or a new ReCap project. A dialog opens in which
you can select the export format, a file name, and the location in which the new project shall be saved.

Export Image – Obtains an overview image from the scan points and saves it the file system the same
folder as the scans.

Export Compensation – Write compensation data to a file.

Export Scan Parameters – Export the parameters of the scan.

Import Compensation – Import compensation file and use immediately. You may not be able to
import a compensation if the scan points were changed by a filter beforehand and have not been saved
again.

Save Objects Scan – Save the objects of the scan the scan file.

Delete – Deletes the scan from the project

Scan Fit
Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Scans Folder / Cluster
Visible – Make the selected object visible or invisible.

View – Open the scans and objects of the scan folder, the correspondence view, the 3D view or the structure
view.

Locate – Resumes the initial perspective of the view. 3D view the rotation point will be set to the position
of the scanner.
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Loaded – Loads the scan points of the scan. Here a check mark shows whether the scan points of a scan are
loaded.

Process Scan – Opens the Configure Processing page to configure the for processing and start processing.

Point Cloud – Create or delete a Scan Point Cloud from the scans within the scan folder or cluster.

Create Scan Point Cloud – Create a Scan Point Cloud from the scans within the scan folder or cluster.

Delete Scan Point Cloud – Delete a Scan Point Cloud from the scans within the scan folder or cluster.

New – Create a new Cluster within the scan folder.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Export

Scans –

l Export Scans – ordered to export the scan points of the selected scan.

l Export Scan Point Clouds – unordered to export the point cloud of the selected scan.

As Project – Create a new SCENE project, or a new ReCap project. A dialog opens in which you can
select the export format, a file name, and the location where the new project shall be saved.

Images – Obtains panorama images of the planar view of each scan and saves these images the file
system the same folder as the scans.

Delete – Deletes the scan folder and all the scans it from the project. The files belonging to the scans are not
deleted.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Scan Manager
Lock all – locks the Scan Manager of the cluster and the Scan Managers of subordinated clusters.

Unlock – The cluster and all its superordinate and subordinate clusters will be unlocked.

Unlock All – unlocks the Scan Manager of the cluster and the Scan Managers of subordinated clusters.

Delete – Deletes the Scan Manager.

Rename – Renames the Scan Manager.

Properties – Opens the Scan Manager.
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Virtual Scan (3D Picture)
The virtual scan is treated as a normal laser scan.

Visible – Make the selected object visible or invisible.

View > 3D View – View the scan 3D view.

Locate – Resumes the initial perspective of the view. 3D view the rotation point will be set to the position
of the scanner.

Export

Image – Obtains an overview image from the scan points and saves it the file system the same folder as
the scans.

Objects – Export the objects of this scan.

Scan Points – Export the scan points of the selected scan. This applies to the points of the scan only
and does not export the scan points of any possible scan point cloud.

As Project – Create a new SCENE project, or a new ReCap project. A dialog opens in which you can
select the export format, a file name, and the location where the new project shall be saved.

Delete – Deletes the scan from the project. The associated file is not deleted.

Properties – Opens the properties dialog.

3D Picture Fit (Fit of a Virtual Scan)
Select – The selection that was used to create the fit object is reactivated. The selection combination mode
determines how the new selection results from the existing selection and the reactivated selection.

Active – A black check mark indicates whether this fit object is the active fit object of the corresponding
object, i.e., whether it is the one that determined the properties of the corresponding object. An object can
have several fit objects, of which one at the most can be active.

Update – Recalculates the object parameters. The basis for this is again the selection that was also used to
create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Correspondences

Figure 16-1 Context menu: Scan folder > Operations > Correspondences
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Delete Correspondences – Deletes correspondences of the scan folder, its scans and of all objects that
belong to its scans. You can select to delete user forced, system forced, system found or anti-
correspondences.

Force Current – Force all already existing correspondences of the scan folder.

Force by Manual Target Names – Forces correspondences by manually created reference name.

Preprocessing > Preprocess Scans – Opens the preprocess menu dialog. With the preprocess option you
may apply a series of processing steps such as filters, automatic object detection or scan registration to the
scans of the scan folder. The scans are automatically processed and saved.

Color/Pictures – Apply the pictures to all the scans within the folder or apply the color contrast filter.

Delete inactive Fits – Deletes all the inactive >.

Global System > Set as Global Origin – Select to work the local coordinate system of the scan folder. The

scan folder is now marked with a red G to indicate that it is currently defining the global coordinate
system.

Import/Export

Export Objects – Export objects. Note, scans need not to be loaded and are therefore not loaded
automatically.

Export Project – Exports the entire scan project. Select, if the new scan project will be used in SCENE
or ReCap. Then, select the target location and a project name.

Export Images – Obtains panorama images of the planar view from all the scans in the project. The
scans are loaded one after the other, the panorama image is created, then saved and then unloaded
again.

Export Positions –Saves the position specifications of all scans and reference objects.

Assemble Meshes –

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Visibility

3D Visibility – Opens the dialog with the default visibility for quick view and 3D views.

Planar View Visibility – Opens the dialog with the default visibility for the planar view.

Layer Manager – Opens the dialog box of the layer manager.
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Viewpoint

Figure 16-2 Context menu: Viewpoint

New – Create a new Point, Sphere, Checkerboard, Circular Flat Target, Corner Point, Plane, Slab,
Documentation Object, Folder or Scan Folder in the project.

Activate – Go to the selected viewpoint the current 3D view.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Properties of Objects in the Structure View
If you right-click an object in the structure view, a context menu opens from which you can select entry
Properties. This menu entry opens a dialog. In this chapter you can find an overview of the different objects
in the structure view.

Scan Project
Name – The name of the object. The green symbol at the object name indicates that corresponding objects
have been found. If corresponding references have not been found, no symbol will be displayed.

Layer – The representation layer on which the object is located.

Select active layer – Enters the currently active representation layer.

Assign layer to all contained objects – All the scans take on the representation layer of the scan project.

Transformation Tab
Position – The translation portion of the transformation.

X – To key in a transformation in the x direction.

Y – To key in a transformation in the y direction.

Z – To key in a transformation in the z direction.

SCENE User Manual
Chapter 16: Reference Handbook

SCENE User Manual (2024.0) Page 334 of 372



Scroll bar – Set the transformation using the mouse. The direction of the transformation will be the x,
y, or z coordinate that is highlighted in yellow.

Increments – Set the increment for the scroll bar.

Rotation Angle – The angle of rotation if the rotation axis is split along the coordinate axes.

X – The angle of rotation around the x-axis.

Y – The angle of rotation around the y-axis.

Z – The angle of rotation around the z-axis.

Scroll bar – Set a new angle of rotation.

To change a value, you either enter the required value directly into the appropriate field, or you first
select the field and then use the corresponding slider to change the value step by step. You can set the
increment using the Increments dropdown box. If you hit the edge with the slider, simply reselect the
field and the slider will return to the center without you losing your previous changes.

Increments – Set the increment for the scroll bar.

Axis snap – If checked, you can change the rotation for the current axis independently from the others.
This is achieved by changing the order in which the rotations are applied.

Global Coordinates – If checked, coordinates are displayed in the global coordinate system. Otherwise,
they are displayed in the coordinate system of the scanner.

GPS Reference Tab
Define the reference coordinate system by entering the GPS or UTM position.

Scan Folder

General Tab
Name – The name of the scan folder.

Layer – The representation layer in which the scan folder is located.

Select active layer – Enters the currently active representation layer.

Assign layer to all contained objects – All the scans of the scan folder take on the representation layer of
the scan folder.

Transformation Tab
Position – The translation portion of the transformation.

X – To key in a transformation in the x direction.

Y – To key in a transformation in the y direction.
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Z – To key in a transformation in the z direction.

Scroll bar – Set the transformation using the mouse. The direction of the transformation will be the x,
y, or z coordinate that is highlighted in yellow.

Increments – Set the increment for the scroll bar.

Rotation Angle – The angle of rotation if the rotation axis is split along the coordinate axes.

X – The angle of rotation around the x-axis.

Y – The angle of rotation around the y-axis.

Z – The angle of rotation around the z-axis.

Scroll bar – Set a new angle of rotation.

To change a value, you either enter the required value directly into the appropriate field, or you first
select the field and then use the corresponding slider to change the value step by step. You can set the
increment using the Increments dropdown box. If you hit the edge with the slider, simply reselect the
field and the slider will return to the center without you losing your previous changes.

Increments – Set the increment for the scroll bar.

Axis snap – If checked, you can change the rotation for the current axis independently from the others.
This is achieved by changing the order in which the rotations are applied.

Global Coordinates – If checked, coordinates are displayed in the global coordinate system. Otherwise,
they are displayed in the coordinate system of the scanner.

Folder Tab
Cluster – Determine the scan folder as a cluster.

Reference Cluster – Determine the cluster as the reference cluster

Fixed Cluster – Mark the cluster alignment as fixed and exclude it from further automatic registration
attempts.

Scan Manager

NOTE: You can resize the Scan Manager dialog to display all columns.

Scan Manager Tab
Name – The name of the Scan Manager.

Managed by – Name of the superordinate Scan Manager.

Locked – as soon you finished your work with this cluster, you can lock its Scan Manager.

Sub Manager – List of the subordinate Scan Managers.
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The Scan Manager also informs whether external references were used for the registration.

The traffic lights next to the Scan Managers indicate whether they contain good or failed Scan Fits. If a
traffic light next to a Scan Manager is red, this means that this Scan Manager contains bad Scan Fits. Green
means that all the quality criteria are met. Amber shows that at least one quality criterion is somewhat
compromised. If there is a symbol next to a Scan Manager or a Scan Fit, this means that registration
could not be executed, maybe because of missing references.

If you want to see the critical fits of a subordinate Scan Manager, double-click this Scan Manager to open it.
Switch to the tab Scan Results.

Scan Results Tab
The tab Scan Results gives you a list of all Scan Fits managed by the Scan Manager and shows the overall
quality of each registration. This is symbolized by a traffic light too. Double-clicking on a fit object in the
list opens its properties dialog.

The average tension of each registration is calculated in theMean Target Tension column of this table: the
lower the value, the better the registration result. Here you can easily see which registrations failed or which
registration results are bad (in this example the first two Scan Fits have an amber traffic light, so they seem
not to be optimal). To identify the critical reference pairs which are responsible for the bad fit, you can
switch to tab Ref. Tensions.

Correspondence View – opens the correspondence view with all the scans that are managed by the Scan
Manager.

Correspondence Split View – opens the correspondence split view.

You can also open both views by right-clicking the cluster node in the structure view and selecting View >
Correspondence View or View > Correspondence Split View.

Scan Point Errors
Tab Scan Point Errors shows all reference cluster pairs used for the scan registration.

Mean – describes the discrepancy between the two corresponding referenced clusters.

Full Hierarchy – When activated, the reference pairs of all >s will be displayed.

Overall Statistics

Error – The resulting error between scans calculated by measuring the distances between scan points.

<4 mm – Deviation smaller than 4 mm, displayed percent. This value gives a quick overview on the
overall quality of the registration.

You can go directly to a scan point error by double-clicking it. The corresponding view is opened and the
connection is highlighted.

Target Tensions Tab
Tab Target Tensions shows all reference pairs used for registration, sorted by their tension.
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Tension – describes the discrepancy in the global coordinate system between the position and the
orientation of the two corresponding reference objects Scan 1 and Scan 2. With reference points in the
distance between the positions of the two reference points serves as input for the calculation of the tension.
With planes, slabs or pipes the position and the direction of the objects serve as input for the calculation of
this value.

Values close to zero indicate a good registration result. Here, you can easily identify reference pairs which
are causing problems in the registration. Clicking on the scan name selects the corresponding reference in
this scan, double-clicking opens the reference’s properties.

Full Hierarchy – When activated, the reference pairs of all > will be displayed.

Weighted Statistics

Error – The resulting error between scans calculated by measuring the distances between scan points.

Deviation – Deviation over all tensions.

Min. – Minimum tension

Max. – Maximum tension

You can go directly to a target tension error by double-clicking it. The corresponding view is opened and
the selected object is highlighted. If you right-click a target tension in the Scan Manager and select Locate
in <scan_name>, you can locate the target tension in the scan you want.

Scans
Depending on the used scanner type, the scan properties dialog might have different tabs. On the following
pages the scan properties dialog will be described for scans recorded with the FARO Laser Scanner.

General Tab
Name – Name of the scan. Scans cannot be renamed.

Layer – The representation layer in which the scan is located.

Select active layer – Enters the currently active representation layer.

Assign layer to all contained objects – All the objects of the scan take on the representation layer of the
scan.

Scan Tab
Size – The number of columns and rows. If a scan is loaded reduced in resolution, the reduced number of
columns and rows is displayed and, light gray underneath, the complete number of columns and rows.

Data loaded –Indicates whether the scan is loaded.

Reference Scan –Indicates whether the scan is used as a reference scan for registration.

Scan Fixed – Mark the scan alignment as fixed and exclude it from further automatic registration attempts.
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Scanner Dist. Range – Range of the scanner.

Scanner Position – The position of the scanner with the mirror being the point of origin.

Orientation Axis – Rotation axis of the scan.

Orientation Angle – The scan’s angle of rotation.

Recording Date – The time the scan was recorded.

Scan Origin Info – Additional information on the origin of the scan, for example, where it was recorded
and information about issues (scanner warnings or errors) that occurred during recording of the scan.

Info – Further details that were provided when recording.

Scan Area Tab
Selected Profile – The scan profile that was selected for the recording of the scan (only available for FARO
Focus scanners).

Angular Area – The recorded angular area.

Vertical – The vertical angular area.

Horizontal – The horizontal angular area.

Resolution – The resolution of the scan, measured fractions of the maximum resolution.

Quality – The quality setting that was selected for the recording of the scan. This setting has influence on
the quality respectively on the noise of the scan data. The corresponding measurement rate is displayed too
(in 1000 points per second).

Filters

Clear Sky – Checked if the Clear Sky Filter was applied during the recording of the scan.

Clear Contour – Checked if Clear Contour Filter was applied during the recording of the scan.

Scan Size – Number of rows and columns.

Resolution – The resolution of the scan. You can select between:

pt/360°, pt/°, °/pt, ‘/pt, “/pt, mm/10m, in/30ft.

File Size – File size of the scan.

Distance Range – The distance range that was selected for the recording of the scan (only available for
FARO Focus Laser Scanner V7 or greater).

Operation Tab
This tab is only available for scans taken with the FARO Laser Scanner LS, the FARO Laser Scanner
Photon or the FARO Focus Laser Scanner.

Name – The name of the project or the order.

Company – The client’s company name.
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Division – The client’s or order’s division.

Subdivision – The client’s or order’s sub-division.

Area – The scanned area.

Info – Additional information.

Min. Reflection – The reflection value limit set when recording.

Project Tab
This tab is only available for scans taken with the FARO Focus Laser Scanner.

This tab shows information about the scan project. This information was given before the scan was
recorded.

Project Name – The name of the project / or sub-project that was assigned to the scan.

Customer – information about the potential project customer.

Additional information – Additional information provided for the project.

Operator Tab
The FARO Focus Laser Scanner allows to create operator profiles with names, contact details and further
information. While scanning, it also allows to specify the operator who is currently working with the
scanner. This information will then be saved in the meta data of the recorded scans and is shown on this tab.
It might be useful for the person who is post processing the scans; especially when there are several scanner
operators working on the same scan project.

You can still add or change this information when processing the scans SCENE.

Scanner Info Tab
Scanner – The name of the scanner.

Revision – The revision number which is allocated during servicing.

Scanner Type – The type of scanner.

Serial Number – The serial number of the scanner.

Range – The range of the scanner.

Compensation – The name of the compensation file.

Scanner Settings Tab
This tab contains some compensation data of the scanner.
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Sensors Tab
Inclinometer

Use – Enable or disable the use of the inclinometer data for registration.

Inclinometer Axis – Shows the up direction of the inclinometer in the scan system.

Inclinometer Angle – Shows the angle between the z-axis and the inclinometer axis in the scan system.

Ignore Measurement – Overwrites the inclinometer axis and the angle with values that level the scan.

Transformation mismatch – Shows the difference between the z-axis defined by the inclinometer and
the z-axis defined by the scan’s transformation.

Compass

Use – Enable or disable the use of the compass data for the correspondence search.

Compass Axis – Shows the orientation of the scan in the scan system.

Compass mismatch – Shows the difference between the orientation defined by the compass and the
orientation defined by the scan’s transformation.

Altimeter

Use – Enable or disable the use of the altimeter data for correspondence search.

Measured Height – The height measured by the altimeter of the scanner based on a given reference
height.

Global Positioning System (GPS) – the values measured by the scanner’s GPS sensor.

Position (lat./long.) – GPS position longitude and latitude.

Position (UTM) – GPS position UTM coordinates.

Measured Height – Height above sea level.

Transformation mismatch – Shows the difference between the position defined by the GPS data and
the position defined by the scan’s transformation.

Advanced – Shows the raw data from the GPS sensor.

Place using Sensors – Restores the initial placement of the scan according to the measurements of the
various sensors.

Camera Tab
This tab is only available for scans taken with the FARO Laser Scanner LS or the FARO Laser Scanner
Photon.

Camera Mount – Type of the camera bracket that has been used for taking a colored scan.
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Non-winding – The old, fixed type for scans taken with FARO Photon and LS scanners and the type
for all scans taken with FARO Focus Laser Scanner.

No parallax – The new mount with the sliding mechanism.

No parallax, with pins – The camera mount with the sliding mechanism and pins that fit into the
bushings on the side of newer FARO Laser Scanners. Note that older models of the FARO Laser
Scanner are not equipped with these bushings.

Camera Orientation – Camera orientation

Top – The camera was fixed at the top position of the mount bracket: Therefore the camera was
pointing slightly upwards when taking pictures.

Horizontal – The camera was fixed at the lower position of the mount bracket and therefore oriented
horizontally.

Exposure

Manual – Exposure time, exposure index, and f-number is set directly at the camera.

By Scanner – The scanner determined a balanced exposure setting.

Correction – Correction factor for the exposure that has been determined by the scanner.

Color Tab
This tab is only available for scans taken with the FARO Focus Laser Scanner.

Scan with Color – Checked if the scan was recorded colored.

Exposure Metering Mode – The exposure metering mode used to take the color pictures when colored
scan recording was switched on:

Even Weighted Metering – The light information coming from the entire SCENE without giving
special weighting to a particular area was used to determine the exposure of the camera.

Horizon Weighted Metering – The light information coming from the horizon was used to determine
the exposure setting of the camera.

Zenith Weighted Metering – The light information coming from above the scanner was used to
determine the exposure setting of the camera.

Scan Fit

Scan Fit Tab
Scan Name – Name of the scan. Scans cannot be renamed.

Name – The name of the fit object.

Transformation

Position – The calculated position of the scan.
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Orientation Axis – The calculated rotation axis of the scan.

Angle – The calculated angle of rotation of the scan.

Click the Used Settings button to check which registration method was performed.

Global Coordinates – If checked, coordinates are displayed in the global coordinate system; else they are
displayed in the coordinate system of the scanner.

Target Tensions Tab
This tab is displayed when you have run a target-based registration.

Normalized Tension – In most cases, this value is identical to the Point Distance (see below). It is only
different if you have reference coordinates based on GPS measurements. For example if you use a GPS
device to measure the position of a sphere, the position of the spheres is not very accurate. As a
consequence, the > cannot be as good as it normally is, and would show very large deviations.

In such cases the indicator of the > quality should not base on this, therefore the Normalized Tension puts a
lower weight on the GPS reference positions, leading to smaller numbers for the tension.

Point distance – The standard deviation of the distance between the local reference points and their
corresponding references.

The traffic light indicates the quality of this individual criterion:

green: < 10 mm

orange: ≥ 10 mm and ≤ 20 mm

red: > 20 mm

Point drift – The mean value of the deviations between the local reference points and their corresponding
references. In contrast to viewing purely the distance, the direction of the deviation is also taken into
account here. Deviations can therefore cancel each other out.

The traffic light indicates the quality of this individual criterion:

green: < 1 mm

orange: ≥ 1 mm and ≤ 5 mm

red: > 5 mm

Long. mismatch – The standard deviation of the longitudinal distance between the local reference points
and their corresponding references. The longitudinal distance is the difference between the distance values
to the scanner.

The traffic light indicates the quality of this individual criterion:

green: < 10 mm

orange: ≥ 10 mm and ≤ 20 mm

red: > 20 mm
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Angular mismatch – The standard deviation of the angular distance between the local reference points and
the corresponding references. The angles are measured with reference to the local coordinate system of the
scanner.

The traffic light indicates the quality of this individual criterion:

green: < 0.08°

orange: ≥ 0.08° and ≤ 0.17°

red: > 0.17°

Orthogonal mismatch – The standard deviation of the orthogonal distance between the local reference
points and the corresponding references. This is a way to express the angular mismatch as distance
mismatch.

Inclinometer mismatch – Angular difference between the calculated orientation axis and the axis defined
by the inclinometer.

The traffic light indicates the quality of this individual criterion:

green: < 1°

orange: ≥ 1° and ≤ 5°

red: > 5°

List of targets used

Object – The name of the reference object. If reference object is a specific real reference, the full path
of the corresponding object will be displayed; if referenced object is a virtual mean reference (mean
reference from several scans) only its name will be displayed.

Distance – The distance between the local reference point and the corresponding global reference.

Long. – The longitudinal distance between local reference point and the corresponding global reference.

Angular – The angular distance between the local reference point and the corresponding global
reference.

Orth. – The orthogonal distance between the local reference point and the corresponding global
reference.

The traffic light here is green if a minimum of three references (including the inclinometer) are
available; it’s red if there are less than three references.

When you press the View button, a 3D view will open which gives you an overview of the placement of the
scanner and the local and global references.
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Figure 16-3 Overview of references

Scan Point Tensions
This tab is displayed when you have run a cloud-to-cloud or a top-view-based registration. It is also
displayed when you have run a target-based registration and marked checkbox Calculate scan point
statistics.

Cluster/Scan x– In these two columns the point errors of each cluster or scan compared to every other scan
are displayed.

Mean [mm] – The mean point error between a pair of clusters or scans.

< 4mm [%] – The percentage of a pair of clusters or scans where the point error is more than 4 mm.

Overlap [%] – The percentage of a pair of clusters or scans where the overlap is higher than 90%.

Used Points – Number of scan points that were used to calculate the cloud-to-cloud registration.

Details – If you click this button a dialog opens that shows more details of the scan point tension.

Overall Statistics

Mean [mm] – The overall mean point error between pairs of scans or clusters.

< 4 mm [%] – The overall percentage of pairs of scans or clusters where the point error is more than
4 mm.

Constraints Object
Name – The name of the constraints object.

Scanpoint Distance – A quality parameter of a plane.

Max – The scan point distance of the plane with the highest distance. The traffic light indicates the
quality of this individual criterion. It is green at values <4 mm, red at values >20 mm and orange
between them.

Mean – The mean value of all managed planes. The traffic light indicates the quality of this individual
criterion. It is green at values <4 mm, red at values >20 mm and orange between them.
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Constraint Error – Constraints are implemented by functions that are zero if the constraint is met.
Deviations from zero are called Constraint Error.

Max – Highest value of all constraint functions. The traffic light indicates the quality of this individual
criterion. It is green at values <2.2e-013, red at values >1e-005 and orange between them.

Mean – Mean value of all constraint functions. The traffic light indicates the quality of this individual
criterion. It is green at values <2.2e-013, red at values >1e-005 and orange between them.

Planes – Planes used to define constraints.

Plane – Name and path of the plane.

Fixed – Fixed planes are only used to define the constraint but will not be changed.

Constraints – List of pairs of planes and the constraint chosen for this pair.

Plane 1 – First plane.

Plane 2 – Second plane.

Description – The constraint chosen.

Constrained Plane Fit
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; else they are
displayed in the coordinate system of the scanner.

Plane Name – Name of the corresponding plane

Name – Name of the fit (by default named according to the constraints object that manages this fit)

Normal – The orientation determined by the fit. The orientation is given by the direction which stands
perpendicular to the plane.

Position – The position determined by the fit.

Number of scan points – The number of scan points in the selection used for the fit. The traffic light
indicates the quality of this individual criterion. It is green at values >80, red at values <20 and orange
between them.

Scan point distance – The standard deviation of the distance of the scan points from the calculated plane.
The traffic light indicates the quality of this individual criterion. It is green at values <4 mm, red at values
>20 mm and orange between them.

Scan point drift – The average distance of the scan points from the calculated plane. With this, the scan
points above the plane can be averaged out with the scan points below the plane. The traffic light indicates
the quality of this individual criterion. It is green at values <1 mm, red at values >5 mm and orange between
them.

Last Constraint – The name and path of the last constraints object that has been used to manage this fit.
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Measurement

General Tab
Name – The name of the object.

Layer – The representation layer on which the object is located.

Measurement Properties Tab
Overall Distance – Measured distance. When measuring between two points, the result will be the point-to-
point distance. When using a plane or rectangle, the measurement is automatically taken perpendicular to
this plane or rectangle. Note that negative distances will occur if the normal of the plane or rectangle points
opposite direction.

Vertical Distance – Vertical part of the point-to-point distance.

Horizontal Distance – Horizontal part of the point-to-point distance.

Along X – The distance along the x-axis of the point-to-point distance.

Along Y – The distance along the y-axis of the point-to-point distance.

Show Distance – Select which values shall be shown in the views.

Measure Objects –List of objects that were used for the measurement. List is empty for point-to-point
measurements.

Picture

General Tab
Name – The name of the object. The green traffic light right to the object name indicates that
corresponding objects have been found in other scans. If corresponding references have not been found, no
traffic light will be displayed.

Layer – The representation layer on which the object is located.

Picture Properties Tab
Spherical – A check-mark to indicate spherical pictures.
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Pipe

General Tab
Name: The name of the object. The green traffic light to the right of the object name indicates that
corresponding objects have been found in other scans. If corresponding references have not been found, no
traffic light will be displayed.

Use for Place Scans, Correspondence Search and Automatic Name: The object will be used for
registration. Correspondence relationships to this object are enabled and its name will automatically be
changed if corresponding objects have been found or the name of a corresponding object has been changed.
Local reference objects will have this option activated by default if their name has not been manually
changed by the user.

Use for Place Scans and Correspondence Search: The object will be used for registering scans.
Correspondence relationships to this object are enabled but its name will not be changed automatically. This
means that the name of this object is fixed and corresponding reference objects to other scans will be named
accordingly. Global reference objects and local references which have been (re-)named manually will have
this option activated by default.

Use for Place Scans: The object will only be used for registering scans but excluded from any
correspondence search. Its name will not be changed automatically.

Ignore for Place Scans: The object will not be used for registering scans and is excluded from any
correspondence search. Its name will not be changed automatically. These options are relevant for the
automatic correspondence search and for the registration of scans which are only available in SCENE.

Layer: The representation layer on which the object is situated.

Pipe Properties Tab
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; else they are
displayed in the coordinate system of the scanner.

Pipe Name – The name of the pipe.

Axis – The axis of the pipe.

Position – The position of the pipe.

Diameter – The diameter of the pipe.

Length – The length of the pipe.
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Pipe Fit
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; else they are
displayed in the coordinate system of the scanner.

Pipe Name – The name of the corresponding pipe.

Name – The name of the fit object.

Axis – The axis determined by the fit.

Position – The position determined by the fit.

Diameter – The diameter determined by the fit.

Length – The length determined by the fit.

Number of scan points – The number of scan points in the selection used for the fit.

The traffic light indicates the quality of this individual criterion:

green: >80 points

orange: ≥ 20 and ≤ 80 points

red: <20 points

Scan point distance – The standard deviation of the distance of the scan points from the calculated pipe.

The traffic light indicates the quality of this individual criterion:

orange: < 4 mm

orange: ≥ 4 mm and ≤ 20 mm

red: >20 mm

Scan point drift – The average distance of the scan points from the calculated pipe. With this, the scan
points inside the pipe can be averaged out with the scan points outside the pipe.

The traffic light indicates the quality of this individual criterion:

green: < 1 mm

orange: ≥ 1 mm and ≤ 5 mm

red: >5 mm

Plane

General Tab
Name – The name of the object. The green traffic light right to the object name indicates that
corresponding objects have been found in other scans. If corresponding references have not been found, no
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traffic light will be displayed.
Name: The name of the object. The green traffic light to the right of the object name indicates that
corresponding objects have been found in other scans. If corresponding references have not been found, no
traffic light will be displayed.

Use for Place Scans, Correspondence Search and Automatic Name: The object will be used for
registration. Correspondence relationships to this object are enabled and its name will automatically be
changed if corresponding objects have been found or the name of a corresponding object has been changed.
Local reference objects will have this option activated by default if their name has not been manually
changed by the user.

Use for Place Scans and Correspondence Search: The object will be used for registering scans.
Correspondence relationships to this object are enabled but its name will not be changed automatically. This
means that the name of this object is fixed and corresponding reference objects to other scans will be named
accordingly. Global reference objects and local references which have been (re-)named manually will have
this option activated by default.

Use for Place Scans: The object will only be used for registering scans but excluded from any
correspondence search. Its name will not be changed automatically.

Ignore for Place Scans: The object will not be used for registering scans and is excluded from any
correspondence search. Its name will not be changed automatically. These options are relevant for the
automatic correspondence search and for the registration of scans which are only available in SCENE.

Layer: The representation layer on which the object is situated.

Plane Properties Tab
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; else they are
displayed in the coordinate system of the scanner.

Normal – The orientation of the plane, given by the direction that stands perpendicular to the plane.

Position – A point of the plane.

Plane Fit
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; else they are
displayed in the coordinate system of the scanner.

Plane Name – The name of the corresponding plane. You can enter a name manually or choose one from
the dropdown menu. This menu contains the names of the last 10 fitted planes other scans and helps
choosing the right name for the registration and accelerates the manual naming process.

Name – The name of the fit object.

Normal – The orientation determined by the fit. The orientation is given by the direction which stands
perpendicular to the plane.
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Position – The position determined by the fit.

Number of scan points – The number of scan points in the selection used for the fit.

The traffic light indicates the quality of this individual criterion:

green: >80 points

orange: ≥ 20 and ≤ 80 points

red: <20 points

Transversal normal deviation – The standard deviation of the normal, which is determined using the
interim results of the fit. A high standard deviation indicates that the selected area is not as flat as it should
be. There could be a ripple or there might be other objects in the plane. The standard deviation is broken
down a transversal and longitudinal deviation.

The traffic light indicates the quality of this individual criterion:

green: < 1°

orange: ≥ 1° and ≤ 2.29°

red: >2.29°

Longitudinal normal deviation – The standard deviation of the normal longitudinal direction.

The traffic light indicates the quality of this individual criterion:

green: < 1.15°

orange: ≥ 1.15° and ≤ 2.29°

red: >2.29°

Scan point distance – The standard deviation of the distance of the scan points from the plane that has been
determined. This is a good measurement for noise.

The traffic light indicates the quality of this individual criterion:

green: < 4 mm

orange: ≥ 4 mm and ≤ 20 mm

red: >20 mm

Limited Plane Fit
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; else they are
displayed in the coordinate system of the scanner.

Border Points – A list of all the corner points of the plane.

Plane Name – The name of the corresponding plane. You can enter a name manually or choose one from
the dropdown menu. This menu contains the names of the last 10 fitted planes other scans and helps
choosing the right name for the registration and accelerates the manual naming process.

Name – The name of the fit object.
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Normal – The orientation determined by the fit. The orientation is given by the direction which stands
perpendicular to the plane.

Position – The position determined by the fit.

Number of scan points – The number of scan points in the selection used for the fit.

The traffic light indicates the quality of this individual criterion:

green: >80 points

orange: ≥ 20 and ≤ 80 points

red: <20 points

Transversal normal deviation – The standard deviation of the normal, which is determined using the
interim results of the fit. A high standard deviation indicates that the selected area is not as flat as it should
be. There could be a ripple or there might be other objects in the plane. The standard deviation is broken
down a transversal and longitudinal deviation.

The traffic light indicates the quality of this individual criterion:

green: < 1°

orange: ≥ 1° and ≤ 2.29°

red: >2.29°

Longitudinal normal deviation – The standard deviation of the normal longitudinal direction.

The traffic light indicates the quality of this individual criterion:

green: < 1.15°

orange: ≥ 1.15° and ≤ 2.29°

red: >2.29°

Scan point distance – The standard deviation of the distance of the scan points from the plane that has been
determined. This is a good measurement for noise.

The traffic light indicates the quality of this individual criterion:

green: < 4 mm

orange: ≥ 4 mm and ≤ 20 mm

red: >20 mm
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Slab

General Tab
Name: The name of the object. The green traffic light to the right of the object name indicates that
corresponding objects have been found in other scans. If corresponding references have not been found, no
traffic light will be displayed.

Use for Place Scans, Correspondence Search and Automatic Name: The object will be used for
registration. Correspondence relationships to this object are enabled and its name will automatically be
changed if corresponding objects have been found or the name of a corresponding object has been changed.
Local reference objects will have this option activated by default if their name has not been manually
changed by the user.

Use for Place Scans and Correspondence Search: The object will be used for registering scans.
Correspondence relationships to this object are enabled but its name will not be changed automatically. This
means that the name of this object is fixed and corresponding reference objects to other scans will be named
accordingly. Global reference objects and local references which have been (re-)named manually will have
this option activated by default.

Use for Place Scans: The object will only be used for registering scans but excluded from any
correspondence search. Its name will not be changed automatically.

Ignore for Place Scans: The object will not be used for registering scans and is excluded from any
correspondence search. Its name will not be changed automatically. These options are relevant for the
automatic correspondence search and for the registration of scans which are only available in SCENE.

Layer: The representation layer on which the object is situated.

Slab Properties Tab
Global Coordinates – If checked, coordinates are displayed in the global coordinate system. Otherwise,
they are displayed in the coordinate system of the scanner.

Face – The visible face of the slab object.

Thickness – The thickness of the slab object.

Normal – The orientation of the slab, given by the direction that stands perpendicular to the slab.

Position – A point of the slab.

Slab Fit
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; otherwise,
they are displayed in the coordinate system of the scanner.
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Slab Name – The name of the corresponding slab. You can enter a name manually or choose one from the
dropdown menu. This menu contains the names of the last 10 fitted slabs, helps you choose the right name
for the registration, and accelerates the manual naming process.

Face – The visible face of the slab object.

Thickness – The thickness of the slab object.

Name – The name of the fit object.

Normal – The orientation determined by the fit. The orientation is given by the direction which stands
perpendicular to the plane.

Position – The position determined by the fit.

Number of scan points – The number of scan points in the selection used for the fit. The traffic light
indicates the quality of this individual criterion:

green: > 80 points

orange: ≥ 20 and ≤ 80 points

red: < 20 points

Transversal Normal deviation – The standard deviation of the Normal, which is determined using the
interim results of the fit. A high standard deviation indicates that the selected area is not as flat as it should
be. There could be a ripple or there might be other objects in the plane. The standard deviation is broken
down a transversal and longitudinal deviation.

The traffic light indicates the quality of this individual criterion:

green: < 1°

orange: ≥ 1° and ≤ 2.29°

red: > 2.29°

Longitudinal Normal deviation – The standard deviation of the Normal longitudinal direction. The traffic
light indicates the quality of this individual criterion:

green: < 1.15°

orange: ≥ 1.15° and ≤ 2.29°

red: > 2.29°

Scan point distance – The standard deviation of the distance of the scan points from the plane that has been
determined. This is a good measurement for noise. The traffic light indicates the quality of this individual
criterion:

green: < 4 mm

orange: ≥ 4 mm and ≤ 20 mm

red: > 20 mm
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Point

General Tab
Name: The name of the object. The green traffic light to the right of the object name indicates that
corresponding objects have been found in other scans. If corresponding references have not been found, no
traffic light will be displayed.

Use for Place Scans, Correspondence Search and Automatic Name: The object will be used for
registration. Correspondence relationships to this object are enabled and its name will automatically be
changed if corresponding objects have been found or the name of a corresponding object has been changed.
Local reference objects will have this option activated by default if their name has not been manually
changed by the user.

Use for Place Scans and Correspondence Search: The object will be used for registering scans.
Correspondence relationships to this object are enabled but its name will not be changed automatically. This
means that the name of this object is fixed and corresponding reference objects to other scans will be named
accordingly. Global reference objects and local references which have been (re-)named manually will have
this option activated by default.

Use for Place Scans: The object will only be used for registering scans but excluded from any
correspondence search. Its name will not be changed automatically.

Ignore for Place Scans: The object will not be used for registering scans and is excluded from any
correspondence search. Its name will not be changed automatically. These options are relevant for the
automatic correspondence search and for the registration of scans which are only available in SCENE.

Layer: The representation layer on which the object is situated.

Point Properties Tab
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; else they are
displayed in the coordinate system of the scanner.

Position – The position of the point.

Add GPS Position – Add GPS information to the point.

Point Fit
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; else they are
displayed in the coordinate system of the scanner.

Point Name – The name of the corresponding point.

Name – The name of the fit object.
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Position – The position determined by the fit.

Number of scan points – The number of scan points in the selection used for the fit.

The traffic light indicates the quality of this individual criterion:

For (contrast) mean points:

green: > 80 points

orange: ≥ 20 and ≤ 80 points

red: < 20 points

For checkerboard points:

green: > 400 points

orange: ≥ 100 and ≤ 400 points

red: < 100 points

GPS Position – Enable to add a GPS position to the object.

Format – Select to enter the GPS position either as coordinates decimal degree notation or UTM
format.

Position – the GPS position decimal degree notation or UTM format.

Altitude – The altitude above sea level of the position.

Accuracy – The accuracy of the position.

Only bright points – Is set for the contrast mean point of a selection.

Objects – When creating an intersection point, the fit is depending on the properties of the corresponding
plane. This dependency is listed here.

Sphere

General Tab
Name: The name of the object. The green traffic light to the right of the object name indicates that
corresponding objects have been found in other scans. If corresponding references have not been found, no
traffic light will be displayed.

Use for Place Scans, Correspondence Search and Automatic Name: The object will be used for
registration. Correspondence relationships to this object are enabled and its name will automatically be
changed if corresponding objects have been found or the name of a corresponding object has been changed.
Local reference objects will have this option activated by default if their name has not been manually
changed by the user.

Use for Place Scans and Correspondence Search: The object will be used for registering scans.
Correspondence relationships to this object are enabled but its name will not be changed automatically. This
means that the name of this object is fixed and corresponding reference objects to other scans will be named
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The object will be used for registering scans. Correspondence relationships to this object are enabled but its
name will not be changed automatically. This means that the name of this object is fixed and corresponding
reference objects to other scans will be named accordingly. Global reference objects and local references
which have been (re-)named manually will have this option activated by default.Use for Place Scans: The
object will only be used for registering scans but excluded from any correspondence search. Its name will
not be changed automatically.

Ignore for Place Scans: The object will not be used for registering scans and is excluded from any
correspondence search. Its name will not be changed automatically. These options are relevant for the
automatic correspondence search and for the registration of scans which are only available in SCENE.

Layer: The representation layer on which the object is situated.

Sphere Tab
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; otherwise,
they are displayed in the coordinate system of the scanner.

Radius – The radius of the sphere.

Position – The position of the sphere mean point.

Sphere Fit
Global Coordinates – If checked, coordinates are displayed in the global coordinate system; otherwise,
they are displayed in the coordinate system of the scanner.

Sphere Name – The name of the corresponding sphere.

Name – The name of the fit object.

Radius – The sphere radius determined by the fit.

Position – The position of the sphere mean point determined by the fit.

Number of scan points – The number of scan points in the selection used for the fit. The traffic light
indicates the quality of this individual criterion:

green: > 80 points

orange: ≥ 20 and ≤ 80 points

red: < 20 points

Radius deviation – The standard deviation of the radius, which is determined using the interim results of
the fit. The traffic light indicates the quality of this individual criterion:

green: < 1 mm

orange: ≥ 1 mm and ≤ 4 mm

red: > 4 mm
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Position deviation – The standard deviation of the position of the sphere mean point, which is determined
using the interim results of the fit. The traffic light indicates the quality of this individual criterion:

green: < 15 mm

orange: ≥ 15 mm and ≤ 80 mm

red: > 80 mm

Scan point distance – The standard deviation of the distance of the scan points from the calculated sphere
surface. The traffic light indicates the quality of this individual criterion:

green: < 4 mm

orange: ≥ 4 mm and ≤ 20 mm

red: > 20 mm

Scan point drift – The average distance of the scan points from the calculated sphere surface. Scan points
outside the sphere can be averaged out with scan point within the sphere. The traffic light indicates the
quality of this individual criterion:

green: < 1 mm

orange: ≥ 1 mm and ≤ 5 mm

red: > 5 mm

GPS Position – see Point Fit

Clipping Box

General Tab
Clipping – Select between hiding the points outside the Clipping Box (hide exterior) or inside the Clipping
Box (hide interior).

Clipping Box enabled – Enable or disable clipping of the Clipping Box. When disabled, the points hidden
by this box will be displayed again; the color of the Clipping Box boundaries and its icon in the red change
to gray.

Clipping Box visible – Toggle visibility of the Clipping Box. Disabling the visibility of a Clipping Box will
only hide its boundaries; the Clipping Box is still active (if clipping is enabled) and it still has effect on the
visibility of the points in the 3D view.

Transformation Tab
Position – The translation portion of the transformation.

X – To key in a transformation in the x direction.

Y – To key in a transformation in the y direction.

Z – To key in a transformation in the z direction.
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Scroll bar – Set the transformation using the mouse. The direction of the transformation will be the x,
y, or z coordinate that is highlighted in yellow.

Increments – Set the increment for the scroll bar.

Rotation Angle – The angle of rotation if the rotation axis is split along the coordinate axes.

X – The angle of rotation around the x-axis.

Y – The angle of rotation around the y-axis.

Z – The angle of rotation around the z-axis.

Scroll bar – Set a new angle of rotation.

To change a value, you either enter the required value directly into the appropriate field, or you first
select the field and then use the corresponding slider to change the value step by step. You can set the
increment using the Increments dropdown box. If you hit the edge with the slider, simply reselect the
field and the slider will return to the center without you losing your previous changes.

Increments – Set the increment for the scroll bar.

Axis snap – If checked, you can change the rotation for the current axis independently from the others.
This is achieved by changing the order in which the rotations are applied.

Global Coordinates – If checked, coordinates are displayed in the global coordinate system. Otherwise,
they are displayed in the coordinate system of the scanner.

Documentation Object
You can add annotations at the scanner position or at any scan point, see Annotations (3D View, Quick
View, Planar View).

Global Coordinates – If checked, coordinates are displayed in the global coordinate system; else they are
displayed in the coordinate system of the scanner.

Position – the position of the documentation object in the project.

Description – detailed information about the documentation object.

Hyperlinks – hyperlinks to files or web sites. Add a new hyperlink by entering its address into the lower
text field, then press Add. You can change the order of the hyperlinks with Up / Down, delete them with
Remove or open them by double-clicking on the list item or by selecting the Open button.

Virtual Scan (3D Picture)

General Tab
Name: The name of the object. The green traffic light to the right of the object name indicates that
corresponding objects have been found in other scans. If corresponding references have not been found, no
traffic light will be displayed.

Use for Place Scans, Correspondence Search and Automatic Name: The object will be used for
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The object will be used for registration. Correspondence relationships to this object are enabled and its name
will automatically be changed if corresponding objects have been found or the name of a corresponding
object has been changed. Local reference objects will have this option activated by default if their name has
not been manually changed by the user. Use for Place Scans and Correspondence Search: The object will
be used for registering scans. Correspondence relationships to this object are enabled but its name will not
be changed automatically. This means that the name of this object is fixed and corresponding reference
objects to other scans will be named accordingly. Global reference objects and local references which have
been (re-)named manually will have this option activated by default.

Use for Place Scans: The object will only be used for registering scans but excluded from any
correspondence search. Its name will not be changed automatically.

Ignore for Place Scans: The object will not be used for registering scans and is excluded from any
correspondence search. Its name will not be changed automatically. These options are relevant for the
automatic correspondence search and for the registration of scans which are only available in SCENE.

Layer: The representation layer on which the object is situated.

Scan Tab
Size – The number of columns and rows. If a scan is loaded reduced in resolution, the reduced number of
columns and rows is displayed and, light gray underneath, the complete number of columns and rows.

Data loaded –Indicates whether the scan is loaded.

Reference Scan –Indicates whether the scan is used as a reference scan for registration.

Scan Fixed – Mark the scan alignment as fixed and exclude it from further automatic registration attempts.

Scanner Dist. Range – Range of the scanner.

Scanner Position – The position of the scanner with the mirror being the point of origin.

Orientation Axis – Rotation axis of the scan.

Orientation Angle – The scan’s angle of rotation.

Recording Date – The time the scan was recorded.

Scan Origin Info – Additional information on the origin of the scan, for example, where it was recorded
and information about issues (scanner warnings or errors) that occurred during recording of the scan.

Info – Further details that were provided when recording.

Transformation
Position – The translation portion of the transformation.

X – To key in a transformation in the x direction.

Y – To key in a transformation in the y direction.

Z – To key in a transformation in the z direction.
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Scroll bar – Set the transformation using the mouse. The direction of the transformation will be the x,
y, or z coordinate that is highlighted in yellow.

Increments – Set the increment for the scroll bar.

Rotation Angle – The angle of rotation if the rotation axis is split along the coordinate axes.

X – The angle of rotation around the x-axis.

Y – The angle of rotation around the y-axis.

Z – The angle of rotation around the z-axis.

Scroll bar – Set a new angle of rotation.

To change a value, you either enter the required value directly into the appropriate field, or you first
select the field and then use the corresponding slider to change the value step by step. You can set the
increment using the Increments dropdown box. If you hit the edge with the slider, simply reselect the
field and the slider will return to the center without you losing your previous changes.

Increments – Set the increment for the scroll bar.

Axis snap – If checked, you can change the rotation for the current axis independently from the others.
This is achieved by changing the order in which the rotations are applied.

Global Coordinates – If checked, coordinates are displayed in the global coordinate system. Otherwise,
they are displayed in the coordinate system of the scanner.
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Chapter 17: Error Messages

The application must be started once by someone with sufficient privilege to register controls. Otherwise,
several modules won't work as expected. You should at least have Power User rights. This also ensures that
all functions can be executed smoothly.

Version of model is not supported – The project was saved with a later version of SCENE and cannot be
read by your version. Use a later version of SCENE.

Version of scan is not supported – The scan was saved with a later version of SCENE and cannot be read
by your version. Use a later version of SCENE.

Failed to rename 'Scan’. Renaming scan files is not permitted! – You cannot rename scans.

One or several objects failed to read in successfully. Please check properties of marked objects. – The
project contains scans that do not exist as a file.

Not all contents of 'Object' were copied successfully. One or several children are bound to their
original location. – When copying objects that were created by a fit, it is not possible to also copy the fit
object to the new location.

The move request was rejected, because either ‘Object’ or one of its children is bound to its current
location. – Some objects cannot be moved or copied to different locations, for example fit objects, or
unloaded pictures.

No valid point cloud to be exported. Hint: try processing scans – In the rcp export no scan was exported

The required software license was not found. – You tried to process a Swift sequence without a valid
Swift license. Make sure that you have a valid Swift license.
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Chapter 18: FAQ

Why can I not rename scans?
Scans in the project must have the same name as the corresponding scan file on your data medium. You
cannot rename the scan file at the same time as the scan in the project because scans can be used in several
projects simultaneously.

Why do I always get the message “Load data reduced size”
when loading scans?
Check settings the under Tools > Options > Scan Data. The maximum scan size permitted is set there. You
can lift the size restriction by setting the setting to unlimited.

Why does my license not work anymore?
The license is linked to the Ethernet address of your network card. When checking the license, SCENE
compares the Ethernet address of the network card with the saved license. Unfortunately, a lot of network
cards hide the Ethernet address if you are not physically connected to a network.

Why is the scan loaded even when starting a Quick View?
Usually, the quick view is saved in the scan. If this is not the case for a scan, SCENE must first load the
scan before it can display the quick view . If the security settings permit it, SCENE then writes the quick
view in the scan, so that next time you open the quick view , it is no longer necessary to load the scan.

When I open the context menu, why do I sometimes get the
dialog to select the object?
If several objects are available next to one another or objects are available within the selection, SCENE
must ask which object you want to select.

SCENE User Manual
Chapter 18: FAQ

SCENE User Manual (2024.0) Page 363 of 372



Why can I no longer load some scans?
Some virus scanners have problems with the extensive scan files. Disable the virus scanner when working
with SCENE.

Why do I get a black window when opening the 3D View?
SCENE requires a graphics card that supports OpenGL 4.3 or higher. If your graphics card supports older
versions only, the 3D view might not work. Switching off the advanced textures or off-screen rendering
under Tools > Options > View might solve this. When switching off advanced textures, the stereoscopic
view is not available anymore. When switching off onscreen rendering, the stereoscopic view, the clear view
and gap filling are not available anymore.

Why is the rendering performance in the 3D View slow or
intermittent?
On systems equipped with NVIDIA Quadro graphics processors, rendering performance in 3D view might
be slow or intermittent. To improve rendering performance, start the NVIDIA Control Panel application
(available in theWindows Control Panel) and select the global preset 3D App – Game Development from
the Global Settings tab.

Why don’t I get the most current position and orientation
when I open an .fls scan file in a third-party application?
Point data and transformation information for scans may be stored in separate revisions. If you want to make
sure that an .fls scan file contains the most current transformation, you must use the command Export as
Project in the context menu of the scans or scan folders.

You can contact the technical support in the Workflow bar in the Help section.
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Glossary

A

artifact
A defect in a scan that occurs as a result of the methods used to capture or process the scan.

C

clipping box
A virtual box that allows defining places of interest in a 3D point cloud by hiding points within or
without of the clipping box.

cloud-to-cloud registration
A registration method that serves as refinement of already roughly positioned scans (by
sensors, manually or other algorithms). Different initial positions may lead to different results.

cluster
A collection of scans which belong together, for example, scans that were recorded on the
same floor of a building, or scans which were taken in the same room. Scan groups, created by
the FARO Focus scanner, are also automatically put into clusters when they are imported into
SCENE.

D

DataHub
FARO’s centralized cloud storage for project data. In WebShare, you can use the DataHub to
create WebShare projects from SCENE or Stream data.

F

FARO Stream
A FARO phone app from which you can control your FARO Focus Premium laser scanner, pre-
register captured scans, collect complementary data, and upload captures directly into FARO
Sphere.

folder
An object type which stores any objects other than scans. It is similar to the Windows file
system folder. The complement to this is the Scan Folder, in which scans are contained.

I

inclinometer
An instrument, similar to a level, used to measure angles of slope.
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L

layer
A logical grouping of objects in a scan project that can be used to switch the visibility of those
objects on and off.

M

model
A node in the structure view that contains CAD objects.

O

Overview Map
A top view of the entire scan project showing the position of the scanner and the scanned
areas. The scanner positions are shown as colored dots.

P

processing
A series of software manipulations to the scan data in a project that improve the quality of the
scan.

project point cloud
A point cloud that consists of the points of all the scans within a scan project. It can be seen as
a comprehensive point cloud of the complete scan project. It is typically created from all the
single scans in the project after they have been preprocessed, colorized and registered.

R

references
A node in the Structure View that contains the reference objects for positioning scans (for
example, survey coordinates). It should not be renamed.

registration
The process of aligning multiple scans in a parent coordinate system using reference positions
common between scans. References are common points between scans that are used to
create a “best-fit” alignment.

S

scan
A file recorded by scanner, containing millions of data points that include position, reflectance,
and color for single scan points. A scan consists of scan points that were recorded from a
single scanner location. Its points are organized in a row column order.

scan folder
An object type that contains scans. It is similar to the Windows file system folder. The
complement to this is the folder, in which all other objects are contained.
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scan point cloud
An alternative representation of a scan. It must be created from a single scan and is organized
in a spatial data structure that facilitates fast visualization of scan points and automated point
loading based on point visibility.

scan project
A collection of related scans and additional data needed to represent a scanned object or site,
such as a building or a crime scene.

sphere
A sphere-shaped target used for target-based registration of scan projects.

structure view
Tree-structure on the left side of the screen in SCENE. It shows the project structure, including
subfolders and objects.

Sync Agent
FARO Software that helps you keep project data synchronized between your PC and FARO
Sphere. You can install the app on your PC by using FARO InTouch.

T

target
A physical object in the area to be scanned that can be detected by the software and used to
register the scans. A target can be a naturally occurring plane such as a wall or desk, or an
artificial marker.

target-based registration
A registration methods that uses targets (e.g., spheres, checkerboards, markers) to determine
the alignment of the scans. This registration method does not use scan positions.

V

virtual reality
The integration of digital information to create a simulated experience of an entire scan project.
You can view the project through a compatible VR headset.

W

white balance
The adjustment of the intensity of primary colors to produce images that match what the human
eye sees under different lighting conditions.
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Appendix A: Technical Support

FARO Technologies, Inc. is committed to providing the best technical support to our customers. If you have
any problem using one of our products, follow these steps before contacting our Technical Support Team:

l Be sure to read the relevant sections of the documentation to find the help you need.

l Visit the FARO Customer Care area on the Web at www.faro.com to search our technical support
database. This is available 24 hours a day 7 days a week.

l Document the problem you are experiencing. Be as specific as you can. The more information you have,
the easier the issue will be to solve.

l Email or faxes sent outside regular working hours usually are answered before 12:00 pm in the next
working day. Should our staff be on other calls, leave a voice mail message; calls are always returned
within 24 hours. Remember to leave a detailed description of your question. Do not forget to include
your name, email address, fax number, telephone number and extension so we can reach you promptly.

North America

Support Hours (Monday through Friday)

8:00 a.m. to 7:00 p.m. Eastern Standard Time (EST)

email: support@faro.com

Phone: +1 800 736 2771, +1 407 333 3182 (Worldwide)

Mexico: 866-874-1154

Fax: +1 407-562-5294

Europe

Support Hours (Monday through Friday)

8:00 a.m. to 5:00 p.m. Central European Standard Time (CET)

email: support.emea@faro.com

Phone: +800 3276 7378, +49 7150 9797-400 (Worldwide)

Fax: +800 3276 1737, +49 7150 9797-9400 (Worldwide)

Asia

Support Hours (Monday through Friday)

8:30 a.m. to 5:30 p.m. Singapore Standard Time (SST)

email: supportap@faro.com

Phone: +1 800 511 1360, +65 6511 1350 (Worldwide)

Fax: +65 6543 0111

Japan
Support Hours (Monday through Friday)

9:00 a.m. to 5:00 p.m. Japan Standard Time (JST)
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email: supportjapan@faro.com

Phone: +81 561 63 1411 (Worldwide)

Fax: +81 561 63 1412

China

Support Hours (Monday through Friday)

8:30 a.m. to 5:30 p.m. China Standard Time (CST)

email: supportchina@faro.com

Phone: +400.677.6826

Fax: +86 21 6494 8670

India

Support Hours (Monday through Friday)

9:30 a.m. to 5:30 p.m. India Standard Time (IST)

email: supportindia@faro.com

Phone: 1800.1028456

Fax: +91 11.4646.5660

End User Documents
All documents related to the Software End User License Agreement, Purchase Conditions, and FARO
Products Service Policy can be found on the FARO Knowledge Base at the following URL:
knowledge.faro.com/Essentials/General/FARO_End_User_License_Agreement_Location.
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Appendix B: Software License Agreement

This Software License Agreement is part of the Operating Manual for the product and software System
which you have purchased from FARO TECHNOLOGIES, INC. (collectively, the “Licenser”) By your use
of the software you are agreeing to the terms and conditions of this Software License Agreement.
Throughout this Software License Agreement, the term “Licensee” means the owner of the System.

I. The Licenser hereby grants the Licensee the non-exclusive right to use the computer software described in
this Operating Manual (the “software”). The Licensee shall have no right to sell, assign, sub-license, rent or
lease the software to any third party without the Licenser’s prior written consent.

II. The Licenser further grants the Licensee the right to make a backup copy of the software media. The
Licensee agrees that it will not decompile, disassemble, reverse engineer, copy, transfer, or otherwise use
the software except as permitted by this section. The Licensee further agrees not to copy any written
materials accompanying the software.

III. The Licensee is licensed to use the Software only in the manner described in the Operating Manual. Use
of the Software in a manner other than that described in the Operating Manual or use of the software in
conjunction with any non-Licenser product which decompiles or recompiles the software or in any other
way modifies the structure, sequence or function of the software code, is not an authorized use, and further,
such use voids the Licenser’s set forth below.

IV. The only warranty with respect to the software and the accompanying written materials is the warranty,
if any, set forth in the Quotation/Purchase Order pursuant to which the software was purchased from the
Licenser.

V. THIS WARRANTY IS IN LIEU OF OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE WITH RESPECT TO THE SOFTWARE AND WRITTEN
MATERIALS. IN NO EVENT WILL THE LICENSER BE LIABLE FOR DAMAGES, INCLUDING
ANY LOST PROFITS OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT
OF THE USE OR INABILITY TO USE THE SOFTWARE, NOTWITHSTANDING THAT THE
LICENSER HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, THE LICENSER
WILL NOT BE LIABLE FOR ANY SUCH CLAIM BY ANY OTHER PARTY.

VI. In the event of any breach by the Licensee of this Agreement, the license granted hereby shall
immediately terminate and the Licensee shall return the software media and all written materials, together
with any copy of such media or materials, and the Licensee shall keep no copies of such items.

VII. The interpretation of this Agreement shall be governed by the following provisions:

A. This Agreement shall be construed pursuant to and governed by the substantive laws of the State of
Florida (and any provision of Florida law shall not apply if the law of a state or jurisdiction other than
Florida would otherwise apply).

B. If any provision of this Agreement is determined by a court of competent jurisdiction to be void and
non-enforceable, such determination shall not affect any other provision of this Agreement, and the
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remaining provisions of this Agreement shall remain in full force and effect. If any provision or term of
this Agreement is susceptible to two or more constructions or interpretations, one or more of which
would render the provision or term void or non-enforceable, the parties agree that a construction or
interpretation which renders the term of provision valid shall be favored.

C. This Agreement constitutes the entire Agreement, and supersedes all prior agreements and
understandings, oral and written, among the parties to this Agreement with respect to the subject matter
hereof.

VIII. If a party engages the services of an attorney or any other third party or in any way initiates legal
action to enforce its rights under this Agreement, the prevailing party shall be entitled to recover all
reasonable costs and expenses (including reasonable attorney’s fees before trial and in appellate
proceedings).
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FARO Technical Support

FARO Technologies, Inc.
125 Technology Park
Lake Mary, FL 32746
800-736-2771 U.S.
+1 407-333-3182 Worldwide
Email: support@faro.com

FARO Business Technologies India Pvt. Ltd.
E-12, B-1 Extension,
Mohan Cooperative Industria Estate,
New Delhi-110044, India
Tel.: 1800.1028456
Email: supportindia@faro.com

FARO Japan, Inc.
716 Kumada, Nagakute-City,
Aichi, 480-1144, Japan
Tel: 0120-922-927, 0561-63-1411
FAX: 0561-63-1412
Email: supportjapan@faro.com

FARO Europe GmbH
Lingwiesenstrasse 11/2, 70825
Korntal-Münchingen, Germany
FREECALL +800 3276 73 78 / +49 7150/9797-400
FREEFAX +800 3276 1737 / +49 7150/9797-9400
Email: support.emea@faro.com

FARO Technologies (Shanghai) Co. Ltd.
1/F, Building No. 2,
Juxin Information Technology Park
188 Pingfu Road, Xuhui District
Shanghai 200231, China
Tel.: 400.677.6826
Email: supportchina@faro.com

FARO Brazil
Rua San José, 360
Cotia, SP 06715-862
Phone: 0800-047-4271 / +55 11 3500-4600
Email: suporte@faro.com

FARO Singapore Pte. Ltd.
TEL: +65 3165 4200
Email: supportap@faro.com
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